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Introduction to creating a geological map with GIS
Last Modified: 22 Aug 23, 09:21:30
This workbook is a supplement to the Introduction to GIS workbook you used in level 1. That workbook is still available to you in Minerva under both the level 1 module and this module. You may still need to refer back to it for some information, e.g. reminders of where to find basic tools in QGIS and instructions on how to download data from Digimap, but I’ve tried to include most of the main information in this document to allow you to digitise your geological maps. I hope any repetition of last year will serve as a useful reminder and it will help if you can find the information you need in one document.
[image: images/svg/info-black-24dp.png] Finding information in a Word document
Remember you can search in Word documents, e.g. by using the <Control-F> keyboard shortcut or by going to the Home ribbon/toolbar and clicking on Find. So, if you do need to look for something in last year’s workbook, you should be able to find it more easily.
To see an automatically generated section list in Word (in effect, a table of contents) go to View > Navigation pane and check that the Headings tab is selected. If you click on a heading, you’ll be taken straight to it.
This workbook gives you detailed instructions for how to create a geological map in QGIS. You will need to do this for your dissertation in your final year, and this level 2 module is a chance to gain and practice the necessary skills under less high-pressure conditions.
At the end of this workbook, you will be able to:
· Create your own field slip on which to collect data in the field, and to use as a basis for digitising your data when you return from fieldwork.
· When you have collected data, you will know how to georeference a scanned version of your field slips so that they appear at the correct geographic coordinates in GIS.
· You will be able to digitise geological points, lines and polygons from your field slip.
· You will style and label the features appropriately.
· You will know how to create a layout ready to print out a high-quality top-copy geological map.
· Finally, you will know how to use Inkscape to add further elements to your layout and finalise it.
When you are ready to digitise your top copy map in your final year, you will still have access to the instructions in this workbook.
Learning GIS with this workbook
Last Modified: 25 Sep 23, 12:36:05
This workbook contains the exercises for a GIS course in the School of Earth and Environment at University of Leeds.
This workbook is provided in Word format. You can download alternative formats via Minerva, e.g. pdf or epub. Look for the link after the download. These alternative formats are not available directly from Clare.
You are welcome to keep your own notes within your copy of the workbook. An up-to-date version will always be available to you within Minerva. Updates may be made during the module based on questions from students and whether anything appears to be unclear. The date that each chapter was last updated will be just under the chapter heading.
If you are working with both Word and GIS open, you may find it easier to use the instructions if you use Reading view in Word. To try this go to View > Read Mode (Word Desktop app) or View > Reading View in Word online. The View menu will then let you change the background colour, the column width, and some other options. You will be able to change the width of Word and the text and images will scale properly.
To exit reading view, press the Esc key on your keyboard, or the Print Layout button at the bottom of the Word window. Hover over buttons to see a tooltip.
[image: images/svg/videocam-black-24dp.png] Office365 - assistive viewing features
This video clip can be found in the module area of Minerva or in the full list of video clips.
Software
The exercises in this workbook are written using QGIS and instructions for gaining access to the software are available in the software document in Minerva.
This workbook acknowledges use of QGIS: QGIS Development Team, 2023. QGIS Geographic Information System. Open Source Geospatial Foundation Project.
How to use these exercises
The following conventions are used:
Video clips of techniques are available in Minerva or in the list of videoclips. They aren’t fancy, just what you’d see if I gave a demonstration in class, but you may find them useful as a supplement to the written instructions.
They are shown as follows in the worksheets:
[image: images/svg/videocam-black-24dp.png] Spatial bookmarks in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
Information boxes point out techniques that you may already know about. They are here as reminders, or as quick tips:
[image: images/svg/info-black-24dp.png] Adding a folder connection in the Catalog pane
If you can’t see your network drive or USB device in the list of folders when adding data or viewing the catalog you need to Connect to folder
For something you should do following previous instructions:
[image: images/svg/create-black-24dp.png] Change page size and orientation
Have a look for each of the tools suggested below and try them out to see what they do. Make notes in the spaces provided.
For a question:
[image: images/svg/help_outline-black-24dp.png] Question title
What do you think of this? Make your own notes either in the document (if you’re using the Word version) or in your own notebook.
For a warning - take note of these, they can often save you time and trouble:
[image: images/svg/warning-black-24dp.png] Warning
If you do x it won’t always work! Make sure that you do y.
For recommended reading related to the current section:
[image: images/svg/library_books_black_24dp.png] Recommended reading
Recommendations will usually be to books from the module reading list which is linked from Minerva.
Contact me
If you find any problems with these instructions, please get in touch with me giving full details of the section and the problem and I will do my best to correct it.
Email me at: c.e.gordon@leeds.ac.uk
Clare Gordon © 2023 The University of Leeds.
[image: ../../shared/docs/images/CreativeCommons88x31.png]
Creative Commons Attribution-NonCommercial-ShareAlike 4.0 International License.
This work is licensed under a Creative Commons Attribution-NonCommercial-ShareAlike 4.0 International License.
Creating a base map
Last Modified: 22 Aug 23, 14:25:18
Learning outcomes
When you have completed this section of the workbook you will be able to
· Use the tools provided in QGIS to prepare data for further use.
· Create a 1:10 000 (or required scale) topographic base map which is suitable to use for geological field mapping and as a basis for digitising geological data.
· Demonstrate how to update styles and add basic labels to layers in your map.
Introduction to creating a base map
Before you go out into the field to collect data, or before you start to digitise geological data, you need to set up a detailed base map. For the UK you will be able to download data from Digimap, and that is the method described in this chapter.
[image: images/svg/warning-black-24dp.png] Warning
The instructions below cover creating a base map for an area in the UK.
If you are working outside of the UK, you will need to source background data from elsewhere. Clare Gordon can advise on this - c.e.gordon@leeds.ac.uk
If your area for your final year dissertation is outside of the UK, Clare will have created a project for you containing the base map data. Please get in touch as soon as possible to obtain it.
Data to download for a UK base map / field slip
It is possible to find a general background map in QGIS by using XYZ tile maps (information in main workbook). These are fine for checking you’re in the right location, and as a background to other data, but are not suitable as a basemap or field slip, particularly at a detailed scale.
Instead, for an area in the UK, you will need to download topographic data from Digimap before you can create a basemap. For a 1:10,000 map we will need to download the raster topographic maps and the vector contour files separately, as Digimap does not provide these as a single data layer.
Full instructions on using Digimap to download data are in the level one workbook.
Download the datasets below from Digimap using the Ordnance Survey download service (NOT Geology download).
Search in Digimap OS Download to go to your field area and make sure that you select to download data for a larger area than you think you will need - it will save having to go back and download more data later.
Download:
· VectorMap Local Raster - TIFF format. Choose the Black and White version.
· OS Terrain 5 contours (NOT 50) - download SHAPE format, not GML.
[image: images/svg/info-black-24dp.png] Note on colour choices for background maps
When you download the raster topographic maps for the UK from Digimap, the basket gives you a choice of colour formats between black and white; faded; and full colour.
If you are creating a field slip to take into the field and map onto, then you can choose which will be the best background for your markings, colours etc. This varies from area to area so you may want to discuss this with your mapping supervisor (show them examples!). Note that the usual recommendation is to use the black and white version and reduce the black to a shade of grey.
For your final top copy map with the digitised geology on top, it is usually recommended that you use the Black and white version so that the geology shows clearly. On a BGS published geological map the topography is a grey layer behind the geology [footnoteRef:61]. You can “fade” a background which is too dark by applying opacity to the layer. [61:  See examples on the BGS Map Portal, such as the Durham sheet.] 

If you are unsure about which background layer to use, speak to your mapping supervisor.
Once you have downloaded the data, save it to your working folder. Remember to stay organised and remember where you have put data. You should try to keep the map file and all your data in the same folder.
Remember, you will need to unzip the data you have downloaded from Digimap before you can reliably use it in QGIS.
[image: images/svg/videocam-black-24dp.png] Using zip archives - viewing, unzipping and zipping
This video clip can be found in the module area of Minerva or in the full list of video clips.
Adding contour data
[image: images/svg/videocam-black-24dp.png] Adding Ordnance Survey Terrain 5 contour lines to QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
You are now ready to start a new project from scratch.
· Open QGIS.
Remember QGIS automatically sets the coordinate reference system (CRS) of a map to that of the first data added.
When downloading Ordnance Survey UK data from Digimap, the raster layers don’t always have coordinate system information, so it makes sense to start by adding the vector contour layers, which do usually (though not always!) have that information.
· Find your contour shapefiles in the Browser panel.
· You may need to look in multiple folders within the terrain-5 folder to find all the .shp files covering your field area.
· You only need to add the shapefiles for lines to your map, not the point shapefiles.
· Add the line shapefiles to a map by dragging and dropping them from the Browser. You can select more than one at a time by holding down the <ctrl> key.
· Click OK on the transformation dialogue if necessary.
Merging contour shapefiles
[image: images/svg/videocam-black-24dp.png] Merging vector layers in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
If you have more than one tile of data for the contours, the first thing you will need to do is merge them into a single layer.
You can see why you need to do this by adding all the line shapefiles to QGIS. Each will be styled separately, so they will be different, random colours.
[image: images/base_map/ContoursMultiple_small.png]
Multiple tiles of contour data showing that each is still being styled separately so each is a different colour.
To merge these into a single layer:
· Vector > Data Management Tools > Merge Vector Layers...
· Add all the line contour shapefiles as Input layers
· Select the correct Destination CRS - for UK layers that will be “British National Grid - EPSG:27700”. Remember: If your area is not in the UK, the CRS will not be British National Grid.
· Give the Merged layer a new name and choose where to save it (remember, try to keep all your data in the same folder/subfolders). It’s a good idea to save it as a layer in a GeoPackage.
· Click Run.
[image: images/base_map/MergeVectorLayers_small.png]
Merging multiple contour shapefiles into a single GeoPackage layer.
The tool should run and add a new layer to your map. This should look similar to the separate tiles, but now you have a single tile styled in a single colour.
[image: images/base_map/ContoursSingle_small.png]
The merged contour output. A single layer styled in a single colour.
Tidy up your Layers panel by removing the individual tiles of data, leaving the merged contour layer.
[image: images/svg/create-black-24dp.png] Saving a bit of disk space
If you need to save space on your computer, or even just want to tidy up your data, you can now delete the folder containing the original contour data you downloaded. If you need it again you can either unzip the file that you downloaded from Digimap again, or just redo the download for new data.
Checking the coordinate system
At this stage it is a very good idea to check that your map CRS is set correctly, and that your data appears in the correct location. Remember there is a whole chapter about coordinate reference systems in the level 1 GIS workbook, if you need to check back.
[image: images/svg/videocam-black-24dp.png] Checking and setting the CRS of your project in QGIS
[image: images/svg/videocam-black-24dp.png] Checking the layer CRS in QGIS
These video clips can be found in the module area of Minerva or in the full list of video clips.
If you are not working in Great Britain, the web page at https://epsg.io can help you to find the correct CRS for your area.
· Start a new blank map in QGIS - you don’t need to save the previous one.
· Add your merged contour layer to the map.
Remembering that QGIS sets the project CRS to the same as the first layer added, the CRS should now be British National Grid (EPSG:27700). If you’re working in an area outwith the UK, remember you will be using a different CRS.
· To check the project CRS look at the bottom right of the map window. There should be a small globe icon, and next to that the current CRS. If you want more information you can click on it to see the project properties.
[image: images/base_map/ProjectCRS_small.png]
The project CRS at the bottom right of the map window. In this case EPSG:27700 indicates that it is set to British National Grid.
If the CRS is incorrect use the instructions in the main workbook to check the project and the contours layer. If you get this wrong at this stage, you’ll be setting up major problems for yourself later.
Checking the location of your data on the map
Once you have the CRS set correctly, it is worth double-checking that your data is located correctly.
· If the file browser isn’t visible in QGIS open it by going to View > Panels > Browser
· Scroll down in the browser and look for XYZ Tiles
· Under XYZ Tiles you should be able to find a layer called OpenStreetMap - double-click on this to add it to your map. You’ll probably need to accept a CRS transformation warning.
· Move the OpenStreetMap layer to beneath the contours layer and check that the contours are correctly located, e.g. not floating somewhere off the coast of Africa [footnoteRef:92]. [92:  Data which is missing a CRS, or has it incorrectly applied, often ends up at 0, 0 coordinates in lat/long. This point is just to the west of Africa and is colloquially known as Null Island.] 

Hopefully everything will be fine. If so, just remove or make the OpenStreetMap layer invisible then carry on with these instructions.
Don’t forget to Save your map before continuing.
If there is a problem, you need to check the CRS of the data and the project and try again. If repeating the process doesn’t help, get in touch with Clare. You must sort this out before you start later sections of this workbook.
Styling the contours
Now the contour lines are in your project, you need to style them so that they look professional and don’t get in the way of any more work you do. For this, take inspiration from the British Geological Survey published maps. I have paper copies in my office, which you are welcome to ask to see. Otherwise have a look at the scanned maps on the BGS website. You can find them in the BGS Maps Portal (last viewed: 22nd August 2023). Try to make sure you look at a relatively recently published example, such as the 1:25 000 Dounreay map published in 2005.
[image: images/svg/info-black-24dp.png] Colour or greyscale contour lines?
The British Geological Survey uses contours styled as greyscale on their maps. You may find, or be advised by your supervisor, that coloured (usually orange/brown) contours work better for your map area, particularly when you are creating field slips.
It’s worth talking to your dissertation supervisor about this before you set up your field slips.
Styling contours manually
If you want more control over how your contours are styled and labelled, or want colour instead of greyscale, then use the instructions in this section.
If you want greyscale contours it’s worth trying the instructions for styling contours with the OS style sheet below.
[image: images/svg/videocam-black-24dp.png] Styling contours in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
To start styling your contours:
· Select your contours layer in the Layers panel.
· Either press F7 on your keyboard or click on the Open the Layer Styling Panel button above the layers panel.
Styling as categorized symbols
It is good practice to style your contours so most are of a standard width, but contours at a regular interval, such as 50 metres, are made slightly thicker.
[image: images/svg/create-black-24dp.png] Checking the attribute table for the contours
Check the attribute table for your contour feature class. For Ordnance Survey data there will be a column that divides the contours into master and ordinary. If your area is on the coast, you may also have high and low water mark.
Make a note of the column that divides the contours into master and ordinary.
To set up the styling:
· In the Layer Styling panel check you have the correct layer selected at the top.
· Change the type of styling from Single symbol to Categorized in the next drop-down box.
· Drop down the Value list and choose the column that you made a note of above. The name should be SUB_TYPE.
· Click on the Classify button at the bottom of the panel.
The panel should end up looking like the image below.
[image: images/base_map/ContourStyling_small.png]
Setting up multiple categories for contours. The list should include categories for master and ordinary.
You don’t need the all other values symbol, so select that line and click on the red minus sign at the bottom of the window to remove it.
If you’re in an area with no coastline you won’t need the meanHighWater and meanLowWater symbols either, so you can remove those as well if they are present (they might not be).
You shouldn’t notice any difference on your map, but it will tidy up your Layers panel, and if you were going to add this layer to a map legend it would stop extra symbols appearing there too.
Styling contour lines
Remember there is more about styling in the workbook you used for the GIS module last year. There are also more comprehensive instructions later in this workbook. In this section I only show you how to style your contours.
The automatic styling of the contour lines that QGIS has applied is unlikely to be satisfactory. To make the styles look more suitable and so that the contours are visible, but don’t get in the way of your geological annotations:
· Start by setting the scale of the map to 1:10000, or the scale at which you will be printing the map.
· In the Layer Styling panel double-click on the line symbol for the ordinary contours on the left.
· In the styling panel that opens click on Simple Line in the box at the top.
· Use the options on the panel to set the contours as follows:
· Colour = a pale grey - for example, click on the colour patch and set R, G and B all to 200, or use the HTML notation setting and type in #c8c8c8
· Alternatively, if you would prefer coloured contours try setting the colour to R = 224; G = 148; B = 94 or HTML notation #e0945e which will give you a shade of orange.
· Set the Stroke width to 0.16 - it should be a narrow line which is visible, but not too obvious.
· Check that Stroke style is set to Solid Line
· If you don’t have Live update ticked at the bottom of the panel, either tick it now, or click on the Apply button.
[image: images/base_map/OrdinaryContourStyle_small.png]
Settings for the ordinary contour - thin, grey lines.
Your ordinary contours should have changed to a thin, grey line.
· Click on the arrow button at the top to return to the list of classes.
· Now double-click on the line symbol for master and again go to Simple Line
· Use the same colour as above, but set the Stroke width to 0.26 - the master contours need to be a bit more obvious than the ordinary.
· Again, make sure the settings are applied then return to the class list.
You can change these settings later if you’re not happy with them, but try them for now.
Your contours should look something like the image below.
[image: images/base_map/StyledContours_small.png]
The styled contours - all grey but with the master contours as slightly thicker lines.
Styling contours with the OS style sheet
When you download the Terrain 5 contour data from Digimap, the download includes Ordnance Survey style files that you can use to style your contours. Note that the contours will be coloured orange/brown. If you prefer, or have been advised, to style your contours as greyscale, then use the section above on Styling contours manually instead.
Finding the style files
The zip file you downloaded from Digimap will include the style files for the contours and spot heights.
· Using your computer file explorer, not the browser in QGIS, look in your unzipped terrain-5 folder and navigate to docs.
· Unzip the zip file called terrain5-shp-styles.zip - keep it in the same location.
· Go into the unzipped shp > qml folder.
You should be able to see files called line.qml and point.qml as well as a Quick Start Guide and a folder called images.
[image: images/base_map/StyleFilesInFolder_small.png]
The contents of the qml folder showing line.qml and point.qml as well as the Quick Start Guide.
The .qml files are the ones you need to use to style your downloaded data.
The Quick Start Guide contains the instructions to apply these styles to your data but you can follow the instructions below instead.
[image: images/svg/videocam-black-24dp.png] Applying styles to a layer with a qml file in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
To apply a qml file to a layer:
· Either double-click on the contours layer in your Layers panel, or right-click and select Properties. You can’t import styles from the Layer styling panel.
· Go to the Symbology tab of the properties.
· At the bottom left of the properties is a button which says Style. Click on this button and select Load Style...
· This opens the Database Styles Manager. Make sure Load style is set to From File.
· Click on the three dots button next to File and navigate to where you unzipped your qml files.
· Select the line.qml file and click Open.
· Back in the Database styles manager, click on Load style.
The Symbology should change to show the new styles.
[image: images/base_map/LayerPropertiesSymbology_small.png]
Loading the contour lines qml style file via the layer properties window.
If you have a large area of contours and it looks a bit as if QGIS is going to crash, it’s worth just waiting - don’t try clicking on anything as that will make it worse!
The point.qml file styles the spot heights. You don’t really need these on your map, so if you have added the shapefiles with _point.shp you can remove them.
You will find more information about using qml style files later in this workbook.
Labelling the contours
It is essential to add labels to the contour lines to show the height. Without labels contours are basically pointless.
If you use the OS style sheet, you will already have labels on the master contours. If you want to include labels on all the contours, the instructions below will allow you to change that.
If you followed the instructions on Styling contours manually, you must follow the instructions below to label your contours.
[image: images/svg/videocam-black-24dp.png] Labelling contours in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
Once again you need to look at the attribute table of the contours layer to see which column holds the information you need for the height labels.
[image: images/svg/help_outline-black-24dp.png] What is the name of the column which holds the information about height above sea-level?
Check the attribute table of the contours feature class as you did before.
Now to label the contours:
· If the Layer Styling panel isn’t already open, press F7 or the Open the Layer Styling Panel button.
· On the Layer Styling panel click the Labels tab.
· Check that your contours layer is selected in the box at the top, then click where it says No Labels and select Single Labels.
· The default Value probably won’t be correct, so drop-down that box and select the name of the column you found above, the one that holds the value for the height above sea-level. In the case of the Ordnance Survey Terrain 5 data this should be called PROP_VALUE.
The labels should change to show the height.
Changing the style of the labels
The correct labels should appear on your map, but if you look at them, the size and colour are unlikely to be correct. To change that, do the following:
· Check the map scale is set to the scale you will be printing your map at, e.g. 1:10 000.
· In the Layer Styling panel select the font you want to use.
· Set the Size to something small, e.g. 6 points. The labels need to be visible, but not to dominate the map.
· Set the Color to the same colour as the contours. In this case a pale grey - click on the colour patch and set R, G and B all to 200, use the HTML notation setting and type in #c8c8c8.
[image: images/base_map/ContourLabelling_small.png]
The Layer Styling panel for contour labels.
Label placement for contours
If you have a closer look at the contour labels on your map, you should notice the labels don’t appear on top of the lines to which they refer, this can be very confusing, particularly on maps with a lot of contours. You need to change the Label placement so it is easier to see the height of each contour.
· In the Label tab of the Layer Styling panel, click on the Placement tab.
[image: images/base_map/PlacementTab_small.png]
Finding the Placement tab - look for the four arrows icon.
· Under the General Settings set the Mode to Parallel or Curved
· Next to Allowed positions tick On line and untick Above line
Your labels should move so that they are on top of the contour to which they refer.
[image: images/base_map/LabelledContours_small.png]
Contours labelled with the labels on top of the contour lines.
This is the basic formatting for the contour labels, but feel free to experiment with the other settings. A thin Text buffer can work well for contour labels, but can also be too intrusive. Experiment and see what works for your area, taking published maps as inspiration as suggested at the start of this section.
[image: images/svg/warning-black-24dp.png] Warning
If you find labelling the contours slows down the redrawing of your map too much, you can make the contour layer invisible while you work on other parts of the map.
Don’t forget to make them visible again before you print or export your map.
Adding the background raster map
So far, you’ve used one of the xyz tile maps as the background map. This is useful for general maps, but you need a detailed map for fieldwork and as a background to your top copy geological map. You should have downloaded VectorMap Local Raster tiles from Digimap, and these will be a suitable map.
[image: images/svg/videocam-black-24dp.png] Adding raster background maps to QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
To add the raster tiles:
· Find the raster tiles you downloaded by using the Browser panel. If you don’t have the files in a subfolder of the folder containing your map project, move them there now using your usual file manager. Double-check you have unzipped the files.
· If you downloaded data from Digimap and unzipped it, then the files should be in a folder called something like vml-raster-bwr
· The names of the files you need should be something like vml-raster....tif
· Simply drag and drop the raster file(s) from the Browser to the map. Don’t forget you may have to add files from more than one folder.
· If you have more than one tile, select all the layers you’ve just added, right-click, and Group Selected to keep them together. You should be able to make them all visible or invisible by ticking or unticking the group.
· Move the new layer or group so that it is under the contours layer.
[image: images/svg/warning-black-24dp.png] Warning
You do not need to do any more to these layers to use them. In particular, don’t try merging them - it won’t work.
[image: images/base_map/MapWithVML_small.png]
The completed map with styled and labelled contours, and a VectorMap Local background map.
Your raster maps may appear rather bad quality on your screen, but this is usually just an on-screen problem. When you print your map or zoom in closer, it should be fine.
Fading the black and white background map
The black and white background map has a rather high contrast and it is a good idea to “fade” the black to a shade of grey.
· In the Layer styling panel (F7) go to the Transparency tab on the left (second tab down, use the tool tips to check it).
· Set the Global opacity slider to 50% to start with.
You can change the percentage if it still looks too dark, or has faded too much. You are aiming for a map where you can still see the features, but anything you hand draw or digitise on top of the base map should show up clearly.
Note: If you have more than one tile of background data you will need to fade each one individually.
[image: images/svg/create-black-24dp.png] Check your map
Check that the background map looks right with your contours, e.g. that the contours don’t go straight through the middle of lakes, or that streams don’t appear to flow uphill.
If they don’t look right, check that you have downloaded and added the correct data. If you use data which is intended to be used at differing scales, you may find that there is a problem.
Create a layout for printing a field slip
You will need to add various map elements to the layout for your field slip before you print or export it. The layout chapter from your level 1 workbook has also been included later in this workbook and the links below should go straight to the relevant sections.
Remember to consider adding the following:
· A measured grid with grid coordinates
· A scale bar
· Relevant copyright acknowledgements - in a very small font…
If your field slip needs to be printed across more than one page use the instructions for setting up to print multiple map pages.
Once you are happy with your layout go to the section on printing and exporting map layouts and decide whether you are going to export it to pdf, then print it, or print it directly from QGIS.
[image: images/svg/create-black-24dp.png] GIS class
If you are doing this process as part of the GIS class for level 2, export your final map as a pdf and upload it to your Class notebook page to get feedback on what you have done.
This map should only need to be a single A4 or A3 page.
You are very unlikely to need to export your field slip as an image format or svg as you should be intending to print it to take into the field. PDF is the best format for printing accurately.
[image: images/base_map/Fieldslip_small.png]
A field slip or base map ready for field mapping or to use as a background for a top copy geological map. (Not to scale.)
Save your map project
Don’t forget to save your project at regular intervals.
· Project > Save or <Ctrl>-S.
Once you have finished and have produced your field slips, don’t forget to save again, then don’t delete this project.
When you have been out and collected data on your field slip, you will need this project as a base for compiling your top copy map.
The safest thing to do to make sure you don’t lose it, is to zip the folder containing the project (remember you need to include the data as well as the map document) and upload the zip file to a folder on OneDrive as a backup copy.
Georeferencing a scanned map
Last Modified: 16 Jan 24, 16:42:38
The background to georeferencing a scanned map will be covered in the introduction to the class, and the presentation and any other supporting materials will be available in Minerva. The introduction should help you to understand why you are doing these exercises. If you still aren’t sure, please ask Clare.
Learning outcomes
When you have completed this section of the workbook you will know how to:
· Explain what is meant by georeferencing and why it is necessary
· Demonstrate how to import a scanned map in to GIS and use georeferencing tools to place it in the correct geographical / spatial relationship to your base map.
What is georeferencing?
Having created a base map, printed it out, and used it to collect data in the field, you have returned with hand-drawn annotations on the printed map. Your next task is to digitise (or trace on computer) the geological features to produce a “top copy geological map”.
To be able to digitise the data you need to get the printed map into GIS in the correct geographical relationship to your base map.
You will start by scanning your fieldslip. Despite being electronic, that file has no spatial reference information to tell QGIS where in space the map belongs. You can see that information from the map, but in effect that scan is just a picture. The computer can’t see the information.
You will need to georeference the scanned map so the electronic information about location is coded into the file. Once you have done that the map will appear in the correct place overlaying your base map and you can start tracing the geology.
Georeferencing, in effect, means “pinning” your scanned map to the base map in QGIS. You find points for which you know the grid coordinates, which usually means the intersections of grid lines, put a control point at that location on the fieldslip, then in the same location on the basemap.
[image: images/georeferencing/sketchMap.png]
Georeferencing a fieldslip to a basemap. In this case the fieldslip is stretched to fit the base map using control points, shown as pins on the diagram.
Scanning your fieldslip
If you have already been provided with an electronic copy of a completed fieldslip, then you don’t need to do this first stage.
If you are using your own fieldslip(s), you first need to create a digital copy by scanning it.
[image: images/svg/warning-black-24dp.png] Warning
Note that taking a photograph of a fieldslip, instead of scanning it, will not work well and should only be used as a last resort. However careful you are the image will be distorted in some way.
All the printers in clusters around the University will scan.
The default format appears to be pdf, which won’t open in GIS. It should be possible to change the settings so that the output is tif, jpg or png.
Tif, jpg and png are all acceptable formats for georeferencing. Tif will be the best quality, but probably the largest file size. Jpg will have small file sizes, but will lose some quality due to lossy compression.
If you end up with pdf, it is possible to use an online converter, such as Smallpdf.com to convert it to an image format. Despite the name, this does give you a choice of output format.
· Once you have scanned your fieldslip(s), save it to a folder within the folder containing your project from the previous chapter. Remember, being organised and saving everything to the same place can save you a lot of time.
Georeferencing
Georeferencing involves clicking on particular points on your scanned map and linking them to the equivalent point on a background map.
Below I show you how to georeference using intersections on measured grids. The maps you need to georeference are most likely to have measured grids, and this is the most accurate and simplest way.
It is also possible, if you have an old map without a measured grid, for example, or your map is in a different coordinate system to the background map, to georeference by clicking on recognisable points such as road junctions or corners of buildings. Doing it this way does tend to be less accurate, but it’s useful to know that it’s possible.
[image: images/svg/videocam-black-24dp.png] Georeferencing a scanned map in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
I strongly recommend you watch the video clip for this. It isn’t a difficult process, but it is fiddly, takes a bit of care and can be frustrating if you don’t fully understand it.
You’ll be adding control points and typing the grid reference for each point, so it may help if you start by marking some points at intersections of grid lines on a print out of your fieldslip. Then write down the full 12 figure grid reference for each point, being very careful to get the x and y coordinate the correct way round.
A useful way of remembering which way round x and y are is Along the corridor and up the stairs - so start with the numbers along the bottom (or top) for x, then the numbers up the side for y.
It is not a good idea to use the corners of the map. You have no guarantee they are accurately numbered. Use the intersections of the grid lines instead.
[image: images/georeferencing/IngletonFieldSlipGeorefAnno_small.png]
A geological fieldslip marked with control points. Note the 12 figure national grid reference for each point written down ready for georeferencing.
Add your scan to QGIS Georeferencer
Start by opening the base map from the previous chapter in QGIS.
If you take your fieldslip and add it directly to QGIS, it won’t appear on your map. That is because there is no location information coded into the scan. You need to follow the instructions for georeferencing before adding the scan to QGIS.
[image: images/svg/info-black-24dp.png] Work with one fieldslip at a time
If you have multiple fieldslips to georeference, work with them one at a time. Don’t try to merge them, or anything similar.
Once the fieldslips are in your project and georeferenced, leave them as individual layers. Merging them will not work.
The next step is to open the Georeferencer. The location of this varies depending on which version of QGIS you are using.
· If you are using version 3.22 or below, go to Raster > Georeferencer...
· If you are using version 3.26 or above, go to Layer > Georeferencer...
The Georeferencer should open as a new window.
· To add your scanned map, click on the raster button at the top left or go to File > Open Raster.
· Navigate to where you saved your scanned map and select it then click Open.
[image: images/georeferencing/GeoreferencerWithImage_small.png]
The georeferencer once your scanned raster map has been added.
[image: images/svg/warning-black-24dp.png] Warning
Once you start georeferencing, keep going. If you close the georeferencer, there is an option to save the control points, but it’s best to just do the whole thing in one go.
Adding control points
Control points are the link between your scan and your base map.
[image: images/georeferencing/GeoreferencingToolbarAnno.png]
The Georeferencing toolbars.
· Click on the Add point button in the toolbar (tooltips will help you to find it).
· In the georeferencing window, zoom in to one of the grid intersections on your map.
· Left-click on the intersection as accurately as you can. There should be a tiny green spot where you clicked.
· The Enter map coordinates window should open. Type the x and y coordinates of the intersection into the appropriate box.
· Check that the correct CRS is selected in the dropdown box.
· Then click OK. The tiny spot should turn red to show it is set and the coordinates you entered should appear in the table at the bottom of the window.
[image: images/georeferencing/EnteringCoordinates_small.png]
Entering coordinates into the x and y fields. Note that the x is the coordinate at the top of the map, the y is the coordinate at the side of the map. The previously added coordinates show in the table at the bottom of the window.
· Move onto the next point and repeat the steps above at least five more times. You need a minimum of four control points, but more will be more accurate.
· Try to ensure that your control points are spread out across the whole map.
Georeferencing with landmarks
If you are georeferencing using landmarks, rather than grid intersections, when you click to add a control point, instead of typing in the coordinates click on the From Map Canvas button (you may also want to tick the Automatically hide georeferencer window box. This will allow you to click on the selected landmark on the base map.
Transformation settings
Once you have six points we need to set the type of transformation.
· Go to Settings > Transformation settings or click the cog symbol on the tool bar.
The Transformation type controls how your scan is stretched or reshaped to fit the base map according to the points you’ve added. Different transformation types use different mathematical methods of redrawing your scan.
If your scan is of a map which was created in QGIS, uses the same CRS, and has been scanned not photographed, then QGIS probably won’t need to do anything too complex to get your scan to fit the map.
· Drop down Transformation type and select Linear.
However, if when you scanned your map it wasn’t in the correct orientation, you may need to select a different transformation type to get it to work. Basically this means QGIS may need to rotate your map by 90 degrees for example. In this case:
· Drop down Transformation type and select Polynomial 1.
For both transformation types:
· Leave Resampling method as Cubic
· Check that the Target SRS is correct, in this case EPSG:27700 - OSGB36 / British National Grid.
· Click on the three dots button at the end of the Output raster row and navigate to your project folder. Give the output file a name that will help you remember what it contains.
· Under Compression choose LZW - this is a non-lossy type of compression for tiff files, which will ensure that your files don’t end up too large when stored on disk.
· Save GCP points and Set target resolution should both be ticked, and put 1 for both horizontal and vertical (Vertical will be a negative number).
· Check Load in QGIS when done is ticked
· Finally click on OK.
[image: images/georeferencing/TransformationSettings_small.png]
The Transformation Settings dialogue.
Once we’ve done this, the GCP table at the bottom of the georeferencing window will update to show numbers in the final few columns.
You can try out different transformation types to see which works best with your scan. You can’t select some until you have more control points, though.
Transformation accuracy
The column to look at now is the final one, headed Residual (pixels) This shows the error in map units using the current transformation type. For most maps, map units will be metres.
At the bottom of the window, there should be a list of numbers, one of which is Mean error:.
[image: images/svg/help_outline-black-24dp.png] What is the mean error for your georeferencing?
Looking at the bottom of the georeferencing window, what number is given for the Mean error?
[image: images/georeferencing/MeanError_small.png]
The GCP table and the bottom of the georeferencing window showing a Mean Error of 0.719387.
The image above shows that with Linear Transformation set, my mean error is 0.719. Apologies that the text is cut off slightly - I don’t know why my screen/computer is doing that!
[image: images/svg/help_outline-black-24dp.png] How worried do we need to be about this error?
An error of 0.719 metres on a 1:10,000 map is not a big issue.
Think about the error on your map. How accurate do you think the geology on your fieldslip is likely to be? How accurate were your measurements? Is an error of 1 m a reasonable amount? If you took locations by GPS, what was the accuracy of those? Probably not less than 1 m!
When it comes down to it, it is your decision what level of accuracy you think is reasonable with your data and on your map, but you are extremely unlikely to need to georeference to an accuracy of less than 1 m.
Solving georeferencing accuracy problems
If you need to increase accuracy, sometimes it can be a single, slightly mis-aligned point which can cause the most problem.
· Go back to the GCP table and have a look at the Residual (pixels) column. Is there one point which is higher than the others?
· If there is, try unticking it in the left-hand column. What effect does that have on the mean error?
· If the point is wrong because you’ve mistyped the coordinates, e.g. got x and y the wrong way round, you can fix that by double-clicking in the Dest. X and Dest. Y columns and retyping the values.
· Don’t forget to tick the Enabled box again to include the point.
· If you want to remove that point so it isn’t included in georeferencing at all, right-click on the row and remove.
· If necessary, add more control points to your map.
· If you still have high residual error or you’re not happy with how the map looks, try changing the Transformation type in the Transformation settings. Does setting it to Polynomial 1 work better than Linear? Try out some different options.
When you have the Mean error at a level you are happy with, you are ready to complete the georeferencing.
To complete the georeferencing
To finish georeferencing, you do need to click on the Start georeferencing button, which is slightly confusing. It indicates that QGIS will start running the georeferencing algorithms.
· Click on Start Georeferencing on the tool bar or go to File > Start Georeferencing.
· If your settings are correct, QGIS will run the georeferencer and a new version of the scan will appear in your Layers panel.
· You may need to Zoom to layer to be able to see the scan on your map.
Check that the scan appears in the correct place on your base map. Turn it on and off and check that any streams, roads, lakes etc appear in the same places as the streams, roads and lakes on the base map.
If you’re happy with the result, you are ready to save your map and start digitising.
If there are problems with the location of your fieldslip, you may need to go back and check the control points or try georeferencing again with a different transformation type. You do need to get this right or the digitising you do will be in the wrong location.
Once you have finished georeferencing, checked the end result, and saved your map, continue on to start digitising your data.
Further information: georeferencing
If you want more information about georeferencing, try the following.
· YouTube video by Hans van der Kwast - Georeference a scanned map in QGIS
· QGIS Tutorials and Tips has a tutorial on Georeferencing Topo Sheets and Scanned Maps (QGIS3)
· More information on Georeferencing from Wikipedia
All links last checked: 01/11/2022
Task workflows for geological features
Last Modified: 19 Sep 23, 14:14:02
This chapter doesn’t give any specific instructions but does include suggestions for sections of the following chapters you will find useful for completing particular tasks towards digitising the geology from your fieldslip, styling and labelling it.
Make sure you are familiar with the contents of these chapters anyway. Try out some of the techniques on sample data, where it doesn’t matter if it doesn’t work. If you need to find out how to do something else, use the search function (<Ctrl>-F) in Word to find it, or the navigation pane - View > Navigation Pane.
These workflows don’t include links to instructions setting up a base map, georeferencing your fieldslip or layout and presentation. Those apply to your whole map, not just to particular features. Creating a base map and georeferencing your fieldslip consist of step-by-step instructions and you should follow the whole chapter for each of these.
Use the links to go straight to each section within the workbook.
Bedrock geology
· Set up a geopackage feature class to contain your data.
· Digitise polygons and add attributes to describe each rock type, including a label to help identification of each feature on your map.
· Add extra fields if you need to add any extra attributes.
· Use topological editing and snapping to ensure no gaps or overlaps between polygons.
· Style your polygon layer, using categories. Use pattern fills if appropriate.
· Use opacity or blending modes to show geology on top of a background map.
· Label your polygons. If you need to set labels differently for different groups of features within a feature class, use rule-based labelling. Use the placement options for polygons.
· Remember to add labels to the patches in your key as well.
Geological lines
For example, faults, geological boundaries and fold axes.
· Set up a geopackage feature class to contain your data.
· Digitise lines, using snapping to follow edges of polygons or automatic tracing, and add attributes to describe the type of line. Include labels if required.
· Add extra fields if you need to add any extra attributes.
· Style your lines, using dashes for inferred lines or similar.
· Add “decorations” for fault ticks, fold symbols etc. Reverse your lines if necessary.
· Label any lines if necessary. Note, you don’t need to label lines with “fault”, “fold” etc, that should be shown by your key. If you need to set labels differently for different groups of features within a feature class, use rule-based labelling. Use the placement options for labelling along lines.
Structural symbols
For example, bedding, cleavage, foliation.
Workflow for adding structural symbols manually (not from a spreadsheet).
· Set up a geopackage feature class to contain your data.
· Digitise points, adding attributes as you go.
· Add extra fields if you need to add any extra attributes.
· Style your points. Add new symbol libraries, or create your own symbols if necessary.
· If you need to rotate your symbols, add a rotation field, then manually rotate each symbol.
· Label point symbols if necessary. For labelling symbols with dip, see suggested way to place labels.
· If you need to set labels differently for different groups of features within a feature class, use rule-based labelling.
Adding point data from a spreadsheet
· Prepare your spreadsheet data for importing.
· Convert British National Grid letters to numbers if necessary.
· Change Leeds method structural geology data to right-hand rule if necessary.
· Import data to QGIS with the Spreadsheet Layers plugin
· Convert the spreadsheet layer to a feature class
Digitising geological data
Last Modified: 10 Oct 23, 16:14:17
Unlike the chapters on creating a basemap and georeferencing, this isn’t a step-by-step guide where you start at the beginning and work your way through. You will be digitising your own data, and my explanations will, of necessity, be general. You need to look at the techniques available and decide which ones you need to be able to digitise your data.
Learning outcomes
When you have completed this section of the workbook you will know how to:
· Set up appropriate storage for GIS data.
· Demonstrate how to use GIS tools to create new spatial data and edit existing data.
· Explain how to import point data from spreadsheets or GPS in to GIS.
Introduction to digitising geological data
Now that you have a base map, and your field slip is georeferenced to the correct location, you can start to draw your geological data.
The process of tracing, or drawing in GIS is known as “digitising”.
For this chapter you will be digitising polygons, points and lines by tracing over geological features on your field slip. You will also learn some alternative ways to add point data to your map.
Each map you create will have different requirements, e.g. you may not need to add symbols to particular maps.
Some of these techniques will have been covered in the level one workbook, but they are all in one place here and are covered in more detail. The techniques are also being applied specifically to geological mapping.
This is a long chapter. You may not need to use every technique, but have a go at them and pick out what you need to use for the map you are working on at the moment.
Your level two map is an ideal opportunity to try out the techniques shown here on a small map before you start work on your dissertation map.
Experiment. You may well find better ways of doing things, or ways that suit you better. As ever in computing and GIS, there is more than one way to do most things and you may find a different way gives you better results or seems simpler to you.
Make use of any opportunity to get feedback on your maps. In level two, you can ask me to look at your map in the class if that will help you. I can’t comment on the geology, but I can give you feedback on the GIS and cartography aspects.
Note that in this chapter I am covering how to create your data. The next chapter, Styling and labelling geological data, will go into the detail about how to make your data look like a properly styled geological map.
I have included some workflows for digitising geological features in the previous chapter. These should help you find the appropriate sections of this chapter and the chapters on styles and labelling. These are some suggestions, make sure you have looked at all of these chapters to see what other techniques might help you to digitise your geological field slip, though.
Setting up GeoPackage feature classes to store your data
You should be familiar with storing data in GeoPackages from the level one course. Below is a reminder of how to set up feature classes, or layers, within a GeoPackage.
[image: images/svg/info-black-24dp.png] Geopackage format
A GeoPackage is a form of database specifically designed to store and retrieve spatial data efficiently. It has been developed relatively recently, but it’s use as a GIS format has spread very quickly. QGIS encourages the use of GeoPackages, and it is increasingly possible to use them in other GIS software.
During this course you will use GeoPackages to store your spatial data. If you want more information about the format there is a lot on the GeoPackage website.
The first thing you need to do is set up the storage for the data that you are about to create. You may already have a GeoPackage in your project, and if you do you can use that to store this new data too.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Creating feature classes in a GeoPackage
This video clip can be found in the module area of Minerva or in the full list of video clips.
Creating a new GeoPackage and adding a feature class
If you are going to use an existing GeoPackage go straight to the next section - Adding a new feature class to an existing GeoPackage.
If you don’t already have a GeoPackage or want to create a new one:
· In the Browser right-click on the folder in which you want to store the new GeoPackage or GeoPackage layer. It’s a good idea to use the Project Home folder if you have already saved your map but at least put it in the same folder as the rest of your project data.
· New > GeoPackage
· Give your new Geopackage a name in the Database field - don’t delete the path to it, just change the name. I tend to name the GeoPackage with the location general location of my map, e.g. Inchnadamph.gpkg
· Choose a Geometry type from point, linestring or polygon. (Note that once this is set for a feature class you can’t change it later)
· There is a drop down for the CRS (unlabelled) either drop that down and select the project CRS or use the button at the end of the line to search for the appropriate CRS. Remember, if you are working outside of the UK, this will not be British National Grid.
· If you want to add any fields to contain attributes you can do so now - it is also possible to add fields later
· Under New Field type in a Name - e.g. Label
· Choose a Type for your data.
· Then type a Maximum length if it is a text field.
· Then click on the Add to Fields List button to add the new field to the list. You can then add more fields if you need to.
· Once you’ve added all the fields click on OK to create the new feature class.
[image: ../../shared/docs/images/creating_data/NewGeopackageLayer_small.png]
Creating a new layer in a new GeoPackage.
The new feature class should be created in your GeoPackage and added to your map.
If the new layer isn’t added to your map drag it there from the Browser now.
If you can’t see the new layer in the GeoPackage you may need to select the top-level folder and then click on the Refresh button at the top of the Browser.
Adding a new feature class to an existing GeoPackage
If you already have a GeoPackage:
· Right-click on your GeoPackage in the Browser panel
· Select New Table
· If you get an error message saying Cannot Create New Tables
· click OK to get rid of it,
· then right-click on the GeoPackage again and this time select Add Connection.
· You won’t see any difference at this point, but now right-click and select New Table again.
· The New Table dialog should open.
· Fill in Table name with a name which will remind you what that table contains - for example, Bedrock
· Choose a Geometry type from point, linestring or polygon. (Note that once this is set for a feature class you can’t change it later)
· There is a drop down for the CRS (unlabelled) either drop that down and select the project CRS or use the button at the end of the line to search for the appropriate CRS. Remember, if you are working outside of the UK, this will not be British National Grid.
· If you want to add any fields to contain attributes you can do so now - it is also possible to add fields later
· Under New Field type in a Name - e.g. Label
· Choose a Type for your data.
· Then type a Maximum length if it is a text field.
· Then click on the Add to Fields List button to add the new field to the list. You can then add more fields if you need to.
· Once you’ve added all the fields click on OK to create the new feature class.
[image: ../../shared/docs/images/creating_data/NewGPKGTable_small.png]
The window to create a new table in an existing GeoPackage.
If the table isn’t added to your map automatically, drag it to the Layers panel from the Browser now.
If you can’t see the new layer in the GeoPackage you may need to select the top-level folder and then click on the Refresh button at the top of the Browser.
Adding fields to an existing layer
The instructions above showed you how to add attributes as you created the new layer, but sometimes you need to add attributes to an existing feature class or layer. This is how to do that.
· Open the Attribute table of the layer you need to add an attribute to.
· Either use Ctrl + E or click on the pencil icon (Tooltip = Toggle Editing Mode) to start editing.
· Then either use Ctrl + W on your keyboard or find the New Field button on the same toolbar to bring up the Add Field dialog.
· Fill in the dialog as required. The options will vary depending on the Type of data you want to store.
[image: images/digitising/AddField_small.png]
Filling in the dialog to add a new text field to an existing feature class. The options will vary depending on the data type.
· When you’ve added all the new fields you want to add, Click on the button to Save Edits or use Ctrl + S on your keyboard.
· Then Ctrl + E or the pencil icon to toggle editing off.
Planning your storage
You will now have the skills to set up the storage for your data.
Spend a few minutes looking at your field slip and thinking about the types of data you are going to be digitising.
You’ll find it easier to plan once you know what tools are available to you, so don’t worry if it isn’t obvious to you at the moment.
[image: images/svg/create-black-24dp.png] Feature classes to create for these exercises
I’d suggest that for most top-copy geological maps, you’ll need a minimum of three feature classes.
Create a GeoPackage now and add three feature classes / layers as suggested in the list below.
Add a text field called Label and another called Type to each one.
     • A polygon class for bedrock
     • A linestring class for geological lines, e.g. faults, fold axes, geological boundaries.
     • A point class for symbols, such as bedding and cleavage.
I’ll use that general plan in the instructions below, but it really is up to you how you plan your data. Some people prefer to have an individual feature class for each type of bedrock, or separate classes for folds and faults.
Once you know what you are doing, look for a scheme that makes sense to you and helps you to keep your data organised and produce a professional final map.
Creating new features by digitising
To get used to the tools below, I’m going to suggest that you start by moving away from your field slip to a blank part of the map and just try them out. This can all be deleted later, or just not included in your final map. Once you have decided which techniques to use you can apply them to your real data.
[image: images/svg/videocam-black-24dp.png] Editing features in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
Starting to edit
As usual, there is a choice of ways to start editing.
Start with the polygon layer you created, but this is the same for linestring and point layers too.
· Either right-click on the layer you want to add features to and select Toggle Editing or find the Digitising toolbar and click on the pencil icon (tooltip: Toggle editing).
· A pencil icon should appear next to the layer in the Layers panel.
[image: images/digitising/DigitisingToolbar_small.png]
The Digitising Toolbar with the Toggle Editing button activated.
· If you can’t see the Digitising toolbar go to View > Toolbars and check that there is a tick next to Digitising Toolbar.
· On the digitising toolbar click on the Add Polygon Feature button or press <Ctrl>+. (that’s a full stop). For a linestring or point it will be the same keyboard shortcut, but linestring or point instead of polygon.
The cursor should have changed to a target icon. The centre of this target is where you will create vertices (points) when you click on the map.
Saving edits
Edits are saved to the feature class in the GeoPackage, not to the map. So clicking save on the usual toolbar won’t save your edits.
To save data edits:
· Click the Save Layer Edits button on the Digitising Toolbar.
Make sure you save your edits regularly. It is frustrating if you’ve spent ages editing, then QGIS crashes and doesn’t save them.
Stopping editing
Stopping editing is simply the same as starting.
· Either right-click on the edited layer select Toggle Editing or find the Digitising toolbar and click on the pencil icon (tooltip: Toggle editing).
· If you haven’t saved edits, QGIS will give you a chance to save them now.
Digitising the geology
Using the instructions above you can start to digitise polygons, lines and points onto your map.
[image: images/svg/info-black-24dp.png] Using the instructions below
Below I will give the instructions in a way that assumes you are doing this for the first time. I will step you through some examples. When you are creating your own maps with your own field slips, you will need to make your own choices about names, shapes and field contents.
· To practice or get used to the techniques, move your map away from the area of your fieldslip(s) to a blank part.
· Toggle editing on.
· Use the mouse to left-click on the map. Each time you click you will create a vertex, or corner.
· To practice, click several times to create a polygon.
· If you are digitising the geology on your field slip, click somewhere on a geological boundary, then keep clicking along the boundary.
· To finish editing this shape, right-click anywhere on the map.
· You may find the Feature attributes window pops up. If it doesn’t you can press F6 on your keyboard, or open the attribute table by right-clicking on the layer in the Layers panel. You’ll be able to add the new attributes there instead.
· Fill in the Label as Lst - this will be used as a label on the map to show rock types.
· and the Type as Limestone, this will be used in the key and also to style the layer as a different symbol for each rock type.
· When you’ve done that, click on OK to finish.
[image: images/digitising/FeatureAttributes_small.png]
Filling in the feature attributes for the new digitised object.
Your new polygon should appear on your map, styled in the default style for your layer.
· Save your edit
Now you have your first polygon on your map. For a geological map you will need to digitise lots of these, and you will probably need to digitise them next to each other, with no gaps or overlaps. Continue to the next section to see how to do this.
Topological editing and snapping
This section shows you how to avoid gaps and overlaps between polygons and how to draw lines that follow the edges of other features.
To be able to see what is happening in this section, it is worth styling your polygon layer so the polygons are about 50% opaque. If you can’t remember how to do this see the section on setting opacity in the Styles chapter.
Topological editing and snapping are new concepts, but worth finding out about because between them, topological editing and snapping can make your digitising much more accurate and professional.
Topological editing is a technique which minimises errors by enforcing rules between shared boundaries, including not allowing overlaps and helping to minimise gaps.
Snapping is a setting which allows the cursor to move to an existing feature. You can control which features your cursor will snap to, and how far from the feature snapping will occur.
[image: images/svg/videocam-black-24dp.png] Using snapping and topological editing when editing in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
Snapping and topological editing settings
To set up snapping and topological editing:
· Go to View > Toolbars and tick next to Snapping toolbar.
· To enable snapping either click on the magnet icon (tooltip: Enable Snapping) on the toolbar, or S on your keyboard.
[image: images/digitising/SnappingToolbar_small.png]
The snapping toolbar with snapping enabled.
· Next click on the next button to the right, the one with the tooltip All layers.
· Select Open Snapping Options. The alternative way to find this menu is to go to Project > Snapping Options...
Now we need to set several options:
· Firstly, click the Topological Editing button.
· Click on the Allow Overlap button and select Follow Advanced Configuration. If, in the future, you do need two features to overlap, you’ll need to remember to switch this off. Disabling snapping doesn’t stop Topological editing or Allow Overlap from working.
· Now click on the All layers button and select Advanced Configuration
This should enable you to see a list of the vector layers in your project and make selections of the layers you want to use snapping and topology with.
· Tick the box on the left next to your polygon layer (in my case, that’s Bedrock) and tick the box further to the right under Avoid Overlap.
· Click on Vertex under Type and select Segment as well.
· For now, we’ll set a high snapping value so you can see how it works, so under Tolerance set the polygon layer value to 100 pixels.
· Also tick on the left next to your linestring layer (in my case, that’s geol_lines. You won’t have an option for Avoid Overlap for the linestring layer.
[image: images/digitising/SnappingSettings_small.png]
The Snapping Settings window with Advanced Configuration and Topological Editing set.
· You can keep the Snapping Settings window open if you wish, or close it now.
Adding a new feature with snapping and topological editing
Now you can start accurately adding additional features.
· Start editing your polygon layer and click to Add polygon feature.
· Hover over a vertex (corner) on the shape you have already digitised. You should see a small bright pink square. This indicates that if you click to create a vertex now, it will “snap” to that point.
· Hover over one of the longer sides on your previously digitised shape. This time you should see a sort of hourglass shape, this is because you selected Segment as well as vertex under Type. Again, if you create a vertex now, it will “snap” to that point.
· Create a new polygon by clicking on three positions on the existing polygon, then moving away to click in blank space.
· Finish by right-clicking.
· If the attribute dialog opens fill it in with:
· Label = Sst
· Type = Sandstone
· Save your edit.
· Try creating another polygon which overlaps one of the polygons you’ve already created. You should find that the overlapping area doesn’t digitise. Try selecting each polygon in turn to check this. This is the result of setting Avoid overlap for the polygon layer.
· Now you’ve seen how snapping works, return the snapping numerical value to 12 - values that are too high can be more of a hindrance than a help.
The new polygon should fit nicely against the existing one with no gaps or overlaps. To check this, use the Select features button on the Selection toolbar (you may need to drop down the arrow next to the button on the left of the toolbar to find this) to select each polygon in turn.
[image: images/digitising/SelectionToolbar_small.png]
Selecting Select Features from the Selection toolbar. You may need to drop down the arrow next to the button on the left.
Creating curves with the editing tool
You may have realised by now that the editing tool you are using is rather basic. It produces straight lines, but not curves.
The most effective way to use the tool is simply to click more frequently, at smaller intervals, around curves. If you’re careful about how you do this the result is usually absolutely fine.
There are other tools on the Advanced Digitizing toolbar which can produce curves, for example, Digitize with Curve and Enable Stream Digitizing. Try these out if you wish, but I’ve not found them very easy to use to produce a professional end result.
To draw curves with the usual editing tool:
· Zoom in closely to the line or edge you are tracing.
· Digitise as usual, but click frequently to create a lot of vertices.
· Don’t try to be too perfect about this! It’s a balance between time and the final result at the scale at which people will be looking at your map.
[image: images/svg/create-black-24dp.png] Try digitising lines and points
Lines and points are digitised in exactly the same way as polygons. The main difference is that lines don’t “close”, so the end doesn’t go back to the beginning, and for points you only have to click once.
Try using the techniques above to draw lines either on their own, or accurately following the edges of the polygons.
Also add a few points at random over your polygons so you can see how digitising points works.
Don’t forget to keep saving your edits, and get into the habit of toggling editing off on layers that you have finished editing.
If you create features you don’t want to keep, there are instructions for deleting features a bit further on.
Automatic tracing
Automatic tracing allows you to digitise new features next to existing features without having to click on every vertex. This can be very useful if you are digitising complicated shapes. It can be difficult to get used to, but once you can use the tool effectively it can save you a lot of time.
This technique can be particularly useful for adding lines along the edges of existing polygons, for example, if you need to add a fault between two bedrock polygons.
[image: images/svg/videocam-black-24dp.png] Using automatic tracing in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
To automatically trace along the edge of an existing feature:
· Select your polygon feature class and toggle editing on.
· Either press T on your keyboard, or click the Enable Tracing button on the Snapping toolbar.
· If you don’t already have snapping set for the layers you are working with, enable it now.
· Click on a vertex or segment (depending on your settings) along the edge you want to trace.
· Now gently move the cursor along the line. You don’t need to be too exact, and when you get to the end of the part of the boundary you want to trace, click and then move away to complete the line or polygon.
· Finish by right-clicking as usual and don’t forget to save your edits.
[image: images/svg/create-black-24dp.png] Use automatic tracing to add a line to the boundary of a polygon
Now toggle editing on for your line feature class and try using automatic tracing to digitise an accurate line along the edge of the polygons on your map.
Don’t forget to keep saving your edits, and get into the habit of toggling editing off on layers that you have finished editing.
[image: images/digitising/DigitisedGeology_small.png]
Digitised points, lines and polygons. The lines follow the edges of the polygons. None of the features have been styled yet, that happens in the next chapter.
Turning off snapping and topological editing
If you decide not to use snapping, or it gets in the way on one particular section of your digitising:
· Toggle it off by clicking on the magnet icon again, or S on your toolbar.
· If you don’t wish to use topological editing (though that is very strongly advised) or avoiding overlap, you will need to turn those off separately on the Snapping toolbar.
· Note there are a few editing tools, such as Add Ring which don’t work if you have topological editing enabled.
Merging
This will only work on polygons, not linestrings or points.
If you’re working on a large or complex polygon it can be annoying if you get most of the way round then make a mistake or have to stop for some reason. Get around this by digitising part of the polygon at a time then merging the separate polygons.
For this to work, you will need to disable topological editing.
· Open the Snapping Settings - Project > Snapping options
· Untick Avoid Overlap next to the layer on which you want to merge features.
· Close the snapping settings, unless you only want to turn off Avoid overlap briefly.
If you leave Avoid overlap on, you’ll end up with polygons next to each other. When you merge them, you might end up with lines across the merged polygon which are very difficult to get rid of.
[image: images/svg/videocam-black-24dp.png] Merging vector features within a layer in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
You will need to have the Advanced Digitising Toolbar open:
· Go to View > Toolbars and tick next to Advanced Digitising Toolbar.
[image: images/digitising/AdvancedDigitisingToolbar_small.png]
The Advanced Digitising Toolbar.
· Start editing your polygon layer and click to Add polygon feature.
· Create a feature on top of the existing feature labelled Lst, overlapping generously. Create a few more overlapping features.
[image: images/svg/warning-black-24dp.png] Warning
Do make sure you overlap features you want to merge. If you try to snap edges, once you have performed the merge you will be left with strange lines across the centre of the merged polygon. Once you have those, it is fiddly to get rid of them.
[image: images/digitising/OverlappingMerge_small.png]
There are multiple polygons for the Lst - the opacity allows you to see that they are overlapping.
· Save your edits but don’t stop editing.
· Use the Select features tool to select all of the polygons you want to merge, using the shift key to select multiples.
· On the Advanced Digitising Toolbar find the Merge Selected Features button and click on it. It’s near the right-hand end of the toolbar and looks like two shapes being stitched together.
· The Merge Features dialog will open, giving you a chance to chose how the attributes of the merged polygon will be filled in.
[image: images/digitising/MergeFeatures_small.png]
The Merge Features dialog. Choose the button below to select which attributes are in your final polygon.
· In my case it doesn’t matter which I choose as they are all the same. I’m going to click on Take attributes from feature with the largest area. Whichever you click on, the tool will preview for you the one it’s using.
· Then click OK.
· Don’t forget to save your edit if you are happy with it.
Check the attribute table to see that you now have a single polygon with the attributes you selected.
[image: images/digitising/Merged_small.png]
The single merged Lst polygon - compare with the image above.
Changing existing features
You’ll probably find that having drawn your features on your map you need to make some changes to them, e.g. if you’ve drawn the boundary of two rock types in the wrong location or need to change the location of a line or point. The techniques in this section will show you how to make these changes.
Make sure you have drawn several features of each type of point, line and polygon and that you have snapping and topological editing enabled.
Changing shared boundaries with topology
[image: images/svg/videocam-black-24dp.png] Changing shared boundaries with topology in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
If you are digitising geology you are likely to have boundaries which are shared between two polygons. If you need to make a change to one, you will also need to make the corresponding change to the other or you will end up with gaps or overlaps. Topological editing will enable you to do this easily.
You should already have set up topological editing in the snapping toolbar.
· Select your polygon layer in the Layers panel and toggle editing.
· On the Digitising Toolbar click on the Vertex tool, which looks like a hammer and screwdriver next to a bent line.
· Use the cursor to left-click on a vertex on a shared boundary between two polygons.
· If you move the cursor now, a red vertex should move with it and you should be able to see how the shape of your polygons will change.
· When it is in the correct place, left-click again.
If it has worked properly, you should find that the polygons on both sides of the boundary have changed.
Try this a few more times, and don’t forget to save your edits.
Adding vertices
Sometimes you’ll need to add an extra vertex between two others.
· With the vertex tool, hover over the line on which you want to add a vertex.
· You should see a red cross appearing, left-click on that then move the cursor.
· Left-click again to place the new vertex where you want it.
Removing vertices
Sometimes you need to remove a vertex. This is particularly helpful if you need to straighten or simplify a line.
· With the vertex tool, left-click on the vertex you want to remove.
· Press Delete on your keyboard.
The vertex should disappear, and the object will straighten out between the neighbouring two vertices.
Vertex editor
This can be particularly use for setting up a feature to cover a particular area for which you know the coordinates, or for moving a point.
· With the vertex tool, right-click on an editable feature.
· The Vertex editor will open and show the x and y coordinates for the feature you’ve clicked on.
[image: images/digitising/VertexEditorPolygon_small.png]
The vertex editor panel for a polygon showing the x and y coordinates for each vertex. You can type new values into this table to edit your features.
[image: images/svg/create-black-24dp.png] Use the vertex editor to move a point symbol
Open the vertex editor for one of the points you’ve created.
Try increasing the value of the x and y coordinates by 20 each, watching what happens when you press <Enter> to confirm the new values.
Deleting features
[image: images/svg/videocam-black-24dp.png] Deleting vector features in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
You may well find that you need to completely delete a feature you’ve drawn.
· Check editing is toggled on for the correct layer.
· Use the Select features tool from the Selection toolbar to click on the feature you wish to delete. The feature should change to a highlight colour, which shows it is selected.
· Either press the Delete key on your keyboard
· Or use the red Delete Selected button on the Digitizing toolbar.
· As usual, don’t forget to save your edits!
Adding attributes to a feature class
Earlier I gave you instructions how to add fields to an existing layer, use these to add any additional fields that you need. If you don’t have the fields available, you can’t add data to them.
Adding or changing attributes
The section on tracing your polygons from the field slip explains how to add attributes to a record as you digitise. There will also be many times when you need to add attributes later, or change the ones that are already there, and that is what this section covers.
[image: images/svg/videocam-black-24dp.png] Adding or changing attributes in a feature class
This video clip can be found in the module area of Minerva or in the full list of video clips.
In the layers panel check that the feature class you want to change or add attributes to is selected:
· Open the attribute table (right-click then Open attribute table).
· If you aren’t already set up for editing, click on the Toggle Editing Mode button at the top left of the attribute table window, or press <Ctrl>-E.
· Click in a field in the table and type your new or changed attribute.
· Press <Enter> to complete it, or <Tab> to move to the next field.
· When you’ve finished editing, click the Save Edits button at the top of the attribute table or <Ctrl>-S, then toggle editing mode again to stop editing.
Don’t forget to save your edits to the attribute table or you’ll lose your hard work.
Selecting a feature
If you have a lot of features in your attribute table it can be difficult to see which one you want to edit. Selecting the feature on the map first can be really helpful.
· Click on the Select features tool on the Selection toolbar, then click on the feature on the map which you want to edit. The selected feature should change to a highlighted colour.
· You can select multiple features by holding down the Shift key and clicking on as many as you want. You can also use the Select Features tool to “draw” a shape over the map and select all the features it touches.
· Now go to the Attribute table and you should find that the feature you want to add attributes to is selected in the table.
· This works both ways, you can also select in the attribute table by clicking on the grey box to the left of the record, then the selected feature will also be selected on the map.
· Try right-clicking on a feature in the attribute table and selecting either Zoom to feature, Pan to feature or Flash feature. These are all potentially useful ways of finding a particular feature.
Once you’ve selected a feature or features, you can clear your selections by simply clicking the Deselect all features from the layer button or pressing <Ctrl>-<Shift>-A on the keyboard.
[image: images/digitising/SelectionToolbarClear_small.png]
Clearing selections from the Selection Toolbar.
Advanced Digitising Tools
You’ve already opened the Advanced Digitising Toolbar to use the Merge tool, but there are plenty of other tools available there. Try out some of the other tools on your sample layers to see what they do.
I’m not going to go into more detail about them here. You can do everything you really need to do without using further advanced tools, but some of the tools might make digitising easier. If you want more information have a look at Advanced Digitizing in the QGIS user manual.
Creating point features by importing
Point data can be added either by editing the map, as in the section above, or by importing it from a spreadsheet or text file.
When you are working with your own data you will have all of these measurements on your field slip and in your notebook. It is completely up to you as to whether you would rather add bedding, cleavage etc to your map by digitising, or by collating them into a spreadsheet and importing them. Digitising may well be the simplest!
If you have other measurements, e.g. geochemical readings, they may be in a spreadsheet anyway so this will be the method to use.
It is completely up to you which method you use, but have a go at both before you decide.
Xyz files can be either comma separated value text files or Excel (or similar) spreadsheets. They contain point data which includes coordinates for a geographic location, either in two dimensions (x and y) or three (x, y and z). The example we’ll use here is an Excel spreadsheet.
[image: images/svg/info-black-24dp.png] Creating point features by importing
You have already covered the techniques here in the workbook from level one, when you imported geochemistry data. The information here includes extra sections about plotting structural geology data, but generally the principles are the same.
Creating xyz files and preparing for import
You can create xyz files in any spreadsheet program, such as Excel. You need to ensure that your data has an x and y coordinate for each location.
The example below shows grid references for the British National Grid in columns headed easting and northing. Other information can also be included, for example the sample number, a location name, measurements.
· Start by making a copy of your spreadsheet. Make sure you keep the original version and work on a copy so you don’t lose any data if anything goes wrong.
[image: images/svg/warning-black-24dp.png] Warning
Note that when you are preparing a spreadsheet to import into GIS, the column headings must be short and contain no spaces or non-standard characters. So, use text, numbers and underscore characters only. Always check your tables, and edit them as necessary before importing into GIS.
Also check there is no other data in your spreadsheet, for example, sometimes descriptions or extra information are given on the first few rows of the spreadsheet. If this is the case, delete them from the copy you are going to import into GIS.
[image: images/digitising/ExcelSpreadsheet_small.png]
A spreadsheet table ready to import into GIS. Note the short titles with no punctuation or spaces, and no surplus text above the table. The x and y coordinates are in the columns headed easting and northing.
This example spreadsheet is ready to add to QGIS, but for your spreadsheets, don’t forget to check the format of the x and y coordinates, and whether you need to convert dip direction - see the instructions in the next couple of sections.
British National Grid 100 km squares
British National Grid references are often given in the form NN6005,2674, with grid letters at the start to give the 100 km grid square. These letters need to be replaced by numbers if the grid references are to be read by QGIS.
[image: images/svg/warning-black-24dp.png] Warning
If your grid references already have the 100 km grid numbers you should not try to change them. Check your data first!
If you are given a reference that does not include the grid letters but consists entirely of numbers, it is worth checking whether the grid numbers make sense. Of course, it may just mean that the person who created the references forgot about the letters, in that case the reference could refer to any of the 100 km squares covering the UK - not helpful!
Replacing 100 km grid letters with numbers
[image: images/svg/videocam-black-24dp.png] Replacing British National Grid 100 km grid letters with numbers
This video clip can be found in the module area of Minerva or in the full list of video clips.
Follow the example below, then have a go for yourself with the examples provided.
[image: images/digitising/BNG_small.png]
British National Grid 100 km grid squares.
Using the example SK 6005 2674:
· find the number of the line to the left of the grid square in the image above (i.e. one of the numbers from the line at the bottom of the map) - for SK this is “400” - so write it down as 4.
· This number will apply to all of the references in the eastings column of the spreadsheet
· then find the number of the line below the grid square (i.e. one of the numbers to the left of the map) - in this case “300” - so write it down as 3
· This number will apply to all of the references in the northings column of the spreadsheet
So in this example grid reference SK 6005 2674 will become 46005 32674.
· In addition, x and y numbers all need to be six figures to appear in the correct location on a map in QGIS, so if, as in the example, there are fewer digits then we have to add zeros to the end of each to make it up to six figures.
Finally the grid reference above will become 460050 326740 and at this stage will be ready to enter into QGIS.
[image: images/svg/create-black-24dp.png] Practice converting grid letters to numbers
Using the instructions above convert the following grid references to British National Grid numbers with 6 figures for each half (12 in total) so that QGIS will be able to read them. Answers are in the footnotes[footnoteRef:345]. [345:  The QGIS-readable grid references are as follows:
1 - NH 3395 3196 = 233950 831960
2 - SP 727 499 = 472700 249900
3 - TM 2753 3952 = 627530 239520] 

1 - NH 3395 3196 =
2 - SP 727 499 =
3 - TM 2753 3952 =
If you look at the corners of a published hardcopy Ordnance Survey map such as the Landranger (Pink covers) or Explorer (Orange covers) series you’ll be able to see these numbers as small figures on the labels of the grid lines - only at the corners, though, not right around the edges. The grid letters will appear in the corner of the published maps too.
Replacing the numbers in your spreadsheet
If you don’t have many locations that you need to change then you can edit each one manually, but if you have many sample points this rapidly becomes a big job. Try using the power of the spreadsheet to do this more efficiently.
Start by working out what numbers you need to replace the grid letters using the instructions above.
· Open your spreadsheet in Excel or similar
· Give headings to two more columns to the right of the rest of the data - call them x and y
· Click in the first cell in the x column then go up to the Formula Bar at the top
· Type =( in the Formula Bar then click on the first cell in the easting column, the reference of that cell should appear, e.g. C2
· Now type in the formula bar - *10)+200000 (that’s 5 zeros after the 2). The first number before the 5 zeros (2 in this example) should be the one that you found when converting the grid letters. We are multiplying by 10 to add a zero to the end of the original number so that once we’ve added 200000 we have a six-figure number.
The statement should read:
=(C2*10)+200000
· Press Return to apply the statement to the cell.
[image: images/digitising/ExcelFunctionBar_small.png]
Typing the function in the first cell.
The six-figure reference for the x coordinate should appear in the cell.
· Repeat the above for the first cell in the y column using the northing column and the second number that you found.
· Now select both of the cells that you’ve just edited
· Note the tiny square at the bottom right of the selection, click and hold on it and use the mouse cursor to pull it down the other cells in those columns.
The rest of the cells should autofill with the correct grid references.
[image: images/digitising/XYZpbSpreadsheet_small.png]
The first few rows of the spreadsheet containing the location of samples.
Save your spreadsheet then close it and make sure that your map is open in QGIS.
Plotting structural geology data in GIS: Leeds method vs Right-hand rule
When you take structural readings in the field in the way you have been taught, you will be recording them using the Leeds method as (for example) 010/18NW, with the strike being between 0 and 180, but if you then use a spreadsheet to import them into GIS, which uses the right-hand rule, the tick mark will be in the wrong direction for some of your measurements.
The problem isn’t with your measurements, but with the way that GIS is able to handle them.
Once you have imported your points into GIS and styled them always have a close look to make sure that they agree with your symbols on the field slip.
This is a general tip - when you’ve added any data to GIS you should always check that it looks correct.
If you don’t need to convert structural data from the Leeds method to the right-hand rule then continue on to the next section.
Changing Leeds method strike and dip to the Right-hand rule for GIS
The information in this section was provided by Ph.D. student Josh Wolstenholme, to whom many thanks.
Remember that you can also add strike and dip measurements to your map by digitising the points directly from your field slip. You do not have to add them via a spreadsheet. Sometimes digitising them directly can be quicker. It probably depends just how many points you need to digitise.
The right-hand rule (RHR) is a notation for geological measurements adopted by some of the geological world, including software such as ArcGIS, QGIS and Stereonet 9. The right-hand rule essentially states that the ‘dip tick’ (using bedding strike and dip as an example) must always be on the right of strike line as shown below.
[image: images/digitising/rhrComparison.png]
Right hand rule vs Leeds notation. See the table for the measurements.
	a
	a
	b
	b
	c
	c
	d
	d

	Leeds
	RHR
	Leeds
	RHR
	Leeds
	RHR
	Leeds
	RHR

	000/52E
	000/52
	048/52SE
	048/52
	063/52NW
	243/52
	153/52NE
	333/52


In the image an indicator arrow has been placed along the strike as a reference to keep the dip on the right-hand side of the strike. You wouldn’t usually include this arrow with your symbols. The table shows the equivalent data using the Leeds method and the right-hand rule.
You may find it easier to understand by drawing a strike and dip on a piece of paper and rotating it yourself. This helps to visualise what is happening.
Converting dip direction into RHR
Essentially, if you dip direction is between just above west (271°) and just below east (089°) you will need to create a new strike.
If you refer back to the examples above measurements a and b have a dip direction between 090° and 270°, whereas c and d are between 271° and 089°.
In Excel, a simple (but complex looking!) formula can calculate this all for you. It utilises the operators =IF and =OR to determine whether you measurement needs converting or not.
Remember, once you have imported your points into QGIS and styled them always have a close look to make sure that they agree with your symbols on the field slip.
The formula we will use is as follows (note that the code should all be on one line):
=IF(OR([@[Dip Direction]]="N",[@[Dip Direction]]="NE",[@[Dip Direction]]="NW",[@[Dip Direction]]="NNE",[@[Dip Direction]]="NNW",[@[Dip Direction]]="E"),[@[Strike/Azimuth]]+180,[@[Strike/Azimuth]])
This essentially states that if any of the values within the Dip Direction column are equal to any of the following: “N”,“NE”,“NW”,“NNE”,“NNW”,“E” there will be 180° added to the Strike/Azimuth in a new cell. If the condition is not met (i.e. Dip Direction does not equal any of the aforementioned), then the original strike is preserved and placed in a new cell.
An alternative way of doing this is to use an actual dip direction in degrees. This is more accurate and a quicker formula to write, however requires more data collection or processing:
=IF(OR([@[Dip Direction]]>270,[@[Dip Direction]]<90),[@[Strike/Azimuth]]+180,[@[Strike/Azimuth]])
This takes the reading from the Dip Direction column (i.e. the direction the dip is pointing), and tests if it is either >270 (North-west to North) or <90 (North-east). If so, 180° is added to the Strike/Azimuth in a new cell. If the condition is not met, then the original strike is preserved and placed in a new cell.
N.B. The [@[Name]] notation refers to a column within a formatted table. It is perfectly fine to use an individual cell reference such as G38 (for example).
Excel document with examples
There is an associated Excel document with this workflow, which makes use of the first example of code with sample data.
· Right-hand rule spreadsheet (Excel format download).
Importing data from spreadsheets
Once you have checked your spreadsheet and updated it as necessary, you can finally add your data to QGIS.
The most reliable way to add xyz data to QGIS is to use the Spreadsheet Layers plugin.
Installing the Spreadsheet Layers plugin
One of the strengths of QGIS is that it has a wide variety of plugins that you can install to carry out extra tasks. It’s worth having a look at the list of plugins available to you in the plugin manager.
[image: images/svg/videocam-black-24dp.png] Installing plugins in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· In the menu bar go to Plugins > Manage And Install Plugins...
· When it opens click on the Installed heading on the left to see the plugins that are already installed.
· If you click on a plugin you’ll be able to see a bit about it in the panel on the right.
[image: images/digitising/PluginsInstalled_small.png]
The plugin manager showing the core plugins that are installed when you install QGIS. Your list will probably be different to mine.
To install a new plugin:
· Click on Not installed on the left
· Type Spreadsheet into the search box at the top
· From the list that appears click on Spreadsheet Layers and have a look at the description
· This plugin will do what you want it to do so click on Install Plugin
[image: images/digitising/PluginsSpreadsheetLayers_small.png]
Installing the Spreadsheet Layers plugin.
Once it has installed you should get a message at the top telling you it has been successful, and Spreadsheet Layers should now be in the list of Installed plugins.
· You can Close the plugin manager now.
· If you can’t see the Manage Layers toolbar (see image below) make it visible by going to View > Toolbars and putting a tick in the box next to Manage Layers toolbar. It will probably open vertically to the left of your Layers and Browser panels.
· You should gain a new button in the Manage Layers toolbar - hover over it to see the tooltip which should say “Add spreadsheet layer”.
[image: images/digitising/ManageLayersToolbarSpreadsheet_small.png]
The Manage Layers toolbar showing the new button for Add spreadsheet layer.
Converting the spreadsheet
[image: images/svg/videocam-black-24dp.png] Importing points from csv or spreadsheet to QGIS with the Spreadsheet Layers plugin
This video clip can be found in the module area of Minerva or in the full list of video clips.
To convert a spreadsheet so you can use it in QGIS:
· Click on the Add spreadsheet layer button on the Manage Layers toolbar to open the dialog. Start filling it in by browsing to your spreadsheet file using the button to the right of File Name.
· Make sure there is a tick in the box next to Geometry and select the x and y fields as appropriate. In the spreadsheet example above, those fields will be easting and northing.
· Set the Reference system to the correct CRS.
· Check the data types in the preview pane. You may find that you need to change some data types from Text to Integer or Real to show that they are number types (Integer will have no decimal places, Real will have decimal places).
· Check the table previewed below looks correct.
· Then click OK.
[image: images/digitising/CreateLayerFromSpreadsheetFile_small.png]
Creating a layer from a spreadsheet file. Check the CRS is set correctly and the preview below looks right. Remember to check the data types for text, real and integer.
The data points from the spreadsheet should appear in the map you have open in QGIS. Use Zoom to Layer to check the location if you need to. If they don’t appear where you expect them to, check that you entered the x and y columns correctly in the spreadsheet tool, and also check you selected the correct CRS.
If you have a look in your folder in the Browser panel you’ll see the new layer has been created with an extension of .vrt. This means it is a virtual GIS format which references the original file. For our purposes, it is a good idea to convert this to a GeoPackage feature class, i.e. a more permanent file format. This will allow us to use the layer in analysis.
· Right-click on the layer in the Layers panel and go to Export > Save features as....
· Save the layer to a new or existing GeoPackage in your project folder and give it a name that will mean something to you next time you come to work on your map.
· Check the CRS is correct.
· Once the GeoPackage layer is added to your map, remove the .vrt layer to prevent confusion.
As usual it is important to look at the data to see what it contains and to check your attribute table against the spreadsheet.
Creating point and line features from GPS
When you are collecting your own data you may well find yourself using a GPS receiver, or collecting GPS data on a mobile device. If you do, you are likely to need to know how to add data from gpx files to QGIS. This section covers the things you need to be aware of when collecting data, and how to import the data into QGIS for use on your maps.
If you are new to GPS and would like to find out more about the background and technology, there is a beginners guide at:
· Garmin - What is GPS?
Considerations when collecting data with GPS
Setting up the GPS
It is possible to collect data via GPS with a dedicated GPS receiver, or by using an app on a smartphone.
Given the possible variety, I can’t give instructions for downloading data. You’ll need to look at the instructions for your own device.
There are however, a few things you should check before you start collecting data.
· Check the coordinate reference system (CRS) or projection. If you are using GPS as a supplement to a paper map (which you should be…), set the CRS to the same as the map. In the UK that is usually British National Grid or OSGB 1936/OSGB36. For other countries, look at the maps you are using. This will then allow you to check location on the GPS against location on the map.
· GPS units usually store data as WGS 1984 (EPSG:4326), and this will be the CRS of the data you download. If you are using an app on a smartphone, check the CRS of the output.
Data accuracy
The general advice is to turn on your GPS well in advance of starting to work, and leave it on for the whole of the working day. This gives it a chance to find and track the maximum number of satellites. Even under ideal conditions, when your receiver has found several satellites, due to the nature of the system, accuracy still won’t be 100%. Your device should allow you to see the current level of accuracy, usually a measurement in metres. Be aware of this when using the readings and keep a note of it.
It is particularly worth noting that GPS can give an illusion of extreme accuracy. The readings tend to show figures with lots of decimal places, which could lead you to assume that a reading is accurate to 1 m or less. This is extremely unlikely to be the case!
For this reason, it is still important to know how to locate yourself accurately on a paper map without the use of GPS, and most navigation experts will say that with practice you can be far more reliable and accurate than a GPS unit. Not least, you should have the intelligence to recognise when the point you are standing at is at the top of a cliff, not off it!
Elevation
Don’t use elevation measurements from your GPS. For various reasons, obtaining accurate height readings with GPS is much more difficult than obtaining accurate horizontal readings. The Ordnance Survey web site has an explanation of how best to do this, but it involves specific equipment and readings taken over at least 24 hours.
Downloading data
Again, I can’t give you definite instructions about downloading data from GPS as I don’t know what device you are using.
Choice of format may vary. These instructions assume gpx format. You can also add other formats to QGIS, such as kml or kmz.
If you are using a smartphone app, it can sometimes be simplest to email the output to yourself.
I have provided a sample gpx file for Becketts Park in Far Headingley which you are welcome to download and use to follow the instructions below if you want to.
Adding GPX files to a map
For this section I am assuming you have exported, shared or downloaded your data as gpx format. Your device or app may export as a different format which may need to be added to a map in a different way. You may need to experiment.
GPX files tend to include multiple layers, even if some of them have no data.
· Waypoints - point data - this may be most useful for collecting geological data as you can mark the position of outcrops with a waypoint.
· Routes - linestring data.
· Tracks - multilinestring data, that is a line with the potential for multiple segments.
The sample Becketts Park file contains Waypoints and a Track.
Checking the properties of your gpx file
It’s always a good idea to start by checking the properties of the data you are going to add to QGIS.
· Use the Browser panel to navigate to the location of your gpx file.
· Click on the small black arrow next to the gpx file to open it out and show the layers.
[image: images/digitising/GPXBrowser_small.png]
Viewing the GPX file in the Browser panel. The contents include route_points, routes, track_points, tracks and waypoints.
You may be able to see at least layers called routes, tracks and waypoints, and also route_points and track_points, but don’t worry if you can’t see all of these. It may just mean your device has saved the data slightly differently.
· Right-click on the Waypoints layer and select Layer properties.
[image: images/digitising/GPXLayerProperties_small.png]
The layer properties for the Waypoints layer showing geometry, number of features, CRS, and other information.
The layer properties will tell you the data geometry, number of features in the file, and importantly, the Coordinate Reference System (CRS).
· Look under CRS and you should see that the Units are Geographic (uses latitude and longitude for coordinates) - this is a clue that you’ll need to project the data once you’ve added it to QGIS so the units become metres.
· You can also use the Preview tab at the top of the layer properties to get a preview of your data.
· Close the layer properties.
You can view the layer properties for the other layers in the gpx file in the same way.
Adding waypoints and tracks to QGIS
[image: images/svg/videocam-black-24dp.png] Adding a gpx layer to a map in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
GPX layers can be added to a map in QGIS in the same way as many other geographic formats.
· In the Browser panel, either double-click on a layer from the gpx file or drag and drop it to the Layers panel or map.
· Or drag and drop the whole gpx file. If you do this you’ll be asked to Select Items to Add, and can select from the available layers.
[image: images/digitising/GPXSelectLayers_small.png]
Select the layers you want to add to your map. The dialogue shows how many features each layer contains.
If this is the first layer you have added to your map, the CRS of the map will be set to EPSG:4326, which is WGS 1984.
If you are adding the gpx layer to an existing, projected map, you may need to accept a transformations window.
Exporting gpx layer to a GeoPackage
When you are using data from gpx in GIS it is a very good idea to convert it to a native GIS format, such as shapefile or GeoPackage.
Given the data from gpx is in a geographic coordinate system, you will need to project the data to the same projection as the rest of your data, and you can do this in the same process as saving the data to a GeoPackage.
· In the QGIS menu go to Vector > Data Management Tools > Reproject Layer....
· The Input layer is the layer from the original gpx file
· For Target CRS select the projection of the rest of your map data, in this case it is EPSG:27700 British National Grid, but yours may be different.
· Under Reprojected click on the three dots button and select where you want to save the file. This can be in a GeoPackage, either new or one that already exists.
· Click Run.
[image: images/digitising/GPXReprojectLayer_small.png]
Reprojecting the Waypoints layer from the gpx. The original layer is EPSG:4326, the new layer is being reprojected to EPSG:27700.
QGIS should add the new layer to your map.
Repeat with any other layers from your gpx file that you wish to use on your map.
You can now use these layers in the way you would use any other geographic layers in GIS.
Further information: digitising
Many of the books in the reading list in Minerva have a general introduction to inputting data to GIS. Suggestions include the following:
· Chapter 5, Data input and editing in Heywood, I., Cornelius, S. and Carver, S. (2011), pp.135-173 covers the background to a variety of ways of inputting data to GIS and discusses data quality issues.
· Chapter 8, Data Collection in Longley, P.A. et al. (2015), pp.173 onwards. Again this chapter covers the background to a variety of ways of collecting data and inputting it to GIS. Section 8.3.2 from page 183 covers Vector Data Capture, or digitising.
The QGIS Documentation has a chapter on the techniques of Editing which covers much more than we have been able to cover here.
The information about Digitising an existing layer covers the topics in this chapter, but there is plenty more there.
· Digitising an existing layer for v. 3.22 of QGIS
There are a lot of videos on YouTube which may help you. Try searching for Digitising QGIS. Check the version of QGIS the videos you find are aimed at. Try and pick one for versions 3.16 and over.
Conclusion
You are unlikely to have needed to use all the techniques in this chapter, but you should have picked out those which enable you to add all your geological data to a map in QGIS.
By the end of this chapter you should have a basic map which shows accurately digitised geological polygons, points and lines on a topographic background. This map should now be ready for you to style and label the data to produce a professional map.
Styling geological data
Last Modified: 22 Aug 23, 14:09:31
Unlike the chapters on creating a basemap and georeferencing, this isn’t a step-by-step guide where you start at the beginning and work your way through. Though you will be using similar data, yours will be different to mine, and probably to other people in your class, and my explanations will, of necessity, be general. You need to look at the techniques available and decide which ones you need to be able to style your data appropriately and professionally.
The principles of styling and labelling data were covered in a lecture in level one, and the video of that lecture should still be available to you in Minerva. If you are unsure about some of the principles it would be worth watching that before starting to style and label your map.
Learning outcomes
When you have completed this section of the workbook you will be able to
· Use a wide variety of styles to display your data clearly and informatively on your map.
Introduction to styling geological data
In the previous chapters you’ll have created your data and added information to the attribute tables. Now you’ll learn the techniques to style, or symbolise, that data to make a more informative map ready to present to an audience.
When you first add a vector feature class to a map, QGIS styles it with a single, random colour, and doesn’t add any automatic information about what the features show. You need to need to style your data to differentiate them, and probably add labels to show your audience what each feature indicates.
[image: images/svg/warning-black-24dp.png] Warning
The sections below show the general principles, some of which you’ll have tried out in the level one workbook chapter titled “Styling and labelling your data”. You will need to decide for yourself which techniques to use to best to style and label each of your layers. Experiment - try the different techniques and see which represents your data best.
I have included some workflows for digitising geological features previously. These should help you find the appropriate sections of this chapter and the chapters on digitising and labelling. Make sure you have looked at all of these chapters to see what other techniques might help you to digitise your geological field slip, though.
Styling is the way you add colours and symbols to your map to help your audience to interpret your data.
In this section we’ll concentrate on vector data and you’ll be changing colours for outlines and fills, the style of lines, e.g. solid or dashed, and adding symbols for point features.
If you add a key to your map, it will show the colours and styles you have set for your layers, and these will also show in the Layers panel.
Opening the Layer Styling panel
All the changes you make to the colours and styles of your layers will happen in the Layer Styling panel.
· Start by selecting the layer you want to style in the Layers panel
· Either press F7 on your keyboard, or click on the Open Layer Styling Panel button at the top of the Layers panel - use the tooltips if you need to work out which one it is.
If you already have the Layer Styling panel open and select another layer, it will automatically change. You can check at the top of the panel to see which layer the styles will apply to.
[image: images/styles_extended/LayerStylingPanel_small.png]
The Layer Styling Panel. You can see at the top that the Bedrock layer is selected, then below you can select how to style the layer.
Setting a single symbol for a layer
The simplest style is the same single symbol for every feature in your layer and this is the style QGIS applies by default when you add a vector layer to your map. The colour will be selected at random.
If you have a layer which contains a single type of feature, then you can keep this type and just need to set it to your choice of colour or symbol for outline and fill.
[image: images/svg/videocam-black-24dp.png] Styling a vector layer as a single symbol in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Select a layer in the Layers panel and open the Layer styling panel if necessary.
· The style type at the top should already be set to Single Symbol, if it isn’t, use the dropdown to select that now.
Using the Gallery to select a pre-set style
The simplest way to select a new style is to click on a patch in the gallery. There are instructions to manually set styles later in this chapter.
The Gallery is further down the Layer Styling panel.
· Scroll down the gallery and have a look at the choices. Mine always sets itself to “Favorites”, which limits the number of choices. Instead set the dropdown to All Symbols and you get a longer list.
· When you click on a symbol the style in your map should change immediately. If it doesn’t, check that Live Update is ticked at the bottom of the panel. Alternatively you can use the Apply button each time you make a change.
[image: images/styles_extended/LayerStylingPanelGallery_small.png]
Choosing a style from the gallery for a line layer - simple purple line is selected. Note that Live update is ticked at the bottom of the panel. If you don’t want Live update you can use Apply each time instead.
The section on setting your own styles for a layer will give you a lot more information about creating your own styles.
Setting categories for a layer
Setting categories for a layer allows you to show different feature types within that layer. For example, if you have a single layer for bedrock, and within that you different rock types such as sandstone and limestone, you can set each type as a category and then style each category with a different colour.
[image: images/svg/videocam-black-24dp.png] Styling a vector layer as categories in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Make sure you know which field in your layer you want to use for the categories.
· Select the layer in the Layers panel and open the Layer styling panel, if it isn’t already open.
· To change the type of styling, drop down the box which initially says Single symbol and select Categorized instead.
· The next thing you need to do is choose the Value field. That is the name of the field you want to categorize on. Drop down the Value box and select that field.
· Go to the bottom of the panel and click on Classify.
QGIS should automatically give a colour to each different category in your attribute table. If you have Live update ticked, the layer should change on your map.
[image: images/styles_extended/LayerStylingCategories_small.png]
A polygon layer styled as categories with random colours.
Now you have the categories set, you can go through them and change the colours and styles so they are more appropriate for the data.
· Double-click on the colour patch (little coloured square) next to one of the categories.
· This panel should look familiar, it’s the same as the one you can use to style the single symbol styles. You’ll see more information about this soon.
· To get back to the list of categories, use the back arrow at the top of the panel.
Removing the “all other values” heading
This also works for removing any categories you don’t want to include.
If you look at the list of categories, you should notice the final one says all other values. This is useful if you are still adding features to your map, but is unhelpful when included in a key or legend.
To remove it:
· Select all other values in the list of categories, or the category you want to remove.
· Click on the red minus button at the bottom of the list to remove the entry.
Changing the name of items in the legend or key
When you categorize your features in the styling panel, the Legend entry is automatically set to the same as the Value. This could be absolutely fine, but you may have values which are completely lower case or instead of spaces have underscores or other odd character.
If you have no spaces, or underscores, or abbreviations, it’s good practice to change these so that when you create legends or keys for your maps they read as normal language. You can also use this method if you need to add a bit more description to a legend item.
· In the list of categories double-click on the text you want to change in the Legend column.
· Type the corrected version.
You should see that the text also updates in the Layers panel.
Continue to edit each of the legend headings so that they all start with an uppercase letter and have spaces rather than underscores, etc., or describe your data for the legend.
[image: images/styles_extended/LegendUpdated_small.png]
The categories list in the Layer styling panel showing the updated legend entries with uppercase first letters and spaces instead of underscores.
Combining layers visually in QGIS
There are two main ways of combining layers visually in QGIS. Opacity / transparency and blending modes.
Opacity or transparency
[image: images/svg/videocam-black-24dp.png] Setting opacity for a vector layer in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
QGIS dialogues tend to use opacity rather than transparency to make it possible to see data underneath other features, which can be a bit confusing. If you do get confused, try to remember which sliders or settings to use, and just experiment to see what works!
For opacity you need to reduce the percentage value.
· 100% is fully opaque or not transparent at all.
· 0% is not opaque or is completely transparent.
Try out the sliders in the suggestions below to see how this affects the features and layers on your map.
As often in GIS, there is more than one way to set opacity. Try out the suggestions and see which works best for you in each case.
Layer opacity
Often you’ll want to make all the features in a layer transparent together, so this is probably the method you’ll use most.
· For a layer styled as a single symbol, use the Opacity slider in the main styling panel window.
[image: images/styles_extended/OpacitySingleSymbol_small.png]
Setting opacity for a layer styled as a single symbol - use the Opacity slider on the main panel.
· When you are displaying features as categories, change all categories at once by clicking on the colour bar next to Symbol and changing Opacity there
· If you want to set different opacity for different categories, start by double-clicking on one of the small colour patches, lines or symbols on the left of the category you want to make opaque. You’ll get a familiar dialogue and can control the Opacity slider there in the same way as a single symbol layer.
· For either single symbols or categories, look for the Layer Rendering heading at the bottom of the Layer styling panel and use the Opacity slider there. This does occasionally cause problems when exporting a layout as pdf, but is usually fine.
[image: images/styles_extended/OpacityLayerRendering_small.png]
Setting opacity for a layer with Layer Rendering.
Making fills and strokes opaque separately
If you want to make a fill transparent but not the outline, or vice versa try the following.
· Go to the box at the top of layer styling panel.
· Click on Simple fill, Simple marker or Simple line, depending which type your layer is.
· To make just the fill transparent - Click on the colour bar next to Fill color.
· To make just the stroke transparent - click on the colour bar next to Stroke color.
· On colour tabs find Opacity slider at the bottom of the list of sliders, and change that.
· Use back arrows at tops of panels to go back to other options.
[image: images/styles_extended/OpacityFillSlider_small.png]
Setting opacity for a fill - look for the Opacity slider at the bottom of the list of colours. Your dialog might look a bit different but you should still have the sliders at the bottom.
Blending modes
Blending modes are a clever way of combining colours between layers which gives you all sorts of effects you can try out to display your data most effectively.
In level 1 I showed you how to use blending modes to display geochemical data on top of a base map. I’ll give general instructions here, but if you want more information about how blending modes work, or more ideas of how to use them, have a look at the blog entry by HelenMakesMaps.
Blending modes are an ideal way of showing bedrock geology on top of a background map.
· Select the top-most layer you want to combine, e.g. your bedrock layer, and open the Layer Styling panel.
· Blending modes are under the Layer Rendering section, so drop down that subheading at the bottom of the panel.
You have a choice between Layer blending mode and feature blending mode. You can use Feature blending if you have overlapping features, but the most useful is usually layer blending.
· Click on the dropdown under Layer next to Blending Mode.
· Select the blending mode you require. You can try them all out, but to start with select Multiply.
[image: images/styles_extended/BlendingMode_small.png]
Setting the Layer blending mode to Multiply to combine two layers visually.
Even if you haven’t set opacity on this layer, you should now be able to see the layer underneath through the blended layer.
You can use opacity in conjunction with blending modes. It really is a case of trying out the options and seeing which shows your data most clearly.
Setting your own styles for a layer
Using the Gallery is the easiest option if the style you need is available, but what if you want something that isn’t included there? The choices above the gallery make it possible to have more control over your styles.
· When you first open the Layer styling panel, there is a box under the Single Symbol dropdown. This is probably set to Marker, Line or Fill, depending on whether your data is points, lines or polygons.
· Selecting Simple marker, Simple line or Simple fill instead, will give you more options for controlling your styles.
I’ll go into detail about the options for each type of data in the sections below. There is plenty of overlap, but for geological mapping there are certain ways you’ll want to be able to style your data.
Choosing colours for map features
We had a short look at this in the lecture on Styles and Labelling in level 1, and you should still be able to see the lecture videos for that.
In addition, there is a lot of advice in the books on the reading list about choosing colours for maps.
Try chapter 5 from the GIS Cartography book by G.N. Peterson. Chapter 6 in the same book goes through styling different types of features and suggests suitable colours, e.g. for rivers and streams or buildings. This is a very useable guide, but does have quite a lot of detail.
In addition, try the Color Brewer web site - it lets you play with colour combinations and is specifically aimed at people making maps.
If you are going to be making a layer transparent then you will probably find that it is best to choose strong colours for features. The colours will fade when you apply transparency, though of course this may be what you want to happen.
Creating or finding more styles and symbols for QGIS
The default styles and symbols in QGIS are limited, but it is possible to find libraries of styles on the web, or to create your own symbols.
Adding more symbols to QGIS
Increasingly there are symbol libraries available on the web which can be imported into QGIS.
Style libraries are imported via the Style Manager and the QGIS documentation includes instructions on how to use the Style Manager.
· The QGIS Hub provides both styles and layouts. There are some useful styles, but nothing geological at the moment (October 2022).
· Open Source Agenda provide Geologic Symbols Qgis which, as it says, are geological symbols for QGIS. The styles can be downloaded as a zip file and there are instructions for importing on the overview page.
[image: images/svg/warning-black-24dp.png] Warning
If you are moving computers, you may find your styles appearing as large question marks when you reopen your map. This is unfortunate, and I haven’t yet found a solution beyond reinstalling the styles and reapplying them. You may find, if you store the styles in the same folder as your project and keep them with it, you may not have the problem.
Once you have styles imported you will be able to find them in the Gallery.
Note that occasionally you may need to restart QGIS for the imported styles to work.
Creating your own SVG symbols and fills
If you want to create your own pattern fills for polygons or symbols for points or markers, you can use Inkscape to create an svg file which you can then import and use. You will have used Inkscape in level 1 to create cross-sections or diagrams and the instructions are still available to you in Minerva. There is also information about Inkscape in the final chapter of this workbook.
Alternatively you may be able to find suitable svg files on the web.
One suggestion is to download gsymblib. This is a zip file. Unzip it to your GIS folder, then go into the folder, into the gsymblib-svg folder, and either patterns (for fills) or symbols (for points). The files are only numbered. There is a visual index to the symbols at the bottom of the linked page.
Styling polygon features
The principles for styling points, lines and polygons all have a lot in common, but for polygons you need to think about fills as well as strokes (or outlines).
Changing fills and strokes
As when using the Gallery, start by opening the Layer Styling panel, if it isn’t already open.
· Select a polygon layer, and if your layer is styled as categories select one of the categories by double-clicking on the colour patch.
· The heading for Fill will be selected by default. Below that you’ll have a choice of setting the Color and the Opacity for the fill and outline together, and you can use those, but if you click on the Simple Fill heading instead, you’ll have more choices.
[image: images/styles_extended/SimpleFillOptions_small.png]
The extended list of options under Simple Fill. You can change the fill and stroke separately, and have other new options too.
There are a lot of options here and I can’t take you through all of them. I’ll give instructions below for some of the aspects of styling specifically geological data, but otherwise, you need to try things out for yourself.
Styling polygons with pattern fills
Sometimes it is useful to be able to style a polygon with a pattern fill. On geological maps, this technique is often used to show igneous rocks. There is a high chance that someone in your audience is colour blind, and symbol fills may help them to tell different rock types apart.
[image: images/svg/warning-black-24dp.png] Warning
Treat pattern fills with care! They can be very useful, but they can also make your map look more confusing and “busy” than it needs to be.
· In the box at the top select Simple fill.
· The options below include Fill style. Dropdown the choices and select BDiagonal. Have a look at the effect on your map, then try some of the others.
· Drop down Stroke style and select Dot line. Again, have a look at the effect on your map then try some of the others.
These ways of setting patterns are very limited - you can’t change the spacing of the diagonal lines, for example.
There are some pattern fills in the Gallery. Examples include hashed lines and pattern dots. These are the simplest way to add patterns and show how you can have more control over patterns.
· In the box at the top have Fill selected.
· From the Gallery select hashed cblue /.
Your polygon should change to a style with no background, but blue lines at a 45° angle.
Have a look at the box at the top. You should see it no longer just says Simple fill, but has a tree of different elements including Simple line, Line pattern fill and Line.
[image: images/styles_extended/PatternFillGalleryDiagonal_small.png]
The breakdown of the blue diagonal fill style from the Gallery showing the different elements making it up, including Simple line, Line pattern fill and Line.
· Click on the subheading for Line Pattern Fill.
In the dialogue which appears you can start making some changes to the angle and spacing of the diagonal lines.
· Try changing Rotation to 60°.
· And change Spacing to 5 mm.
This can be a really useful start for creating your own pattern fills.
The section on Importing geological symbols below shows you how to add more symbols to QGIS so you have more choice in the gallery. Alternatively, you can create your own symbols.
To add an svg image to a polygon layer as a pattern fill
[image: images/svg/videocam-black-24dp.png] Styling polygons with svg pattern fills in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
The section on creating your own SVG symbols and fills gives you some ideas on where to find SVG symbols online, or how to create them yourself in Inkscape.
Once you have an SVG symbol you want to use:
· In the Layer styling panel, select the rock type or feature you want to style and click on Simple fill.
· In the options below, dropdown the list of choices next to Symbol layer type and select SVG fill.
· Go right down to the bottom of the Layer Styling panel. There should be a box with no label, but with the three dots button at the end of it. Click on the three dots button and browse to select your svg file.
· Click Open and your polygons should be styled.
[image: images/styles_extended/FillsImportSVG_small.png]
Selecting an SVG fill and choosing the SVG image to apply using the box at the bottom of the dialogue. A simple fill has been added to provide a background colour.
· You can alter the Texture width (to change the size) and the Rotation, but you’ll probably find none of the other options are available.
· If you want to add a background colour, click on the Fill heading again.
· Then click on the green plus button next to the box. A Simple fill will be added. Click on the down arrow so it is below the SVG fill in the list.
· Change the colour and transparency to settings which look good on your map.
Styling line features
Styling line features is basically the same as styling polygon features, so refer back to the instructions for single symbols and categories if you need a reminder. Again, you can use the gallery, set opacity and use blending modes.
You are likely to be using line features to delineate geological boundaries, faults, fold axes etc. Styles for these are usually more complex than a simple, solid line.
If you install the geologic symbols, you will have a lot more relevant options available to you in the gallery.
Styling dashed lines
You may well need to sest up dashed lines on your map, e.g. for inferred geological boundaries. You can do this as follows:
[image: images/svg/videocam-black-24dp.png] Styling dashed lines in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Draw a continuous line for the feature as usual.
· In the layer styling panel click on the Simple line entry under Line.
· Dropdown the list next to Stroke style and choose Dash Line.
· This may be just what you want, but if it isn’t you can then tick Use custom dash pattern further down the panel.
[image: images/styles_extended/DashPatternDefault_small.png]
Setting up a custom dashed line pattern. Click on the button under Use custom dash pattern to edit the dashes and spaces.
· Now click on the button which shows the current dashed line to open the editor.
You’ll have a table with the headings Dash (mm) and Space (mm). The numbers show the lengths of the dash and the space in millimetres. You can edit these numbers to change the dash pattern.
· Change both numbers to 4. [image: images/styles_extended/DashPattern_small.png]
· Use the back button at the top of the layer styling panel to go back to the other options.
You should now see a dashed line with much wider spaces.
· You can still change Stroke width to change the thickness of your line. Remember, geological lines on maps shouldn’t be too thick.
· You can also still change the colour.
Experiment with these settings to set the line as you want it.
Styling lines with “decoration”
By “decoration” I mean the little extra symbols, such as:
· The “ticks” to show downthrow on faults.
· The little triangles or “barbs” which show thrust faults.
· Crosses or arrows to show fold axes.
· Arrows to show direction of movement.
The simplest way to apply these is to import the Geologic symbols library and use those styles from the Gallery, but if this isn’t possible, or you still want to create your own, try some of the suggestions below.
[image: images/svg/info-black-24dp.png] Combining dashes and decoration
You can use dashed lines and decoration for the same line style. The Layer styling panel allows you to add a simple line and a hashed line or marker line to the same style.
Use the green plus button to the right of the Line box and then the arrows to arrange the layers of the style.
[image: images/styles_extended/CombiningLineElements_small.png]
Combining a hashed line, a simple line, and a marker line to create a single symbol. The symbol preview is on the left.
[image: images/svg/videocam-black-24dp.png] Styling lines with decoration in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
Using a hashed line
· Having set up a Simple line as required, use the green plus button to add another Simple line to your Line, then change the Symbol layer type to Hashed line.
A hashed line is a short line perpendicular to your main line.
I’ll show you how to set this up to show downthrow on a normal fault:
· Change Hash placement to on central point, so you don’t have too many decorations. You could change the interval instead, but that depends how many different lengths of lines you have as to whether it works.
· Change Hash length to 1.4
· Change Line offset to -1.0 - or whatever offset makes your hash line just touch the main line.
· Check Rotate hash to follow line direction is ticked - or your hashes will be upright on the page and not linked to your line.
[image: images/styles_extended/HashedLine_small.png]
Setting up a hashed line to indicate the downthrow of a normal fault.
If your hashes are on the wrong side of some of your lines, have a look at the section below on flipping line features.
Using a marker line
· Having set up a Simple line as required, use the green plus button to add another Simple line to your Line, then change the Symbol layer type to Marker line.
· Under the Marker line subheading select the Simple marker.
Simple marker gives you a choice of basic markers to use on a line.
· To show a syncline fold axis, try adding the cross from the gallery below.
· Going back to Marker line in the tree will allow you to change the Marker placement and the Line offset.
If you want a more complex symbol you can select one of the other Symbol layer types, instead of Simple marker, and, for example, import an SVG image file.
I’ll cover this in more detail under styling point features, as it is more relevant there.
Reversing line features
Some line styles are directional, for example if you are using a decoration on one side of the lien or have an arrow. One example is the tick to show downthrow on a fault. You may find the marker is on the wrong side on some lines and not others. In the example below, the ticks should be inwards, so the tick on the lower line is on the wrong side.
[image: images/styles_extended/FlippingLinesWrongSide_small.png]
The markers on these two lines should be on the inner sides. The marker below is incorrect.
The solution is to reverse or flip the line, as the direction depends on which end you started digitising from, and therefore the stored start and end of the line.
[image: images/svg/videocam-black-24dp.png] Reversing line features in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
To reverse, or flip the direction of the line:
· Check you have the Advanced Digitising toolbar available - View > Toolbars > Advanced Digitising Toolbar.
· Toggle editing for the layer.
· On the Advanced Digitising Toolbar find the Reverse line button (tooltips will help if you hover over the buttons) and click on it.
[image: images/styles_extended/AdvancedDigitisingReverseLine_small.png]
The Reverse Line button on the Advanced Digitising toolbar.
· Now just click on the line you want to reverse, or flip. You should get a notice at the top of the map saying Line reversed and the tick should change sides.
· Save your edits and toggle editing off.
[image: images/styles_extended/FlippingLinesRightSide_small.png]
The markers on both lines are now correct and the Line Reversed notice is showing at the top of the map.
Styling point features
Styling point features is basically the same as styling polygon or line features, so refer back to the instructions for single symbols and categories if you need a reminder. Again, you can use the gallery, set opacity and use blending modes.
You are likely to be using point features for structural symbols, markers on your map or as locations to add labels.
The default gallery in QGIS is limited, and you may need to create your own symbols, or add symbols from external sources.
To add an svg image to a point layer as a symbol
[image: images/svg/videocam-black-24dp.png] Styling points with svg markers in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
The section on creating your own SVG symbols and fills gives you some ideas on where to find SVG symbols online, or how to create them yourself in Inkscape.
Once you have an SVG symbol you want to use:
· In the Layer styling panel, select the feature you want to style and click on SVG Marker.
· Go right down to the bototm of the Layer Styling panel. There should be a box with no lable, but with the three dots button at the end of it. Click on the three dots button and browse to select your svg file.
· Click Open and your points should be styled.
· You can use the options above to resize the symbol. Remember, geological symbols shouldn’t be made too large on your map.
· If you need to rotate cleavage, foliation etc, don’t do it in this dialogue. There is a section later about rotating point symbols. The Rotation option here rotates all symbols to the same angle.
· You may not be able to change the Fill and Stroke colours. If that is the case, you may need to edit the original svg in Inkscape and import it again.
[image: images/styles_extended/PointSVG_small.png]
Selecting an SVG file and setting size.
Rotating point symbols
[image: images/svg/videocam-black-24dp.png] Rotating point symbols in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
To be able to rotate your structural point symbols by strike, you must have a field in your attribute table to hold the rotation data.
· Open the properties for your points layer (either double-click on the layer in the Layers panel, or right-click and Properties...).
· Go to the Fields tab in the list down the left-hand side.
· Check whether you have a numeric field with a type of int or double which will hold the rotation data/strike for your points.
· If you haven’t, click on the pencil icon at the top to toggle editing, then use the left-hand button to add a New field.
· Give the field a clear name (no spaces) and check the Type is Whole number (integer) or Decimal number (real).
· Click on the pencil button again to toggle editing and save your edit.
· Close the Properties panel.
[image: images/styles_extended/AddField_small.png]
Adding an integer field to hold rotation data.
Setting the rotation field
To set the rotation field for a point symbol:
· Open the Layer styling panel for the symbol you wish to rotate.
· Check you are on the Marker heading - the one at the top of the window.
· Find the Rotation setting further down the dialogue, but above the Gallery. Next to that there is a grey symbol with an arrow and a couple of boxes. This opens the Data defined override settings. Click on that, then hover over Field type: int, double, string.
· A list of your fields should display, select the field that you want to hold your rotation data.
[image: images/styles_extended/SettingRotation_small.png]
Setting the rotation field for a points layer.
The grey symbol should change to yellow to show that data defined override is set.
If you imported your points from a spreadsheet or xyz file, you may already have rotation data in the field. If this is the case, your points should automatically rotate. If you didn’t, then go to the next section to see how to rotate the point symbols manually.
Rotating the point symbols manually
If you don’t have values in the rotation field and want to add them manually, do the following:
· You do already need to have carried out the instructions above to set the rotation field, so if you haven’t already, do that first.
· Check you can see your field slip, as well as the point symbols.
· Toggle editing for the layer which contains your points.
· Zoom in on the first point.
· Check you have the Advanced Digitising toolbar available - View > Toolbars > Advanced Digitising Toolbar.
· Toggle editing for the layer.
· On the Advanced Digitising Toolbar find the Rotate point symbols button (tooltips will help if you hover over the buttons) and click on it.
[image: images/styles_extended/RotatePointSymbols_small.png]
The Rotate Point Symbols button.
· Click on the point you wish to rotate.
· You’ll see an arrow, and a number showing the angle of rotation. Move your mouse until the arrow is at the correct angle, then click again.
[image: images/styles_extended/RotatingThePointSymbol_small.png]
Rotating the point symbol - the arrow and degrees of rotation.
Your symbol should be set to the correct angle. Save your edits, and if you don’t want to rotate any more, turn off editing.
If you look at your attribute table now, you should see the angle of rotation in the field you set as the rotation field.
Reusing styles
Once you have worked hard at styling your layers, you may want to style other layers in the same way. The following tips allow you to do that.
Copying and pasting styles between layers
If you have more than one layer with the same attributes and want to style them in the same way, and if you have already styled one of the layers, you can copy and paste the styles between them. This also works between map documents.
· Right-click on the styled layer and select Styles > Copy Style > All style categories.
· Then right-click on the unstyled layer and select Styles > Paste style > All style categories.
Your styles should copy straight across.
Styling layers with a qml file
If you are downloading layers, you will sometimes find that the creator has also provided style files with an extension of .qml. These can contain both styles and labels and can make displaying data much simpler.
Some producers have a separate webpage where you can download styles. For example, the Ordnance Survey provides qml files for their open data via a separate repository.
If the qml files are zipped, you will need to unzip the file first.
There are other formats of style files which will work in QGIS. Some, such as .lyr, need the SLYR (Community Edition) plugin before they can be used. The instructions for how to use .lyr files are in the level 1 geology workbook - search for “Styling the geology with lyr files”. QML is the easiest to use and to save for your own data.
Applying styles from a qml style file
[image: images/svg/videocam-black-24dp.png] Applying styles to a layer with a qml file in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
If you have a qml fle and want to apply it to a layer:
· Either double-click on the layer in the Layers panel, or right-click and select Properties. You can’t import styles from the Layer styling panel.
· Go to the Symbology tab of the properties.
· At the bottom left of the properties is a button which says Style. Click on this button and select Load Style...
· This opens the Database Styles Manager. Make sure Load style is set to From File.
· Click on the three dots button next to File and navigate to where you unzipped your qml files.
· Select the appropriate qml file and click Open.
· Back in the Database styles manager, click on Load style.
If you have a complex layer you may have to wait a bit at this stage, it depends how many styles QGIS needs to load.
The Symbology should change to show the new styles.
[image: images/styles_extended/LoadStyle_small.png]
Loading a qml style file via the layer properties window.
· Now click on OK and your layer should be styled according to the qml styles. Again, this could take a while if you have a complex layer.
If it looks a bit as if QGIS is going to crash, it’s worth just waiting - don’t try clicking on anything as that will make it worse!
Saving styles to a qml style file
If you have styles you want to save to use in the future, you can save them as a .qml file and apply them in the same way as above.
I sometimes export a qml file if I’m basically happy with my styles and labels, but want to try out some alternatives. Then if I’m not happy with what I’ve done, I can apply the style again to get back to where I was.
· Open the layer properties for the styled layer and click on Style > Save Style... to load the Save Layer Style dialogue.
· Check Save style is set to As QGIS QML Style File
· Click on the three dots button at the end of the line after File and select where to save your qml file, and what you want to call it.
· You can select what you want to save in your qml file, but I usually just leave all options ticked.
· Click OK to save the file.
[image: images/styles_extended/SaveLayerStyle_small.png]
Saving the styles and labels from a layer as a qml file.
Styling layers with ESRI layer files
Sometimes you’ll be provided with .lyr style files rather than qml. An example of this is geological data downloaded from Digimap. You won’t be able to see the style files in QGIS until you install the SLYR (Community Edition) plugin. This type of style files are designed to be used in ArcGIS rather than QGIS, but the plugin allows QGIS to use them too.
Installing the SLYR (Community Edition) plugin
You need to install the SLYR (Community Edition) plugin to be able to add the styles to your map.
[image: images/svg/videocam-black-24dp.png] Installing plugins in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· In the menu go to Plugins > Manage and Install Plugins...
· When it opens, click on the Not installed heading on the left.
· Type SLYR into the search box at the top.
· From the list that appears click on SLYR (Community Edition) and have a look at the description.
· Finally, to install the plugin click on Install Plugin.
[image: ../../shared/docs/images/bgs_data/InstallingSLYRplugin_small.png]
Finding and installing the SLYR Community Edition plugin in the Plugin Manager.
Once it has been installed you should get a message at the top telling you it has been successful, and SLYR (Community Edition) should now be in the list of Installed Plugins.
· You can Close the plugin manager now.
Styling your layers with .lyr files
Now you should be able to see the .lyr files in the browser, and apply the styles to the layers you downloaded. Here I give the instructions to use the styles with 1:50 000 geology layers downloaded from Digimap, but they will work in the same way for other data provided with either .lyr or .style files.
· Return to the browser panel in QGIS. Select Project Home and click on the Refresh button at the top of the Browser.
Your BGS 1:50 000 geological data folder should now look like the figure below (file names will depend on the area you have downloaded). It should show .lyr files to match the .shp files.
[image: ../../shared/docs/images/bgs_data/BrowserSLYR_small.png]
The .lyr files should now be visible in the same folder as the shape files.
· If you’ve added the layers to your layers panel, Remove them now. These will just get in the way when you add the .lyr files.
· Now drag and drop the relevant _bedrock.lyr file from the Browser panel to your map. Make sure you pick the .lyr, not the .shp file this time.
The bedrock geology should appear on your map. You may need to move it upwards in the Layers panel to be able to see it.
The layer should appear correctly styled as in the image below.
[image: images/svg/warning-black-24dp.png] Warning
If the layer doesn’t appear on your map and has a warning triangle next to it in the Layers panel, click on the warning triangle and navigate to the .shp layer.
A .lyr file contains the style information, but only links to the data, which is in the .shp file. If the link is broken, as it sometimes is when you download data (through no fault of yours), you need to repair the link.
[image: ../../shared/docs/images/bgs_data/BedrockGeology_small.png]
The styled bedrock geology layer.
[image: images/svg/create-black-24dp.png] Add linear and superficial geology to your map
For BGS geological data, repeat the drag and drop with the linear and superficial .lyr files to add the linear and superficial geology to your map.
Move the layers in the Layers panel so that they are in a single group called Geology and show in the order below:
· Linear
· Superficial
· Bedrock.
[image: ../../shared/docs/images/bgs_data/GeologyMap_small.png]
The symbolised geological map showing the bedrock, superficial and linear geology.
Saving styles to a geopackage
If your layers are stored in a geopackage, it is possible to store the layer styles and labels in the same place. This has the advantage that if you add the layers from your geopackage to a new map, they are automatically styled. This also makes sharing your data with other GIS users much easier. They won’t have to worry about styling the data so it looks as you intended.
· Open the layer properties for the styled layer and click on Style > Save Style... to load the Save Layer Style dialogue.
· Check Save style is set to In Database (GeoPackage).
· Fill in Style name. It’s a good idea to use the same name as the layer.
· Description is optional, but can help if you’re not sure about the style in future.
· Tick Use as default style for this layer.
· Click OK to save the style and labels to the GeoPackage.
[image: images/styles_extended/SaveLayerStyleGeoPackage_small.png]
Saving the layer styles and labels to the Geopackage.
To check this has worked, just add another copy of the layer to the same map. It should be displayed with the same styles and labels as the original. You can remove it once you’ve checked!
Further information: Styling data in GIS
The University of Delft has an open course about Creating data visualisations with graphs, maps and animations. The emphasis is on communicating your data to an audience. Sections of particular interest are:
· Visualize Data in Maps
· Cartography for Map Figures in Academic Journals and Books
The books in the Principles of Cartography section of the reading list (available in Minerva) cover good practice for styling and labelling your maps. Suggestions include the following:
For a quick guide go for Darkes and Spence (2017). The section on “Symbolisation” on pages 17-18 and “Text on maps” on pages 23-25 are particularly relevant.
Peterson (2021) is a very readable book about map design. Chapter 4 covers fonts and chapter 6 covers features. These chapters are both relevant to styling and labelling.
Conclusion
The techniques above should allow you to create a colourful and informative map. Once you have styled your data, you can move on to the next chapter to add labels to your map.
Labelling geological data
Last Modified: 10 Oct 23, 16:03:06
Unlike the chapters on creating a basemap and georeferencing, this isn’t a step-by-step guide where you start at the beginning and work your way through. Though you will be using similar data, yours will be different to mine, and probably to other people in your class, and my explanations will, of necessity, be general. You need to look at the techniques available and decide which ones you need to be able to label your data appropriately and professionally.
The principles of styling and labelling data were covered in a lecture in level one, and the video of that lecture should still be available to you in Minerva. If you are unsure about some of the principles it would be worth watching that before starting to style and label your map.
Learning outcomes
When you have completed this section of the workbook you will be able to
· Understand how labels are used to inform your audience about your data.
· Add appropriately styled and located labels to the features on your map.
Introduction to labelling geological data
In the previous chapters you’ll have created your data and added information to the attribute tables. You’ll have then styled your data. Now you’ll learn the techniques to label that data to make a more informative map ready to present to an audience.
[image: images/svg/warning-black-24dp.png] Warning
The sections below show the general principles, some of which you’ll have tried out in the level one workbook chapter titled “Styling and labelling your data”. You will need to decide for yourself which techniques to use to best to label each of your layers. Experiment - try the different techniques and see which represents your data best.
I have included some workflows for digitising geological features previously. These should help you find the appropriate sections of this chapter and the chapters on digitising and styling. Make sure you have looked at all of these chapters to see what other techniques might help you to digitise your geological field slip, though.
If you look at any map, you’ll be able to see that attributes from the attribute table have been used to add labels. Labels are text on the features on the map which is essential to understanding the data.
Once you have information in your attribute tables, it is simple to add labels to your features. Once you’ve done that, though, getting the labels to look professional can be a bit more of a challenge.
When should you use labels?
You may not need to add labels to all layers, but they can really help interpretation. For example, if you look at British Geological Survey maps they add symbols to each rock polygon which are then included in the key. This makes it easier to spot which colour or polygon symbol is which, particularly for anyone with colour deficiency. Points can be labelled to show location names or dip angle, names can be added along lines, such as “Moine Thrust” on the appropriate thrust fault.
Adding single labels
Single labels cover adding a label to all features in a particular layer using the same style and positioning for all of them.
In the section on digitising geology, I suggested you put a short abbreviation in the label field of the attribute table for each rock type. We can use this short text to label the bedrock layer on the map. If you do this, don’t forget to add the abbreviations to the colour patches in the key too.
[image: images/svg/videocam-black-24dp.png] Labelling features in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
To add single labels:
· Select the layer you wish to label in the Layers panel - the example I’m using here is a bedrock geology layer but the instructions will be the same for any layer.
· Open the Layer styling panel, if it isn’t already open.
· In the tabs on the left, click on the second one down - the tooltip will be Labels.
· Drop down the box which currently says No Labels and select Single Labels.
QGIS will guess which field you might want to use as labels, but will more than likely guess wrong. So make sure you check that the field next to Value is set correctly.
Remember, you need to know your own field names which will probably be different to mine.
· I had to change the Value to my correct field - Label.
[image: images/labels_extended/SingleLabels_small.png]
Setting up a single label style for a layer and selecting the correct field value to use for labels.
If Live update is ticked at the bottom of the Layer styling panel, the labels should automatically appear on your map.
They probably don’t look right yet. It is very unusual for the automatic labelling to do exactly what you want.
Using rule-based labelling
Rule-based labelling allows you add labels to a subset of features in your feature class or different labels for different types of features.
An example of the use of label classes is to restrict the number of labels you use for your contours by only labelling the master or index contours, not the standard contours too. This is particularly useful in mountainous or very hilly areas with lots of contours close together. You had basic instructions for labelling contours earlier in the workbook when you were creating a base map. I’ll use this example here.
[image: images/svg/videocam-black-24dp.png] Rule-based labelling in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
To set up rule-based labels:
· Select the layer you wish to label in the Layers panel - the example I’m using here is a bedrock geology layer but the instructions will be the same for any layer.
· Open the Layer styling panel, if it isn’t already open.
· In the tabs on the left, click on the second one down - the tooltip will be Labels.
· Drop down the box which currently says No Labels and select Rule-based Labeling.
QGIS will show a blank box. To add a labelling rule:
· Click on the green plus button at the bottom of the panel.
· In the Description box add a description for the labels your rule will display.
· Click on the E button on the right of the Filter box. This will open the Expression String Builder.
· Use the box in the centre to look for Fields and Values. Double-click on the field which holds the data you want to set your rule.
In my example of contours, the type field holds information about whether a contour is Index or Normal. I want to filter for only index contours.
· Type = after the field name in the box on the left, then either search for a value in the Values box, or click on the All Unique button.
· When you find the attribute you want to filter by, double-click on it to add it to the expression in the left-hand window.
· When you have completed your expression, check the bottom left of the dialogue, where QGIS will tell you if your expression is invalid. My final expression is "type" = 'Index'.
· Click OK to return to the Layer styling panel.
[image: images/labels_extended/ExpressionStringBuilder_small.png]
Building the expression to select data for only one type of record.
Next you need to add the actual value for your label.
· Further down the panel find the Value field.
· Drop down the list and select the field which holds the data you want to use to label your features. In my case that is height, for the height of the contours.
[image: images/labels_extended/CreatingRule_small.png]
Creating the rule and selecting the attribute to use for labelling.
QGIS should add the label to the features defined by the expression in your rule. It isn’t yet formatted so go ahead and do that too.
· When you’ve finished setting up the rule, use the back arrow at the top of the panel to go back to the list of rules.
You’ll find that you have a summary of each rule you set up.
[image: images/labels_extended/RuleSummary_small.png]
The label panel, showing a summary of the rules you have created.
You can add multiple rules in the same way. If you want to label one type of symbol in red and another in blue, you can set up a rule for each. There doesn’t seem to be a limit on the number of rules you can set.
Styling labels
You can use the options in the layer styling panel to change the font, the size and colour of your labels. We’ll look at how to change the position and angle of labels in a later section.
It’s usually best to keep label styles simple - you’re aiming for readability not fancy effects. So don’t pick fonts that are hard to read!
Font, size and colour
These are relatively straightforward. Use the first tab at the top of the labelling dialogue.
· Select a Font from the dropdown list.
· From the Style dropdown choose whether to use regular, italic or bold.
· Set the Size. This is usually in Points but can be changed to other units of measure. 
· Click on the Color bar to change the colour in the usual way. Note that dark grey can often work better than black for labels. Experiment!
· Set Opacity in the usual way.
[image: images/labels_extended/LabelStylingFonts_small.png]
Changing the font, font style, size and colour for your labels.
As usual, if Live update is selected, changes should be applied to your map automatically, making it easy to check how your labels look.
Buffers to help labels stand out
Labels often have to appear against coloured backgrounds, or above other layers, such as contours, which make them harder to read.
Buffers one possible way to make your labels standout. Do be careful about using them, though. They can make labels too dominant.
A buffer, or halo, is a narrow band of colour around your label.
[image: images/labels_extended/LabelBuffer_small.png]
Buffers around labels on a bedrock geology layer.
· Select the correct layer in the Layers panel and go to the Layer styling panel.
· In the Label panel, go to the Buffer tab at the top (remember to use tooltips).
· Tick the box next to Draw text buffer.
A white, 1 mm buffer should appear around your labels. This doesn’t usually look great. You need to make the buffer less obvious, or more subtle.
· Try setting opacity to a lower value.
· Change the colour of the buffer to a pale grey or cream, rather than white.
· Try out Blend mode options.
[image: images/labels_extended/LabelBufferSettings_small.png]
Setting size, colour and opacity for label buffers.
I can’t give you definite advice on this as the best settings will depend on what colours and symbols are in the background to your labels. Experiment and see what works for each map you make.
Controlling the placement of labels
The default label placement usually isn’t the best placement for your data. The Placement tab of the Layer styling panel label dialogue gives you options to change the placement of your labels.
To control the placement of your labels:
· Set up the font, size and colour of your labels as you wish them to look.
· Click on the Placement tab at the top of the label dialogue.
[image: images/labels_extended/PlacementTab_small.png]
The Placement tab under Labelling in the Layer styling panel.
It’s very difficult to write general instructions for placement. I’ve included specific instructions for labelling polygons, labelling along lines and labelling structural symbols with dip angle, but for other purposes it can be trial and error.
Labelling polygons
The default label position for polygons, such as bedrock layers, is Around Centroid. This places labels over the centre point of the bounding box of the polygon and that isn’t always inside the polygon.
[image: images/labels_extended/PolygonCentroid_small.png]
A polygon labelled Around Centroid. Note the label is over the centroid of the area outlined with a black line, not over the blue polygon itself.
· Instead of Around Centroid try using Horizontal or Free (Angled).
[image: images/labels_extended/PolygonAngled_small.png]
The same polygon labelled as Free - angled. The label is now inside the polygon.
As with so many labelling tasks, experiment with the settings and see what works best for your data.
Labelling along lines
The default label position for lines, such as streams, faults, fold axes, is Parallel. This adds a straight label, along the length of the line.
[image: images/labels_extended/LinesParallel_small.png]
Labels along streams with the setting Parallel.
For many lines, a better option is Curved, so the line follows the shape of the feature.
You can also choose whether to put the label Above the line (the default) or On line, which was the setting we used for contours.
Further settings allow you to choose whether to repeat labels along the line, overrun the end of the line, or use Label Anchoring to change whether the label is anchored to the start, centre or end of a line. It is also possible to change the Maximum angle between curved characters, which can be useful if you have tight curves which cause letters to overlap each other.
As usual, experiment. The settings you need will vary depending on your data.
[image: images/labels_extended/LinesCurved_small.png]
Labels along streams with the setting Curved.
Labelling structural symbols with dip angle
If you look at a published geological map such as the BGS 1:50,000 geological map of Assynt from 2007, you can see the dip labels of the structural symbols are lined up with the barbs on the symbols.
By default the label engine in QGIS won’t make a great job of this.
Instead you can make use of an expression to position the labels and, if you wish, data-defined rotation to angle the labels.
[image: images/svg/videocam-black-24dp.png] Labelling structural symbols with dip angle in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
I have fields called Dip and Strike in my structural symbols feature class. I have used the Strike field to rotate my symbols.
I need to use the Dip field to label the symbols.
· Start by setting up to label the symbols in the usual way. I have used rule-based labelling as I have some symbols with a dip value of 0 and don’t want that to show on the map.
[image: images/labels_extended/DipSymbolsOverZero_small.png]
Using rule-based labels to label only those symbols with a dip value greater than zero.
The labels will appear in random locations around the symbols and won’t all appear associated with the correct symbol.
[image: images/labels_extended/DipLabelsDefault_small.png]
Dip labels with default settings.
To place the labels against the barbs:
· Go to the Placement tab of the label dialogue.
· Set Mode to Offset from Point.
· Click on the grey button at the end of the Offset X,Y line and select Edit...
· The Expression string builder should open. Copy the statement below and paste it into the left-hand section of the expression editor.
to_string((-3*cos(radians(  "Strike" +180)))  )|| ',' ||  to_string(-2 * sin(radians( "Strike"+180)))
· If your rotation data is in a field with a different name to Strike, change that in the expression.
· Click on OK and have a look at the labels on your map.
[image: images/labels_extended/LabelStrikeExpression_small.png]
Entering the expression in the Expression String Builder. You may need to change the name of the Strike field to match your field name.
You may need to change the spacing from the symbols on your map. If you do, make changes to -3 and -2 in the expression above. This is trial and error, but worth taking a bit of time over.
[image: images/labels_extended/DipLabelsSet_small.png]
Dip labels with placement controlled by the expression.
[image: images/svg/info-black-24dp.png] More information about the method used for dip labels
These instructions are based on a blog post from the Irish QGIS User Group. There is more about the technique at that web URL.
Manually placing labels
There is only a certain amount you can do automatically for good placement of labels. Do as much as you can automatically first, but there will probably come a stage where it is easier to get a professional result by moving some labels manually.
Placement can be a problem if you have a lot of labels to fit into a small space, or if you are trying to fit a label into a polygon but QGIS won’t quite do what you want.
[image: images/svg/videocam-black-24dp.png] Manually placing labels in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
Start by opening the Label toolbar:
· View > Toolbars > Label Toolbar
[image: images/labels_extended/LabelToolbarAnno.png]
The Label Toolbar.
The first button on the toolbar opens the usual Layer styling panel label options.
[image: images/svg/warning-black-24dp.png] Warning
Before carrying out any of these changes, QGIS will index your vector layers. This can take a short while, particularly if you have some layers with a lot of data, so don’t worry if nothing appears to be happening at first!
Moving labels
In the example below, I want to move the label for Townbrook Valley further down the valley towards Old Rectory Wood.
[image: images/labels_extended/MovingLabel1_small.png]
The result of the automatic label locations. Townbrook Valley is too far to the west and I want to move it to the east.
To move a label:
· Click on the Move a label, diagram or callout button on the Label toolbar.
· Your cursor should change to a cross, and this is when QGIS may start indexing your vector layers.
· When you hover over a label with this tool, it should have a red outline box, click on the label you want to move.
· An Auxiliary Storage method box may pop-up, asking you to select a primary key.
[image: images/labels_extended/AuxiliaryStorage_small.png]
Setting a primary key in the Auxiliary Storage box. The primary key will probably be fid.
The Primary Key is an index number which should be different for each feature in your feature class. If you set up GeoPackage layers, the default is usually fid (f eature id).
· If your data is in a GeoPackage, fid should automatically be selected, so click on OK.
· If your data is not in a GeoPackage and does not have a fid column, or another column with unique identifiers, the easiest way to add the column is to Export the layer to a GeoPackage.
· Once you have selected the primary key, QGIS will show a green box which moves with your cursor. Move that box to the correct location for your label, then left-click to place it. Note that the label itself won’t move until you click to place it.
· To save the new location, save your map (<ctrl>-s).
Once you’ve finished moving labels, you’ll need to click on another tool, such as Pan Map on the toolbar at the top, to stop selecting labels.
[image: images/labels_extended/MovingLabel2_small.png]
The Townbrook Valley label has been moved to the east and is closer to Old Rectory Wood.
Adding label callouts
Label callouts are labels which appear outside of their associated polygon, but which have a line connecting them. This can be very useful when you have small polygons close together and it isn’t clear which label belongs to which area.
The process is very similar to moving labels so refer back to those instructions too.
In the example below I want to add callouts to the National Trust labels so that it is clearer which buildings are labelled.
[image: images/labels_extended/CalloutsOriginal_small.png]
The automatic placement of the labels for the National Trust Tearooms and Gift Shop. I want to add callouts so it is clearer which building is which.
· In the Layer Styling panel go to the Labelling tab.
· From the row of tabs near the top of the panel select Callouts (use Tooltips to find the tab).
· Tick in the box next to Draw callouts.
[image: images/labels_extended/CalloutsPanel_small.png]
The Callouts tab of the Layer Styling Panel. The Draw Callouts box is ticked.
· Now go to the Label Toolbar (see above under Manually placing labels if you need a reminder) and click on the Move a label, diagram or callout button.
· Click on the label you wish to move.
· Your cursor should change to a cross, and this is when QGIS may start indexing your vector layers.
· When you hover over a label with this tool, it should have a red outline box, click on the label you want to move.
· An Auxiliary Storage method box may pop-up, asking you to select a primary key.
[image: images/labels_extended/AuxiliaryStorage_small.png]
Setting a primary key in the Auxiliary Storage box. The primary key will probably be fid.
The Primary Key is an index number which should be different for each feature in your feature class. If you set up GeoPackage layers, the default is usually fid (f eature id).
· If your data is in a GeoPackage, fid should automatically be selected, so click on OK.
· If your data is not in a GeoPackage and does not have a fid column, or another column with unique identifiers, the easiest way to add the column is to Export the layer to a GeoPackage.
· Once you have selected the primary key, QGIS will show a green box which moves with your cursor. Move that box to the correct location for your label - away from the polygon to which it belongs, then left-click to place it. Note that the label itself won’t move until you click to place it.
· Once you’ve placed the label, QGIS should draw a line between the label and the polygon.
· To save the new location, save your map (<ctrl>-s).
Once you’ve finished moving labels, you’ll need to click on another tool, such as Pan Map on the toolbar at the top, to stop selecting labels.
[image: images/labels_extended/CalloutsMoved_small.png]
The moved labels showing the lines linking them to the relevant polygons.
Once you have placed the labels in the locations you want them to be, you can use the other options in the Callouts panel to control how the lines are anchored to both the labels and the feature. Try the options out to see what is possible.
Rotating labels
In the example below, I want to rotate the label for Devilsmouth Hollow to follow the general line of the valley.
[image: images/labels_extended/RotateLabel1_small.png]
The automatic placement of the label for Devilsmouth Hollow. I want to rotate it to follow the valley.
To move a label:
· Click on the Rotate a label button on the Label toolbar.
· Your cursor should change to a cross, and this is when QGIS may start indexing your vector layers.
· When you hover over a label with this tool, it should have a red outline box, click on the label you want to move.
· An Auxiliary Storage method box may pop-up, asking you to select a primary key.
[image: images/labels_extended/AuxiliaryStorage_small.png]
Setting a primary key in the Auxiliary Storage box. The primary key will probably be fid.
The Primary Key is an index number which should be different for each feature in your feature class. If you set up GeoPackage layers, the default is usually fid (f eature id).
· If your data is in a GeoPackage, fid should automatically be selected, so click on OK.
· If your data is not in a GeoPackage and does not have a fid column, or another column with unique identifiers, the easiest way to add the column is to Export the layer to a GeoPackage.
· Use the cursor to change the angle of your label. QGIS will show you a purple box for the new angle and the angle of rotation in degrees.
[image: images/labels_extended/RotateLabel2_small.png]
Rotating the label - note the purple box showing the new angle, and the degrees of rotation.
· When you’re happy with the rotation of the label, left-click and the angle of the label will change.
· To save the new location, save your map (<ctrl>-s).
[image: images/labels_extended/RotateLabel3_small.png]
The rotated label - now following the trend of the valley rather than horizontal on the page.
Once you’ve finished rotating labels, you’ll need to click on another tool, such as Pan Map on the toolbar at the top, to stop selecting labels.
Changing properties of individual labels
Sometimes, once you’ve set label properties automatically, you have one label you’d like to be a different format, size or colour, but there isn’t an attribute you can use to create a rule just for that label.
In the example below, “The Long Mynd” is the same size and colour as labels for “Haddon Hill”, “Pole Bank” etc, but The Long Mynd is the name of whole hill, of which the others are just parts. So I want to make the label for The Long Mynd larger than the rest.
[image: images/labels_extended/LongMyndLabel1_small.png]
The label for the Long Mynd is the same size as other labels and I want to make it larger so it stands out more. The whole hill is called The Long Mynd.
To change the properties of a single label:
· Select the Change Label Properties button from the Label toolbar.
· When you hover over the label you want to change, it should show with a red outline. Click on the label.
A Label Properties dialogue should appear. Use this to change the properties of your label as you wish.
· Click Apply to see how your changes look.
· If you make the label larger, you may find it disappears. If this happens put a tick in the box next to Always show (exceptions above). This may make other labels disappear, but you can use the section below on displaying unplaced labels to make sure they are visible.
· When you are happy with your property changes, click OK to return to your map.
[image: images/labels_extended/LongMyndLabel2_small.png]
The result of using Change label properties to make the Long Mynd label larger. It now has greater importance on the map, which is appropriate in this case.
Once you’ve finished changing label properties, you’ll need to click on another tool, such as Pan Map on the toolbar at the top, to stop selecting labels.
Displaying unplaced labels
QGIS will use rules behind the scenes to display or hide labels so they don’t overlap on your map or don’t hide certain features. This can be useful, but sometimes a hidden label is essential and you need to show it.
The Display unplaced labels button enables you to view the labels which aren’t visible. Once you can see them, you can move, rotate or resize them using the instructions above, so they will show on your final map.
To view unplaced labels:
· Click the Toggle display of unplaced labels button on the labels toolbar.
Any unplaced labels on your map should appear in red.
[image: images/labels_extended/UnplacedLabels_small.png]
Displaying unplaced labels in red on your map.
Once you can see the unplaced labels you can use the instructions in the sections above to move them, rotate them or change the size until they become placed.
You’ll be able to see when a label is placed so that it will show as the colour will change from red to the styled colour.
In the image below, I’ve moved the labels of The Port Way to the west of the map. They are no longer red, so if I click the Toggle display of unplaced labels button again, they will still be visible.
[image: images/labels_extended/PlacedLabels_small.png]
The Port Way labels to the west on the map have been moved slightly and are no longer red.
Further information: labelling
The sources I’ve recommended for styling also include useful information about labelling.
The books in the Principles of Cartography section of the reading list (available in Minerva) cover good practice for styling and labelling your maps. Suggestions include the following:
For a quick guide go for Darkes and Spence (2017). The section on “Symbolisation” on pages 17-18 and “Text on maps” on pages 23-25 are particularly relevant.
Peterson (2021) is a very readable book about map design. Chapter 4 covers fonts and chapter 6 covers features. These chapters are both relevant to styling and labelling.
In addition try Axis Maps Cartography Guide (billed as “A short, friendly guide to basic principles of map design”) which has a section on Labeling and text hierarchy in cartography.
Conclusion
The techniques above should allow you to create a colourful and informative map. Once you have styled and labelled your data, you can move on to the next chapter to create a layout to display your data to your audience.
Layout and presentation
Last Modified: 08 Jan 24, 17:13:47
The background to layout and presentation will be covered in the lecture segment at the beginning of the class, and the presentation and any other supporting materials will be available in Minerva. The lecture segment should help you to understand why you are doing these exercises. If you still aren’t sure, please ask Clare.
Learning outcomes
When you have completed this section of the workbook you should be able to
· Layout your maps in such a way that they effectively communicate the content and purpose of your work to a user
· Select relevant map elements to include in a layout and set their properties to match the requirements of your map
· print or export your map layout to show your work to it’s best advantage
Introduction to layout and presentation
Once you’ve put in all the hard work to produce a map of your field area or project, it is worth making the extra effort to ensure that you lay it out clearly and print or export it in a professional fashion. Make sure that you allow the time to do this. Care and patience can make the difference between a scruffy, unimpressive map that loses you marks, and a clear, professional map that gives a good first impression and causes your audience to take your work seriously.
[image: ../../shared/docs/images/svg/warning-black-24dp.png] Warning
Don’t underestimate the time that the final details can take and don’t leave this part of the preparation until the last hour before a deadline!
You won’t need to use all the elements and features outlined here for every map. Equally this is not an exhaustive list of possible elements. You should already have some idea of what elements are useful, and should be able to make a decision for each case based on your existing knowledge of maps. If you think that you need to add something that is not listed here, e.g. a report based on a table, then use the extra information available at the end of the chapter and search on-line to find out how to add it.
This chapter isn’t necessarily for working through in order. Make sure that you are aware of the contents and of what QGIS is able to do, and then make your own decisions about what you need to include based on the principles that will be covered in class.
Note that the examples in the images use a general map which isn’t the same as the one you will be working on. The techniques and the buttons in QGIS are still the same, though.
The data for this chapter
You should use a map that you have been creating in previous chapters as instructed below [footnoteRef:737]. Try out all the techniques listed below and then decide which you need to include on this layout before you export it. [737:  If you no longer have a copy of the map that you have been instructed to use it doesn’t really matter. Either use a different map that you have created, or download the map from the week 1 class and use that instead. It isn’t the map itself that is important for these exercises, but having a layout with data on it so that you can try things out.] 

· Level 1 geologists use the Cononish map from the previous chapter.
· Level 2 and above geologists. You should be working on your own maps.
· Level 2 environment students use the Lake District map.
· Level 1 geophysicists continue working with the Llanbedr map.
Creating and saving layouts
In QGIS a print layout allows you to control the format and scale at which you print and export your map, and to lay out additional elements to complete the final product.
Creating a print layout
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Creating a print layout in QGIS and adding a map view.
This video clip can be found in the module area of Minerva or in the full list of video clips.
To create a new print layout
· Open your map project in QGIS if it isn’t already open
· Add a print layout by going to Project > New Print Layout...
· You’ll be asked to Enter a unique print layout title - call it something that will tell you what this layout is intended for. For example, enter A3 for printing. You can leave this blank if you wish.
· Click OK
QGIS will open your new blank layout in a new window. It should look something like the image below - though your toolbars may be in different places.
[image: ../../shared/docs/images/layout/NewPrintLayout_anno.png]
Your new print layout showing a blank page.
In this view you will see your map laid out as it will be when it is finally printed or exported. You’ll see the page outlined on screen and, once you have started adding elements you will see the content as it will look on the page.
Opening existing print layouts
Once you have created a print layout you can close it and open it again without losing it.
· Close the window containing the print layout (Layout > Close)
· To reopen it go to Project > Layouts and select your layout from the list - there is only one there at the moment so click on that.
Saving layouts
A layout is saved as part of the project so whenever you click on Save in your project it will save the layout too.
For now:
· Click on the Save button in the layout window.
· Or Layout > Save Project
Adding a map to a layout
At the moment all you have is a blank page. To add a map to a layout:
· Click on the Add Map button on the Toolbox
· Or Add Item > Add Map
· Then use the mouse cursor to drag a box across the page. It doesn’t matter about the size at the moment you can change it later.
You should now be able to see a section of the map from your main project window. The Item Properties on the right will now give options for the map. You’ll explore these in more detail later.
Size and scale of pages and maps
The size of the page and of the map “window” will affect the scale and extent of the map. These are all linked so if you change one remember to check that your map is either still at the correct scale, or still covers the correct area.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Setting the size and scale of a map layout in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
Page size and orientation
The page that you see in the layout window shows how the page will look when you export or print your map. Remember to check the paper size and set it correctly before you spend time arranging your layout.
To change the paper size and orientation:
· Right-click somewhere on the “page” and go to Page Properties
The page properties should open in the Item Properties on the right.
· The Size setting allows you to choose from a wide range of standard sizes, e.g. A4, A3 etc.
· The Orientation setting allows you to choose between portrait and landscape orientation.
· You can also set the page measurements manually by changing the Width and Height in the boxes below.
· The page in the main view should change automatically when you change a setting.
[image: ../../shared/docs/images/layout/PaperProperties_small.png]
The page properties set to an A3 Portrait page.
[image: ../../shared/docs/images/svg/create-black-24dp.png] Changing paper size and orientation
Change your page size and orientation to A3 Landscape. This will give you more space to experiment with adding other elements to your page.
Once you have changed the paper size you may find that you can no longer see the whole page in the layout view. To zoom in or out use the buttons on the toolbar at the top. In particular use the Zoom full button.
Setting up a multi-page layout
It is possible to create layouts with multiple pages in QGIS.
· On the menu bar go to Layout > Add pages...
· In the box which opens select the number of pages to create and whereabouts you want them to be added.
· Set the size and orientation of your new page(s)
· Then click on OK to add them to your layout.
[image: ../../shared/docs/images/layout/InsertPages_small.png]
Inserting two new pages at the end of the layout.
If you decide you don’t need any of the pages you can delete them:
· Right-click on the page you wish to delete and select Remove page.
Resizing the map in a layout
When you first set up a layout the size of the map may not be the size that you want it to be eventually. Changing the size of the frame is easy, but can take a little experimentation. You will also need to look at this in conjunction with the instructions on changing paper size in the previous section.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Resizing the map frame in a layout in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Make sure that the map frame is selected in the layout by clicking on it.
· When the map frame is selected you should be able to see that there are small boxes at the corners and on each side.
[image: ../../shared/docs/images/layout/ResizeMapFrame_small.png]
Using the handles on each corner and side of a map to resize a map frame in a layout.
· Use the boxes as “handles” to resize the map frame by dragging them
· Keep an eye on the scale in the map Item Properties. If you need to make a map at a particular scale you may need to keep putting this back to the correct scale each time you resize the map.
[image: ../../shared/docs/images/svg/warning-black-24dp.png] Warning
This process can take patience to get the map frame the correct size for the scale and area. There don’t appear to be any short cuts so just stick with it and keep repeating the process!
Moving the map within a map frame
If you need to move the map itself within the frame, e.g. so that you see a different part of it:
· Click on the Move Item Content button on the Toolbox
· You’ll be able to use the mouse cursor to move the map around within the frame.
· You’ll also be able to zoom in and out on the map.
· Remember to click back onto the Select/Move Item button to be able to select items again. It’s frustrating when you forget and find that you can’t move any elements around!
Controlling the map with the Item Properties
If the map is selected on the layout you will see its properties in the Item Properties panel on the right. You can use these to control various settings for the map. The ones you need to know now are:
· The most obvious is Scale. Use this box to type the scale that you want your map to print at.
· Extents is useful if you don’t need to worry about the scale but do need to show a map covering a particular area. You can type the east, south, west and north coordinates and the map frame will change accordingly.
· The Frame setting allows you to put an outline around the outside of your map. This can make the map look more professional.
Adding items to a layout
The information below includes details on adding many different items to a layout. Not all these will be appropriate to every layout, but it is up to you to decide which items to use depending on the purpose and audience of your map and any guidelines specified for assessments or reports. Some of the references on the reading list, particularly Darkes and Spence (2017), should help you with this.
Remember that the QGIS Documentation will provide you with plenty of extra information on how to add items to a layout.
Most items are added to a layout in a similar way to each other using the buttons on the Toolbox. In most cases you’ll then be able to use the Item Properties to make changes to the item.
Selecting items on a layout
There are a couple of ways of selecting items on a layout.
· Click the Select/Move Item button on the Toolbox then click on the item you wish to select
· Alternatively, use the Items panel. As you add more items to your map they will be added to this panel. All you need to do then is click on them in this list to select them on the map.
You can also use the items panel to lock items in place and make them invisible.
[image: ../../shared/docs/images/layout/ItemsPanel_small.png]
The Items panel showing that Map 1 is select and locked, while the attribute table frame is invisible.
Once an item is selected it will have the little “handles” visible for resizing.
A legend or key
You will have added various data to your map, and it is necessary for you to explain to anyone looking at your map what those layers and symbols show. To do this you’ll need to add a legend or key. Note that this can be a relatively complex procedure and there are a lot of instructions in this section. It’s worth having a quick look at the whole section to get an overview before you start trying to add a legend.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Adding a key or legend to a map layout in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
Start by using the default options to create a legend. Once you have the basic legend it is possible to make alterations later.
[image: ../../shared/docs/images/svg/warning-black-24dp.png] Warning
Save your map and take a backup copy of your project folder before you start doing this.
While it is usually fine, if you have a lot of big layers on your map QGIS can crash when you first add a key and you don’t want to lose the work you’ve already done.
There are ways to get around this problem with the legend crashing QGIS.
To add a legend / key:
· Click on the Add Legend button on the Toolbox
· Click on your layout in roughly the location that you want your legend to appear. You can move and resize it later. You can also “drag” the box to the correct size as you add it.
· If the New Item Properties dialog appears click OK
QGIS will add a legend which includes all the items from all the layers on your map. This is likely to be rather a lot! The first thing to do is to remove any that you don’t need.
As usual, while the legend is selected, the Item Properties will show the specific properties for this element.
· In the Item Properties start by checking that the legend is referring to the correct map on your layout - use the dropdown box next to Map to select the correct one if you have more than one.
· You can give your legend / key a title if you wish, but note that this isn’t always necessary.
· Then move down to the Legend Items heading
· If you don’t want all your layers to appear then untick Auto update - you can always click on the Update All button later if you change symbols etc on your map.
· Now you can select layers and then click on the red minus button under the list to remove them.
· To only show elements which appear on your map tick next to Only show items inside linked map - this can be a great help to remove surplus symbols.
[image: ../../shared/docs/images/layout/LegendPropertiesLayers_small.png]
Setting the legend properties to control the layers and symbols on the key.
Once you have just the layers that you want on your key you can then use the rest of the properties to set fonts, backgrounds etc.
· It is possible to drag and drop the layers in the Items list and rearrange them.
· The Columns section allows you to split your legend into two or more columns.
· The Symbol section will let you change the size of symbol, or patch, on the legend - sometimes it is useful to be able to enlarge the “patch”.
· To change layer names in the legend without changing them on your map you can select the item in the list and click on the pencil icon below.
· Alternatively, you can change the names in the Layers panel in map view then click on the Refresh button in layout view to refresh the map and all associated items.
Changing the order of items within a categorized layer
If you have a layer styled by categories, the initial legend entries will usually be in alphabetical order starting from the top.
If you are creating a legend for a layer for which the order is important, for example, a geology bedrock layer where the younger rocks should be at the top and the older at the bottom, you will probably need to rearrange the legend entries.
There are two ways of doing this.
In the Layer Styling panel:
· Open the Layer styling panel and check the correct layer is selected.
· In the categories list drag and drop each entry to change the order.
This also changes the order in which categories are drawn on the map, so you may also need to check that your map still appears correct.
In the Layout legend options
· Select the legend and untick Auto update under Legend Items, if it isn’t already unticked.
· Select one of the categories you want to move and use the blue up and down arrows below the list to move it up or down.
This method only changes the order in the legend and doesn’t affect the order in which your categories are drawn on the map.
Changing the size of the legend patch
Sometimes the patches are too small to see clearly. This can be a particular problem for continuous colour ramps, but vector patches can be resized the same way.
To change the size of a legend patch:
· With Auto-update off…
· In the legend properties double-click on the layer to change or click on Edit selected item properties below the list of items.
· In this dialog you can also change the text next to the legend item.
· Use the Width and Height settings to make the patch larger - it should update automatically as you type numbers.
[image: ../../shared/docs/images/layout/LegendPatchSize_small.png]
Changing the size of a legend patch in the item properties.
Creating a legend for a continuous raster
Version 3.20 and above of QGIS will automatically create a continuous patch. So if you are using version 3.20 or above you don’t need to worry about the rest of this section.
[image: ../../shared/docs/images/layout/ContinuousAuto_small.png]
A legend for a continuous raster which was produced automatically by version 3.20 of QGIS.
Unfortunately, the tools in version 3.16 and below of QGIS don’t make it easy to create a patch for a continuous raster. The quantities will appear as separate boxes. There are ways around this.
[image: ../../shared/docs/images/layout/ContinuousNo_small.png]
A legend for a continuous raster which isn’t showing a continuous scale.
If you look at the article by EcoDiv entitled Legend for continuous raster in QGIS composer you’ll find a way to generate a continuous legend patch [footnoteRef:799]. [799:  Page last visited: 30th March 2022.] 

[image: ../../shared/docs/images/layout/ContinuousYes_small.png]
A continuous legend scale produced using the method at the web page above.
Manually editing the legend
There is a limit to what you can do with the automatic functions and properties but do as much as you can as that will save some time. It’s particularly important to play around with the spacing settings as there isn’t a way to change that manually.
Once you have finalised as much as possible on your legend using the item properties, the instructions below show how to manually add and edit elements manually.
Alternatively, it is possible to export the map as pdf or svg format then edit the legend in a vector graphics editing program such as Inkscape, CorelDraw or Adobe Illustrator.
[image: images/svg/videocam-black-24dp.png] Manually editing a legend in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
Adding or editing items not created automatically
As an example, this could be a way to add a patch for a combined colour on the layout which isn’t actually part of a layer so doesn’t appear in the legend.
To do this, you add the shape you want using the menu items listed below, “draw” it on the layout, then style it using the item properties.
· To add a rectangle or circle go to Add Item > Add shape > Add Rectangle or Add Ellipse.
· To add a marker symbol, e.g. for a point, go to Add Item > Add marker, then choose a marker from the properties as you would for marker symbols in Layer styling.
· To add a line go to Add Item > Add Note Item > Add polyline. Click each node to draw the line, then left-click to finish.
Matching a colour on the map using the color picker
Legend items need to accurately reflect the colour of the equivalent feature on the map, so it’s important to be able to set this. QGIS provides a colour picker feature which is ideal.
· Make sure that the item you want to colour is selected on the layout.
· In Item properties click on the button next to Style. The Symbol Settings dialog should appear. This works in the same way as the Symbol Settings when you’re styling map features.
· click on the colour you need to change.
· Choose the Color picker tab (as usual, hover over the buttons to see the tips).
[image: ../../shared/docs/images/layout/ColorPickerTab_small.png]
The color picker tab.
· Click on the Sample color button to get the color picker cursor, then hover the cursor over the correct colour on the map.
· To select the colour, press the spacebar on your keyboard.
The colour should be applied automatically to your element.
Covering unwanted text or elements
This is an example of lateral thinking, but the easiest way to get rid of unwanted text or elements that can’t be removed using the legend properties, is the following:
· Go to Add Item > Add Shape > Add Rectangle and draw a rectangle over the text or elements you want to remove.
· Set the fill of the rectangle to the same colour as the background (using the color picker as above if necessary).
· Set the stroke style to No pen.
You can then add any new elements on top of the “invisible” rectangle.
Adding new or extra text
Adding new or extra text is really just a case of adding a label in the usual way.
· Add Item > Add Label
· Change the font, font size, colour, etc, to match any other text on the legend.
Preventing the legend from crashing QGIS
If you have a problem with QGIS crashing when you add a legend, try the following. It is probably crashing because you have a lot of layers on your map and, because Auto update is selected, it is struggling to add all the details.
· Open a new, empty project in QGIS
· Create a new blank layout as you did above.
· Add a legend to the layout. It won’t have any content, but that’s fine.
· Untick the box in the legend properties that says auto-update
· It’s a good idea to add a title and a frame to the legend so that you can find it again!
· Save the layout as a template (Save as template button on the toolbar)
· Close the blank project and reopen your real project
· Create a new layout use the template that you saved by doing the following:
· Project > Layout Manager
· Under New from Template select Specific from the dropdown
· then click on the three dots button next to the blank field
· Select the template that you just created and Open
· Click on the Create... button and you’ll be asked for a name for your layout
Once you have the layout open add a map frame. You’ll then need to associate the map frame with the legend by selecting the legend and setting the Map to the correct map.
Now use the + (plus) button below the Legend Items to add the layers that you do want to be included. Ticking Only show items inside linked map will also help.
This is a fiddle and not ideal, but if it stops your QGIS project from crashing hopefully it is worth it!
Scale bar and scale text
Some indication of scale should always be added to both printed and screen maps. A scale bar is a useful convention for both. Scale text (e.g. 1:50,000 or 1 cm = 1 km) is only relevant for printed maps, not for maps on screen where someone can zoom to any scale. If you add scale text you must also ensure that you print or export the map at the correct scale.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Adding a scale bar and scale text to a map layout in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
To add a scale bar
· Double-check first that you have the correct map selected on your layout. Particularly important if you are including multiple maps at different scales.
· Click on Add Scale Bar on the Toolbox
· Click on the layout in roughly the position you want the scale bar (you can always move it later)
· Select OK on the New Item Properties box that pops up
The scale bar should appear on your layout. You can now go to the Item Properties to change various parameters.
· The Map dropdown is where you check that the scale bar is set for the correct map
· Use the Style dropdown to select how you want the scale bar to appear - try a few of these and see what effect they have
· The Scalebar units should be set to something appropriate for your map
· You can use the settings under Segments to change the length and intervals of your scale bar. Try these out and see what happens.
[image: ../../shared/docs/images/layout/ScaleBarProperties_small.png]
The most important settings for the scale bar.
There are a lot more settings so just explore these and see what they do. In particular you may want to change the Font under the Display settings. You can always remove the scale bar and start again!
To add scale text
· Click on Add Scale Bar on the Toolbox
· Click on the layout in roughly the position you want the scale text (you can always move it later)
· Select OK on the New Item Properties box that pops up
A scale bar should appear on your layout. You can now go to the Item Properties to change this to numbers.
· The Map dropdown is where you check that the scale text is set for the correct map
· Use the Style dropdown to select Numeric
The text should appear and automatically match the scale of your map. There are far fewer options for this - mainly just the Font settings.
Text or labels
Text is an essential part of any map layout. Maps need an informative title to show the audience what the map is about. You should include your name (or for an assessment your student ID) as creator of the map. Copyright statements are essential if you have used data from other sources and you may also want to include acknowledgements and further explanations of your maps and data.
There are two main ways to add text, static text and dynamic text. The instructions for static text are shown below. Dynamic is more complex and won’t be covered here. If you are interested in using it you can look at the tutorial on Creating a Dynamic Print Layout in the QGIS Training Manual.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Adding text to a map layout in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
Static text
Static text is text that you type into the box on the Item Properties. This stays the same once you have added it. Most of the text that you add to your layout will be of this type. For example, a title or subtitles to individual maps, your name or ID as the creator of the map, copyright text etc.
To add static text:
· Click on the Add Label button on the Toolbox
· Click on your layout in roughly the location that you want your text to appear. You can move and resize it later. You can also “drag” the box to the correct size as you add it.
· If the New Item Properties dialog appears click OK
· A new label item should appear on your layout. By default the text will be “Lorem Ipsum” (placeholder text).
· Type your text in the box on the Item Properties panel
· The options on the panel will also allow you to change the font, font size and colour, the alignment, and add a frame.
[image: ../../shared/docs/images/layout/TextProperties_small.png]
Item Properties for text. Note the large box to type your text and the options in the Appearance section below.
Copyright acknowledgements
Copyright is important. Remember that most data providers ask you to sign up to conditions that include an obligation to add a copyright acknowledgement to your map. Check what that copyright statement is and make sure that you add it.
For example, when you signed up to use the Digimap collections you agreed to add copyright acknowledgements whenever you created a map with the data. These acknowledgements do change from time to time so it’s worth knowing how to check what they are for yourself.
· To find the Digimap copyright acknowledgements go to the Digimap Help (Help at the top of the main Digimap page)
· Look for a link to Copyright and Licensing and click on it.
· Individual licences are in a list on the left, click on the one for the data you are using. There is more general information in the main body of the page.
· Then look for the information under In return, you must: - that gives you the acknowledgement text.
For example, from April 2019, when you use Ordnance Survey data obtained from Digimap you are expected to add the following text to your map.
© Crown copyright and database rights year. Ordnance Survey (AC0000851941).
Where year is replaced by the current year.
Remember that you do have to acknowledge each different dataset that you use and will have signed up to that when your registered.
[image: ../../shared/docs/images/svg/info-black-24dp.png] Adding the copyright symbol to your text
• To add the © symbol (on Windows), you can copy the symbol from this document and paste it into the box in the text properties panel.
• Alternatively, put the number lock on the keypad, hold down the Alt key, type 0 1 6 9 then let go of the Alt key.
• If you are on a Windows laptop and don’t have a number pad, put the text [%char(169)%] in the text box.
• If you are on Mac, either copy and paste, or use the shortcut Option + G.
If you are not using U.K. Ordnance Survey data this is not the correct copyright acknowledgement to use. For example, if you are using data for Spain or the United States, or indeed UK data that you haven’t downloaded from Digimap. You’ll need to find the correct copyright acknowledgement for yourself. You can often find this sort of information on files that come with the data or on the webpage you downloaded it from.
Digimap also give advice on citing Digimap data as opposed to the copyright acknowledgement.
GIS Lounge have an article about How to Cite GIS Materials which includes the software as well as the data and the maps.
A measured grid
Measured grids add labelled grid lines to a map. If you are using Ordnance Survey or other UK data projected in British National Grid then you can easily add National Grid lines and numbers to your map. The O.S. Raster tiff files already have grid lines marked, but adding a measured grid allows you to include coordinates around the edge of your map - making it possible to read grid references.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Adding a measured grid to a map in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Click on the map to which you want to add grid lines.
· In the Item Properties scroll down until you reach the Grids heading and click on the little arrow next to it.
· Click on the + (plus) button below the Grids heading to add a Grid to the list below.
· Select the Grid in the list and click on Modify Grid...
The Item Properties will change to show the properties for the grid.
· Under Interval set the X and Y boxes to the interval that you want between the lines. This depends on the scale of your map and you can experiment to see what looks best and would be most useful. For now try 1000 - this is in map units which for British National Grid will be metres.
· The lines are often too bold, so click on the Line style dropdown and select a paler shade of grey. You could also make the lines thinner.
[image: ../../shared/docs/images/layout/MapGridProperties1_small.png]
The top of the Map Grid Properties showing the interval and the paler line style.
· Scroll down and tick next to Draw Coordinates - this adds the numbers.
· I usually change the Left and Right coordinates from Horizontal to Vertical so that they follow the edge of the frame.
· Alter the Font as you wish - don’t make the coordinates large. They need to be visible, but not intrusive.
· Change the Coordinate precision to 0
[image: ../../shared/docs/images/layout/MapGridProperties2_small.png]
The Draw Coordinates part of the Map Grid properties showing the Vertical setting for Left and Right and Coordinate Precision set to 0.
Note that the grid that QGIS adds is fully numeric, you may be more used to seeing grid letters for 100 km grid squares, e.g. the University grid reference is similar to SE 2934 3444, the University grid coordinates are similar to 42934 43444. It is the latter that will appear on a measured grid generated by QGIS.
[image: ../../shared/docs/images/layout/MapGrid_small.png]
A map with a measured grid that shows British National Grid coordinates on a 1000 m grid.
North arrows
Before adding a north arrow to your layout stop and think about how you need to indicate north on your map. If you look at the technical information on an Ordnance Survey Landranger (1:50 000) map you’ll see a diagram showing Grid north, True north and Magnetic North. The information given there shows how to plot the difference of magnetic north from grid north. Adding this to your own maps can be useful, particularly if you, or anyone else, are going to be using the map in the field.
If you are taking strike and dip measurements in the field you should have corrected your compass-clino for declination (the horizontal angular difference between true north and magnetic north) anyway. When you plot the measurements on your map it isn’t worth worrying too much about whether you are plotting against grid or true north as the difference on any grid, not just the British National Grid, is unlikely to be that big. See the image below for the different types of north and the declination.
[image: ../../shared/docs/images/layout/LONorthVersions.png]
The different types of North that you will find on a map set to a projected coordinate system, such as British National Grid.
[image: ../../shared/docs/images/svg/info-black-24dp.png] Labelling north arrows
If you add any north arrows to your layout do remember to label them in some way which shows which version of north each one is showing.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Adding north arrows to a layout in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
North arrow: Grid north / Map north
If a map is in a projected coordinate system QGIS will automatically lay it out aligned with the grid. So for example, any map set to British National Grid will be aligned to grid north.
In this case it isn’t strictly necessary to add a north arrow to show grid north if you also include a measured grid on your map, but it doesn’t hurt.
· Click on the Add North Arrow button on the Toolbox
· Click on your layout in roughly the location that you want your north arrow to appear. You can move and resize it later. You can also “drag” the box to the correct size as you add it.
· If the New Item Properties dialog appears click OK
QGIS will add a default north arrow to your layout and open the Item Properties.
· Under Picture check that SVG image is selected
· In the box below scroll down to svg > arrows to select a different north arrow. Note that it’s usually a good idea to keep these simple.
· Change the colours and stroke width under SVG Parameters if required
· Under Image Rotation the North alignment should be set to Grid North by default - if it isn’t set that now.
[image: ../../shared/docs/images/layout/NorthArrowGrid_small.png]
The Item Properties for a north arrow showing Grid North.
If you check this against your measured grid lines you should find that it matches exactly.
North arrow: True north
True north is the direction from the area of your map to the North Pole. In the east/west centre of a grid, such as that set for the British National Grid, it may well be the same as grid north, e.g. in Leeds the difference is extremely slight. As you go further east or west towards the edges of an area covered by a grid the difference becomes more noticeable, e.g. at Lands End in Cornwall, or in Norfolk.
· Click on the Add North Arrow button on the Toolbox
· Click on your layout in roughly the location that you want your north arrow to appear. You can move and resize it later. You can also “drag” the box to the correct size as you add it.
· If the New Item Properties dialog appears click OK
QGIS will add a default north arrow to your layout and open the Item Properties.
· Under Picture check that SVG image is selected
· In the box below scroll down to svg > arrows to select a different north arrow. Note that it’s usually a good idea to keep these simple.
· Change the colours and stroke width under SVG Parameters if required
· Under Image Rotation set the North alignment to True north
You should see the rotation in the box above change to a slightly different number.
If you check this north arrow against your measured grid lines you may well find that the north arrow is slightly tilted.
North arrow: Magnetic north calculated by declination
Magnetic north is the direction from the area of your map to the magnetic north pole. This is the number that is given on the corner of Ordnance Survey maps and the one geologists need for setting their compass-clinos in the field, so it is worth making a note of this on your map too.
Finding the magnetic declination
First you need to find the magnetic declination.
· Go to the World Magnetic Model 2020 Calculator on the BGS Geomagnetism Group web pages
· Use the map to navigate to your location and click to drop a point.
· A small results box will appear. The number you want is the Magnetic declination, which is in in the D column and MF row. There is a key to the results below the map and you are looking for degrees east.
· Make a note of the declination, including any minus sign.
To set magnetic north on a layout
· Click on the Add North Arrow button on the Toolbox
· Click on your layout in roughly the location that you want your north arrow to appear. You can move and resize it later. You can also “drag” the box to the correct size as you add it.
· If the New Item Properties dialog appears click OK
QGIS will add a default north arrow to your layout and open the Item Properties.
· Under Picture check that SVG image is selected
· In the box below scroll down to svg > arrows to select a different north arrow. Note that it’s usually a good idea to keep these simple.
· Change the colours and stroke width under SVG Parameters if required
· Under Image Rotation set the North alignment to True north as declination is the angle from True north to Magnetic north.
· In the Offset field enter the angle that you obtained from the BGS website.
[image: ../../shared/docs/images/layout/MagNorthImageRotation_small.png]
Setting the image rotation for a magnetic north arrow. The declination from the website is -0.35 degrees.
Don’t forget to add text to your map showing the date of the reading. It changes with time.
For more about how the magnetic north pole is moving see the BGS blog.
Multiple maps on one page
It can be very useful to be able to place more than one map or map view on a single page, either so that you can show a different area, or a different zoom level for the same area. You can also use this to set up an automatic extent indicator which marks your study area on a map of a country.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Adding multiple maps to one layout in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
Different areas of the same map
You can add multiple maps to your layout using the Add Map command in the same way you added a single map earlier.
If you add them directly both maps will show the same data and styling. You can then change the scale and extent on each one individually using the Item Properties and the Move Item Content button.
Maps showing different content
If you want to add further maps to your layout but have them showing different content you can do that too.
· Select the initial map frame on the layout
· Make sure that it shows the content that you want it to show and it is all styled correctly
· In the Item Properties go to the Layers subheading and tick on Lock layers
· Once you’ve done that you’ll have the option to tick Lock styles for layers too. This stops your styles from changing if you change them in the main map.
Now go back in to the map view and set up the map and layers so that they are as you want them for the second map.
· Back in layout view add a new map frame as before. This should reflect the map that you have open in the map view now.
· Once you are happy with this view in the Item Properties go to the Layers subheading and tick on Lock layers
· Once you’ve done that you’ll have the option to tick Lock styles for layers too. This stops your styles from changing if you change them in the main map.
As both of your maps are locked you will have to remember to unlock them if you need to make any changes to the styles or combinations of layers.
[image: ../../shared/docs/images/layout/MultipleMaps_small.png]
Two views from the same map with layers locked.
Extent indicator or locator map
For some maps, particularly large scale (detailed) maps of very small areas, it is useful to show a small scale map of the general area with the area of the main map marked, as in the figure below.
[image: ../../shared/docs/images/layout/ExtentIndicator_small.png]
A map of a small area with an extent indicator or locator map to give context.
To do this you need to obtain small scale data and add it to your map. You really only need a general map, even just an outline of a whole country.
Natural Earth data
It is possible to do this using data from Natural Earth. Download the Countries data from Medium scale data, 1:50m > Cultural > Admin 0 - Countries - click on the Download countries button to download a zip file containing a shapefile.
Quick World map
There is also a little trick hidden in QGIS which makes adding a World map with country outlines really easy.
· In your QGIS project click in the Coordinate box at the bottom of your map then delete the existing contents.
· Type world (all lower-case) and press enter.
A map of the world with country outlines should appear on your map and in your Layers panel. When you zoom to layer the result might be a bit odd if you have a projection such as British National Grid set for your map, but try it out and see whether the area you need looks right.
You can style the map as usual, e.g. if you just want outlines.
[image: images/svg/warning-black-24dp.png] Warning
Using a screenshot from Google Earth or Google Maps (or similar) with a marker on it doesn’t look professional and should be avoided. Not least it is surprisingly easy to end up with the marker in the wrong place.
Adding the extent indicator to your layout
Note that the extent indicator does not need to be large, but should be a small map which doesn’t take up too much space on the layout.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Adding an extent indicator to a layout in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Set up your main map and lock the layers on the layout.
· Add the Countries outline to your map and turn off the other layers
· Symbolise the countries as a thin black outline and zoom in to the country containing your study area
· Add a new map to your layout and resize it as appropriate so that it shows the country as a small map.
· Make sure that the small map is selected then go to the Item Properties panel
· Scroll down to the Overviews section and click on the little arrow next to it to open it out
· Click on the + (plus) button then select the new Overview title that appears
· Check that Draw "Overview 1" overview (or whatever your new Overview is called) is ticked.
The properties to change how the overview looks are below.
· Under Map frame select your main map - the one of the smaller area.
[image: ../../shared/docs/images/layout/OverviewsProperties_small.png]
The Overview properties in the Item Properties for the small map.
· Set the Frame style as you wish. If you can’t see the frame on the indicator map because it is too small
· I found that setting the Simple fill Stroke style to Solid Line in the Symbol Settings
· then giving it a thicker Stroke width and setting the Join style to Round gave the effect of a dot on the map.
[image: ../../shared/docs/images/layout/OverviewDot_small.png]
Using the Symbol Settings to make the overview frame look like a dot.
You should now have a map with a marker showing the location covered by your main map. If you move the main map the “frame” on the smaller map will automatically update to reflect the new location.
Inserting photographs and images
You may want to include photographs and diagrams on your map layouts. Geological cross-sections will come under this category too.
[image: images/svg/videocam-black-24dp.png] Inserting photographs and images in a layout in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
To add a raster image
This includes photographs or any image in a format such as jpg, png, tiff, gif.
· Click on the Add Picture button on the Toolbox
· Click on your layout in roughly the location that you want your image to appear. You can move and resize it later. You can also “drag” the box to the correct size as you add it.
· If the New Item Properties dialog appears click OK
QGIS will add a blank picture place holder to your layout and open the Item Properties.
· In the Item Properties click to add a Raster Image
· Use the three dots button to navigate to and select your picture file then click Open
Your picture should appear on your layout. As usual you can resize it and move it on the layout and change the properties in Item Properties
To add an SVG image
SVG stands for Scaleable Vector Graphics. It is the native editing format for the vector graphics program Inkscape. If you have used Inkscape to draw your diagrams you can import them as follows:
· Click on the Add Picture button on the Toolbox
· Click on your layout in roughly the location that you want your image to appear. You can move and resize it later. You can also “drag” the box to the correct size as you add it.
· If the New Item Properties dialog appears click OK
QGIS will add a blank picture place holder to your layout and open the Item Properties.
· In the Item Properties click to add a SVG Image
· Use the three dots button to navigate to and select your picture file then click Open
Your picture should appear on your layout. As usual you can resize it and move it on the layout and change the properties in Item Properties
[image: ../../shared/docs/images/svg/warning-black-24dp.png] Warning
Unfortunately, svg images with gradient fills don’t seem to work well in QGIS. In many cases it will be better to export your diagram from Inkscape as a png file then import that to QGIS as a raster image.
Alternatively, you can export the layout from QGIS when you have finished adding all the map elements and then open it in Inkscape and add your diagrams there. This is usually a better option and instructions will be given for exporting from QGIS later in this chapter.
Checking your map
Checking your map is a very important stage but one that can easily be forgotten if you are in a hurry.
In addition to the points below have a look at Darkes (2017) which gives a lot of quick tips on map layout and presentation. On pages 92 and 93 Darkes includes a section with quick wins for improving your map before publication if you have 5, 15 or 50 minutes.
Suggestions for things to check
· Check that you have included everything you need to include. If this is an assignment reread the instructions and check that you haven’t forgotten to do anything.
· Check that you have left space for margins on the page. This is particularly important if you are printing your map - you don’t want to lose any of the content - but leaving some white space around the outside of your layout looks better even if you’re not printing.
· Check spelling. It’s easy to miss something obvious so if possible, print your map out, or put it on screen and stand back a bit then have a look at it. In particular check geological and geographical names and any technical terms.
· Check that your map doesn’t include anything that you don’t want to include! Did you add some experimental polygons when you were editing, then forgot to delete them? Have you added text boxes and then not removed any that you don’t need?
· Look at the article on Using a mapmaking checklist for map design on the ESRI blog. Read about what makes a map great, then click on the link to the checklist and use the questions there to evaluate your own map. Have you included everything you need to include, or do you have a good reason if something is not on your map? Have you taken care with your presentation?
Checking the colours of your map and layout
In the lectures on styles and labelling, and on presentation, we will have discussed the use of colour on maps. It’s a good idea to check your colours before exporting or printing your map, though you should have been thinking about them as you created and laid out the map too.
In Layout view there is a setting which allows you to simulate different forms of colour blindness.
The idea is to check that all the information on your map is accessible to all your potential audience.
[image: ../../shared/docs/images/layout/PreviewNormal_small.png]
The original, normal view of the map - no preview applied.
· In Layout view go to View > Preview then choose one of the forms of colour deficiency.
The whole layout should change to give you a preview.
[image: ../../shared/docs/images/layout/PreviewProtanopia_small.png]
A preview of the same map as it could be seen by someone with protanopia - no red.
· Check all the colours on your map are distinct. Do any look too similar? Have a look at the key as well to check the colours.
· Do all the layout elements show up clearly? If you’ve put anything on a background, is it still easy to see?
· Try different settings and check the colours carefully for each one.
· Looking at a layout in the greyscale preview setting can give you a good idea of the amount of contrast you have between your colours.
[image: ../../shared/docs/images/layout/PreviewGreyscale_small.png]
A greyscale preview of your map. Note how you can see the amount of contrast between your colours. Try to aim for good contrast to make your map clear to all your audience.
Printing a copy to pdf to check
Almost inevitably you’ll notice something not quite right with your map after you have printed it. To minimize the chances of this happening if you are printing an expensive A0 copy it is a good idea to print your map at A3 and have a close look at it. This isn’t such an issue if your map is only A3 or A4 when full size.
If you don’t have access to a printer then you’ll need to export as pdf and then zoom in and out on your screen.
· Export your layout as a pdf file following the instructions below.
· Open your pdf map file in your usual pdf reader (instructions below are for Adobe Acrobat but you should be able to find similar commands in other programs)
· File > Print
· Choose your printer and use the printer properties to set the paper size to A3 then choose to print in colour.
· In the Page Handling section set Page Scaling to Fit to Printable Area. In Acrobat this should show you a small preview of how your file will print.
· When you are happy with the settings send your file to the printer.
Printing and exporting map layouts
When you have finished creating your map layout in QGIS, you will often need to export it to pdf for printing. The following instructions should help to ensure that your map is the correct size and scale.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Printing or exporting a layout from QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
Printing a map layout from QGIS
The best quality output is probably obtained by printing directly from QGIS, though this isn’t always possible. If it is, print as follows:
· Start by checking that the page size and the map scale are correct.
· Go to Layout > Page Setup and check that the paper size matches the size you set in the layout properties.
· Then Layout > Print to actually print your map.
You’ll need to set up the printer as you usually would. This is system and printer specific so I can’t include fuller instructions here.
Exporting a map layout from QGIS
Exporting to pdf
These instructions show you how to export the map to pdf - the format that is usually required if you are having the map professionally printed.
· Start by checking that the page size and the map scale are correct.
· You should also check the Export Settings under Layout (the next tab to the left of the Item Properties. Check that the Resolution is set appropriately - too high and you’ll have an enormous file, too low and the print quality won’t be good. Try 300 dpi and see how that goes.
· In a layout go to Layout > Export as PDF... or click the button on the toolbar.
· Select where you want to save your output and give it a name
· Then click on Save
· The PDF Export Options should open. The defaults are fine, so stick with those
· Click Save to export the pdf.
You should get a message saying that your layout was successfully exported.
At this stage open the pdf and make sure it looks as you expect it to.
Important note on printing a map layout from pdf
If you are printing your final copy from pdf double-check in the pdf reader you use that the Page Scaling or Zoom is set to Actual size... or None. The actual terminology depends on which pdf application you are using.
This is important to ensure that your map is printed at the scale at which you intend it to be printed. This is particularly important if you are printing maps to be used as field slips. Major problems with measurements can be caused if your map is reduced by even a tiny amount.
Importing a pdf map layout in to Inkscape
[image: ../../shared/docs/images/svg/info-black-24dp.png] Export pdf and import to Inkscape
It is possible to export a map layout to svg which would work in Inkscape, but at the moment the export is rather unreliable. If you want to open your map layout in Inkscape to finish it off it is better to export pdf and import that to Inkscape.
I have experimented a bit with using the output from QGIS in Inkscape for a large map, and have found that, unless you are going to actually want to edit some aspects of the actual map, Inkscape is more stable if you import the map as an image, e.g. png format, and then add other elements around it. The next section below shows how to export your map as a png image.
If you need to make changes to a single element of your map, e.g. the legend, try creating the legend on a separate, smaller layout, export that as pdf and then add that to the main layout in Inkscape.
If you are importing the pdf in to Inkscape and if your map is going to be part of a bigger presentation where scale is important, such as the Geology degree final dissertation map, be very careful to import it without changing scale, size or proportions. The Interactive Inkscape exercises[footnoteRef:927] have a section on how to import a map layout. [927:  If you are not a Geology student but would like to learn how to use Inkscape for drawing and for finishing maps please contact Clare Gordon or go to Clare’s downloads to obtain a copy of the exercises as interactive worksheets.] 

Exporting a map to import to Word and PowerPoint
You can also export the layout to include in programs such as Word or PowerPoint if you are intending it to accompany a report.
· Start by checking that the page size and the map scale are correct.
· You should also check the Export Settings under Layout (the next tab to the left of the Item Properties. Check that the Resolution is set appropriately - too high and you’ll have an enormous file, too low and the print quality won’t be good. Try 300 dpi and see how that goes.
· In a layout go to Layout > Export as image or click the button on the toolbar.
· The Image Export Options will open. This gives you another chance to check the resolution.
· It’s usually worth ticking Enable antialiasing - but if your map looks very blurred it will be worth trying again with this unticked.
· If you are likely to want to open your output in GIS again click to Generate world file
· Click Save and wait for your file to be exported. You’ll get a message when it finishes.
Be aware that it is a good idea to create your layout at the correct size in QGIS before you export it. You can resize jpg or png files in Word and PowerPoint but you’ll lose some of the quality.
Setting up to print multiple map pages
Sometimes, once you have a map set up, you need to print it across multiple pages. The most likely example of this is for Geology students, where you set up your field slip ready for mapping, but it will need more than one page to print it at 1:10,000. Other students probably won’t need to do this, but the instructions are here anyway.
[image: images/svg/warning-black-24dp.png] Warning
Unless you need to set up a map as a series of field slips, or atlas pages, don’t follow these instructions now. It will be better to spend your time on other aspects of your map.
There are a couple of different ways you can do this and instructions are below.
· For all the options, start by setting up a layout with a map frame and any other elements you need to include, e.g. a scale bar, copyright text, date etc.
· It can be useful to have an outline of your area of interest so you can keep track of the area you need. If you don’t already have one in your map, create it as a polygon and roughly digitise the outline of your area.
Moving the map around within the layout
This method is probably the simplest, but it can be easy to miss bits, and if you do, it isn’t always easy to repeat the process.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Generating multiple map pages by moving the map around in the layout
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Set up your map layout, then move the map so you are looking at the north-west corner of your area of interest.
· Check the scale is correct.
· Print or export your map. If you export, you’ll be able to print further copies if you need them.
· Now carefully, using the Move item content tool, click and hold on the north-east corner of your map, and drag the map content across so that the bit you are dragging from is in the north-west corner of the layout. It’s usually a good idea to have an overlap.
· Once again, print or export your map.
· Continue doing this, dragging the map upwards from one of the southerly corners when necessary, so you have complete coverage of your study area.
Using the QGIS atlas function
This seems more complex, but if you make the effort, it is more reliable and if you need to generate maps for the same area again, it will be much simpler to do so than with the method above.
Once you have set up an atlas, QGIS will automatically export the pages based on your settings.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Generating multiple map pages with the QGIS atlas tool
This video clip can be found in the module area of Minerva or in the full list of video clips.
Creating a grid to control your atlas
You need to start by creating a coverage layout to control the area of each page of your atlas and the most reliable way to do this for field slips is to set up a vector grid to cover your area of interest.
To generate your vector grid:
· Search for Create Grid in the Processing toolbox and open the tool from under Vector Creation.
· Set Grid type to Rectangle (Polygon).
· If you have a layer covering the whole of your area of interest on your map, click on the three dots button at the end of the Grid Extent line and select Calculate from Layer, then select your area of interest layer.
· If you don’t have a layer covering the whole of your area of interest, select either Use map canvas extent or Draw on Canvas. If you select the latter, you’ll have a chance to draw your area on the map.
· Use the table below to select your Horizontal spacing and Vertical spacing based on the scale of your maps, and the size of your paper.
· Set the Grid CRS to the correct CRS for your map.
· Either create a temporary layer, or choose where to save your vector grid.
· Run the tool.
Note that the values in the table allow for a bit of an overlap. For landscape orientation instead of portrait, swap horizontal and vertical spacings.
This is a process which is likely to involve a bit of experimentation and changes in spacing to get the coverage you want.
	Paper size and orientation
	Scale of map
	Horizontal spacing (metres)
	Vertical spacing (metres)

	A4 landscape
	1:2,500
	600
	400

	A4 landscape
	1:5,000
	1250
	850

	A4 landscape
	1:10,000
	2700
	1800

	A4 landscape
	1:25,000
	6500
	4400

	A4 landscape
	1:50,000
	12000
	9000


[image: ../../shared/docs/images/layout/CreateGrid_small.png]
Creating a grid on which to base an atlas.
The result should be a regular grid, shown as the blue, dashed lines in the image below. (The thin, solid blue line is my area of interest.) The grid starts from the top left, so you may find you have too much space on the right and bottom of the grid. The main way to deal with this is to change the grid spacing, or use a slightly different area. If any of your grid rectangles have very little or none of your area of interest in them, as in the right-hand rectangles in the example below, you can delete them.
[image: ../../shared/docs/images/layout/VectorGrid_small.png]
The resulting vector grid shown as a blue, dashed line. The rectangles on the right contain very little of the area of interest, and I will delete them.
Setting up the atlas
Once you are happy with your coverage layer, you can start setting up the atlas.
· Enter Layout view and check your layout is set up correctly, e.g. with titles, scale bar, copyright, etc as required.
· Go to Atlas > Atlas Settings - the settings should open to the right of your layout.
· Tick the box labelled Generate an atlas.
· Set the Coverage layer to your vector grid layer.
· For now leave the Hidden coverage layer box unticked - being able to see the coverage layer while you are setting up, helps to get the correct areas on each page.
· For now you can leave the other settings as they are. You can come back to the settings and change those later if you need to.
[image: ../../shared/docs/images/layout/AtlasSettings_small.png]
The basic settings for an Atlas. Note that there has to be a Coverage layer, which in this case is my vector grid layer.
The next options are in the map properties:
· Click on the map frame that will control your atlas.
· Click on the Item Properties tab on the right.
· Scroll down and tick the box next to Controlled by Atlas.
If you are setting up a field slip you will need your maps to be at a fixed scale, usually 1:10,000. To set that fixed scale:
· Check next to Fixed scale.
· At the top of the Map Properties, check the Scale is set correctly - in my case to 10000.000 for 1:10,000.
[image: ../../shared/docs/images/layout/ControlledByAtlas_small.png]
Controlling the Atlas as a Fixed Scale in the Map frame properties.
· Now go up to the Atlas toolbar - if it isn’t visible go to View > Toolbars > Atlas toolbar.
[image: ../../shared/docs/images/layout/AtlasToolbar_small.png]
The Atlas toolbar with the Preview Atlas button clicked.
· Click the button on the left of the toolbar - the tooltip should say Preview Atlas.
Your map frame should jump to the first atlas page for your map. As you’ve left the coverage layer visible, you should be able to check whether you have the coverage you need.
· To preview your atlas, use the arrows on the toolbar. The numbers show which page you are on.
[image: images/svg/create-black-24dp.png] Changing the coverage
If you need to change the coverage, you’ll need to regenerate the vector grid, add it to your map, and change the coverage in the Atlas settings.
Preview your atlas again, and check whether it looks right.
Printing or exporting an atlas
Once you are happy with the coverage of your atlas pages:
· If you want to, make the coverage layer invisible by going to the Atlas settings and putting a tick next to Hidden coverage layer.
· Also in Atlas settings, you can choose whether to export multiple files, or tick next to Single file export when possible to generate a single file with multiple pages. This will work for pdf, but not most image formats.
· Double-check the scale is still correct.
· Go back to the Atlas toolbar and either click on the button to print your atlas, or choose one of the export buttons.
· If you are printing later, then choose pdf. This will also work best if you are going to make changes to your maps in Inkscape.
· If exporting, choose the folder you want to save your output(s) into, then click Select Folder.
· The defaults are usually fine, so stick with those for now, and press Save.
Depending on the number of pages you may have to wait for a bit, but once QGIS tells you it has finished, your file(s) should be available in the folder you selected.
Check the output, and make any changes to your coverage or layout as necessary.
There are other settings you can try, including using Expressions to add a page number or a different title for each page. The sources of help suggested below include more on this.
If you have a vector grid, it is also possible to create a final, less detailed map, which shows the coverage of each individual page - a map index.
[image: ../../shared/docs/images/layout/MapIndex_small.png]
A map index created from the coverage layer with the grid rectangles labelled with the map number.
Other sources of help for creating an atlas
There is a lot online about creating atlases in QGIS. Try any of the following:
· Training manual lesson on using the Atlas Tool - this uses a vector grid to control the pages of the atlas and this is what you are most likely to need for field slips.
· QGIS manual page for Generating an Atlas
· Klas Karlsson YouTube video on creating an atlas
Recommended reading: layout and presentation
The following references from the reading list[footnoteRef:971] will give you information on the principles behind producing a professional layout. [971:  Available in Minerva and via the University Library reading list page - just search for the module number.] 

· Darkes and Spence (2017) - large parts of this book are particularly relevant but it is formatted as a quick reference guide so it’s easy to get quick information about what ever you are looking for. Unfortunately, this book isn’t available online, but is worth buying if you want to buy one book for this module.
Particularly useful in the Darkes and Spence book are the pages at the end titled “Better mapping in 5, 15 and 50 minutes”.
· The article by Frye (2001) gives you quick information about communicating with maps.
Technical information
· The QGIS User Guide includes a chapter on Laying out the maps which covers a lot of the techniques from this chapter plus a few other things such as generating an atlas.
· QGIS Tutorials has a tutorial on Making a map in QGIS 3.
Further information and inspiration
· University of Delft publishes GIS OpenCourseware. Their tutorial on Cartography for map figures in academic journals and books is a clear look at how to include maps in other publications. This is well worth going through.
· For examples and ideas look at the ESRI Map Book Gallery.
· The British Geological Survey printed maps are available online via the BGS Maps Portal and it’s worth having a look at the layout of some of the more modern sheets, such as the Glossop sheet or the Bath sheet.
Completing a map layout in Inkscape
Last Modified: 28 Nov 23, 11:36:04
This chapter gives you ideas on how you can put together your own map layout in Inkscape. I’ll show you some ways you can do that, but feel free to experiment. You will probably need to use quite a few of these techniques for your dissertation map, but this time have a look at the information below and see how you can use it to improve layouts exported from QGIS. Use the Interactive Inkscape worksheets in conjunction with this chapter to finish laying out your map. In level two you’ll be learning how to produce a fair copy geological map in QGIS, and these techniques will be essential for the final layout then.
Why finish off your map in Inkscape?
The instructions in the GIS workbook, and particularly in the layout chapter, will enable you to create your whole map layout in QGIS, but adding images, diagrams and text to the final layout can be a bit hit and miss. Instead, once you have added measured grids, north arrows, a key, an extent indicator, and any other elements which are linked directly to the map, you can export the layout and then add more images, diagrams and text in Inkscape.
If you are working on a map exported from QGIS as pdf format, you can also ungroup content, and make minor changes (very carefully!). This is particularly useful if you need to move elements around on the legend or key, or remove some text.
In Inkscape you can use guides and grids to align your content, as well as the Align and Distribute dialogue. Make use of layers and groups to keep your content organised and “lock” anything you don’t want to edit by accident. You can import content from a range of sources, or create it directly within Inkscape.
[image: images/svg/warning-black-24dp.png] Warning
The instructions below don’t step you through setting up a layout. They are a series of things to try out and use if they are helpful for the layout you are working on at the time.
If you are in the level 1 class, try these all out and see how they work. In future you’ll have an idea of what is possible and what will be useful.
Deciding which format to export from QGIS
It is possible to export your map from QGIS and import it into Inkscape in a few different formats. Each has their advantages and disadvantages, but the amount of memory and power that your computer has might be the deciding factor.
SVG is the “native” format for Inkscape. This allows you to edit elements within the exported map, e.g. if you want to change the legend or some text. Unfortunately, at the moment support for exporting svg from QGIS is unreliable and I don’t recommend trying this.
PDF is another vector format and this can also be opened in Inkscape. Once you open a pdf in Inkscape you can save it as an svg file and edit the vector components in the usual way. This is the way I recommend you try first. If your map covers a large area in detail, note that Inkscape can struggle with large maps, but it could be worth a try to see how it gets on with your map.
QGIS will also export your map as png image format. This is the best option if Inkscape is running too slowly, or crashing when you open the pdf (or svg). It does mean that you can’t edit elements of the map itself any further in Inkscape. You’ll only be able to add new elements. It is, though, possible to export just a legend, for example, from QGIS and add that separately if that helps.
Below I’ve given separate instructions for using pdf and image formats in Inkscape.
[image: images/svg/create-black-24dp.png] Level 1 class: What should you do?
In the level 1 class, try out both of the sections below.
I have provided both pdf and png exports of the same map (Ashes Hollow) from QGIS so you don’t need to do the export from QGIS yourself.
• In the InteractiveInkscape.zip download from last week, you should be able to find the files AshesHollowLayout.pdf and AshesHollowLayout.png. Use these to work through this worksheet. (If you no longer have the data from last week, then download it now.)
Start by following the instructions to open the pdf version. You can also import the png version to the same document to see how it works but use the pdf version for the rest of the exercises.
Exporting your map from QGIS as pdf and opening it in Inkscape
If you have exported your map as png rather than pdf, go down to the next section for instructions.
Exporting a layout from QGIS as pdf format
[image: images/svg/create-black-24dp.png] Level 1 geology
If you are using these instructions as part of the level one geology module the pdf has already been exported for you. Go straight to the section on Opening a pdf file in Inkscape.

[image: images/svg/videocam-black-24dp.png] Printing or exporting a layout from QGIS.
You can find this video clip in the module area of Minerva or in the full list of video clips.
Open your completed map layout in QGIS and start by checking that the scale of your map is correct in your layout - usually 1:10 000.
· Click on the button to export your map as pdf.
· Choose where to save your file and give it a name you’ll remember, then click Save.
You can experiment with the settings, but I find it works best if you don’t export as vectors or create a geospatial pdf.
[image: images/svg/info-black-24dp.png] Exporting text as paths
The recommended setting for Text export is Always Export Text as Paths. This exports text as a series of lines, rather than as text. It does mean you can’t edit your text, but it is possible to delete it if you need to and add corrected text in the resulting space.
The alternative - Always Export Text as Text Objects - keeps the text as text, but tends to mess up the spacing of the letters. It also becomes very difficult to change text, despite what you might think!
[image: ../../shared/docs/images/layout_inkscape/PDFExportOptions_small.png]
QGIS PDF export options.
· Close QGIS.
Opening a pdf file in Inkscape
As pdf is a vector format, you can open it in Inkscape in exactly the same way as you would open a .svg document.
Opening the map directly is the best way to preserve the scale of your map between the two programs. If you open a new document and add your map, it is very easy to change the scale without meaning to, though it is possible. Do not be tempted to resize your map! You should already have set it carefully to the correct scale in QGIS.
· Open Inkscape
· If you get the full splash screen, then click Time to Draw and select Browse for other files..., click on Open, then navigate to your exported pdf. How this splash screen looks will vary depending on your version of Inkscape.
· If you don’t get the splash screen, open the pdf map document with File > Open.
The PDF Import Settings window should open, showing a preview of the document you are opening. (The screenshot below shows Inkscape version 1.3. If you are using Inkscape 1.2 your import screen will be different, but you should still be able to leave everything as the defaults.)
[image: ../../shared/docs/images/layout_inkscape/PDFImportSettings_small.png]
Inkscape PDF import options.
It is best to leave all settings as the defaults, though if you have a multi-page pdf you can select just the page(s) you need. Usually, if you’ve exported from QGIS, you will only have one page.
· Click OK.
Inkscape should open your map layout, setting the page size to the same as the original pdf.
Saving the pdf as svg
At this point it is a very good idea to save the imported pdf as an svg document.
· File > Save as...
· Check the Save as type: is set to Inkscape SVG (*.svg).
· Give your new file a name you’ll remember and choose where to save it. (If you’re using the Ashes Hollow map, feel free to keep the name as AshesHollowLayout.svg.)
Exporting your map from QGIS as an image and opening it in Inkscape
If you have exported your map as pdf rather than png image format, go back to the previous section for instructions.
Exporting your map from QGIS as an image
[image: images/svg/create-black-24dp.png] Level 1 geology
If you are using these instructions as part of the level one geology module the pdf has already been exported for you. Go straight to the section on Importing a map as an image into Inkscape.
· Follow the instructions in the QGIS workbook section on Exporting a map layout from QGIS to export a png (image) format map from your layout.
[image: images/svg/videocam-black-24dp.png] Printing or exporting a layout from QGIS.
You can find this video clip in the module area of Minerva or in the full list of video clips.
Open your completed map layout in QGIS and start by checking that the scale of your map is correct in your layout - usually 1:10 000.
Then click on the button to export an image.
· Set Export resolution to 300 DPI to start with.
· Check that Crop to Content isn’t ticked.
· Choose where to save your file and give it a name you’ll remember, then click on Export.
[image: ../../shared/docs/images/layout_inkscape/ImageExportOptions_small.png]
QGIS image export options.
[image: images/svg/info-black-24dp.png] Resolution and image quality
Image quality depends on the resolution in DPI (dots per inch). If this is set too low the quality will be bad, if it set too high your computer will struggle to handle the image. 300 dpi is usually a good compromise between quality and speed, but you can experiment, e.g. by putting dpi up to 600, or down to 150.
· Check the map image by opening it in your computer’s default graphics app.
At this stage you can change any settings, such as the dpi, and export the image again if you need to.
· Once you’re happy with the map image, close QGIS.
Importing a map from an image into Inkscape
· Open Inkscape if it isn’t already open.
You can either import the image to a new document or to an existing one.
· If you get the splash screen, click on New document at the bottom right of the Time to Draw tab to get a blank Inkscape document.
· Click on File > Import... or the keyboard shortcut <ctrl + I>.
· Select your exported png image and click Open.
· In the dialog which appears, select to Link the image, not to Embed. This means that you will need to keep the Inkscape document and the image together, but that the Inkscape document won’t become too large and will be less likely to crash.
[image: ../../shared/docs/images/layout_inkscape/ImageImportOptions_small.png]
QGIS image import options.
· Click on OK to import the map.
Don’t be tempted to resize the imported map image once it has been imported or the scale will become incorrect.
Setting page size for your map
If you opened a pdf, Inkscape will have set the page size to the same as the pdf. If you imported an image, then the page size in Inkscape is probably still the default A4 size.
If necessary, set the page size to the maximum size you are likely to need. For the level 1 map I’ve provided and for the assessment for your level 2 module this will be A3 so you have room to add sections etc. For a mapping dissertation it will probably be A0. Make sure you read the instructions you’re given!
· File > Document Properties > Display
· Select the correct page size, and whether you want it to be Portrait or Landscape orientation. It is also a good idea to tick the box next to Border on top of drawing.
Saving your document and setting autosave options
· Save your document - either File > Save or <ctrl + s>. Do this regularly - you are likely to be dealing with large documents and Inkscape may crash.
Additionally it is possible to set Inkscape to autosave your documents at regular intervals.
· Go to Edit > Preferences > Input/Output > Autosave and tick Enable Autosave.
You then need to restart Inkscape for this to work. The default interval is every 10 minutes, and it would be worth making a note of where Inkscape saves the autosave files.
Keeping track of elements with the Object browser
Don’t forget you can use the object browser to keep your layout elements organised. See Interactive Inkscape 10 for a reminder of how to use this. You can end up with a very complex document, so being organised can save you time in the long term.
I’d suggest starting by locking the layer you have imported the original map onto so you don’t move or make other changes by mistake. If you then need to move or change anything on the pdf map, don’t forget to unlock it to make the changes but then lock it again.
I’d also suggest renaming your layers so you know what they contain. For example, my imported pdf map is on a layer called 1. I’m going to rename that as Original map so I know what the layer contains.
When adding other elements, create a new layer and add the new elements to that.
For example, before importing a cross-section, create a new layer called Cross-section 1, make sure that it is selected, then import the svg for the cross-section.
Then you’ll be able to select that element using the object browser, make it invisible if you need to, or lock it so you can’t select it by mistake.
In the image below you can see that I’ve added separate layers for each element I think I’m going to be adding - Text, Title, Logo, Abstract, Cross-section 1.
[image: ../../shared/docs/images/layout_inkscape/ISObjectBrowser_small.png]
An example of layer organisation. The layer at the bottom called Original map is the renamed layer for the original map. The padlock on the right indicates the layer is locked and can’t be edited. I’ve added layers for a cross-section, title, etc.
Moving elements from the original pdf
Making changes to the elements on the original pdf in Inkscape is something to be done with care, though if you make mistakes you can always reimport from the pdf again. The best advice is to position elements carefully in QGIS first so you don’t have to move anything later!
Sometimes you need to move parts of the layout around to make space on the new page. For example, moving the legend or a section of text.
[image: images/svg/create-black-24dp.png] Level 1: Moving an element
If you’re using this document in the level one module, try moving the north arrow and associated text so it is in a different position on the layout.
· Make sure the layer containing the original layer is unlocked.
· Use the Selector Tool (s) to draw a rectangle around the element you want to move and let go. You may need to lock (or delete!) a background element if it moves when you try to select.
· At this stage you can group the element if it consists of multiple items - Ctrl + G.
· Now use the Selector tool again to move the element to where you want it.
Adding cross-sections and diagrams to your layout
[image: images/svg/videocam-black-24dp.png] Importing elements to an Inkscape document
You can find this video clip in the module area of Minerva or in the full list of video clips.
Create any cross-sections, stratigraphic columns and diagrams as separate svg documents. Don’t worry too much about matching colours with your map at this stage - you can do that later. It is then simple to import them to your main layout.
[image: images/svg/create-black-24dp.png] Level one: Cross-section to add to layout
For the level one module, either use the cross-section from Ashes Hollow that you digitised in Interactive Inkscape worksheet 11, or use the example cross-section for the same area that I digitised.
· File > Import... and select your svg file then Open.
The SVG Input dialog should open.
· Set the SVG Image Import Type to Include SVG image as editable object(s) in the current file - this enables you to make changes later if you need to, such as matching the colours to the map.
· Leave the DPI for rendered SVG as 96.00. If you’re not happy with the result, you can try again with this set to 300, or even 600.
· Image Rendering Mode should be set to Smooth (OptimizeQuality) as you’re trying to create a good quality presentation.
· Click OK once you are ready.
[image: ../../shared/docs/images/layout_inkscape/SVGImport_small.png]
The SVG Input dialog. Choose to Include SVG images as editable objects within the current file.
Once the content is imported, you can move it around, resize if necessary (be careful with scale for your cross-sections though), and edit it too if you need to. It will come in as a group, so you may need to Ungroup it - Shift - Ctrl - G.
Checking scale in Inkscape
Document 7 of Interactive Inkscape - Transformations - will have shown you how to create an accurate scalebar within Inkscape. You can also check within Inkscape that the scale of your map and section is correct.
You’ll usually need to create a map at 1:10 000, and your section should be to the same scale, with no vertical exaggeration.
[image: images/svg/info-black-24dp.png] Checking scale at 1:10,000
At a scale of 1:10,000, 10 cm will be 1 km.
To check the scale of your map:
· Use the Pen tool (b or Shift-F6) to draw a horizontal or vertical line (remember to hold down the control key to constrain the line to certain angles). Don’t worry about the length while you are drawing it.
· Use the select tool (s) to select the line, then use the context toolbar to change the units to cm, then set the width or height as appropriate to 10 cm. I find it useful to make the line a bright colour so that I can see it above the rest of the items on the page.
· Now move the line so that it is over your map, and line it up with the grid squares. Remember the space between 1 km grid squares should be 10 cm.
· You should know the length your section is supposed to be, so use a similar technique to check that.
Don’t forget to remove any lines when you’ve finished! You don’t want to include them on your final map.
Matching colours between diagrams and your map
[image: images/svg/videocam-black-24dp.png] Editing imported elements in Inkscape and using the colour dropper to match colours
You can find this video clip in the module area of Minerva or in the full list of video clips.
Once your svg sections, strat columns or diagrams etc. are on the main layout you can match the fill colours using the dropper tool.
[image: images/svg/create-black-24dp.png] Level 1: Matching the colours
If you are using the level 1 Ashes Hollow map and my section, notice that the colours for the section are stronger than the colours on the map. If you are using your own digitised section, the colours may well be different.
Use the instructions below to make the colours on the section match the colours on the map.
You’ll need to select the area for which you want to change the colour, and to do this you may need to ungroup your diagram.
· Right-click on the diagram and Ungroup. Click elsewhere to unselect then try clicking on the object you want to select again. You may need to ungroup multiple times. Alternatively you can choose to Enter Group...
· Select the object for which you want to change the colour. Open the Fill and Stroke dialog and go to the Fill panel.
· At the lower left is an eye dropper symbol, click on that, then click on the area of your map that matches the same colour, e.g. the same type of rock. The fill for the object you have selected should update to match.
Try not to click on a contour, or somewhere with a part of the background map - you need the “pure” colour. If you have a key for your map which was produced by QGIS, the colour patches for the key are probably the easiest way to find the correct colour.
[image: ../../shared/docs/images/layout_inkscape/ISFillPanel_small.png]
The Fill panel in Inkscape with the eye dropper tool marked.
Adding images to your layout
Images can be jpg, png, tif formats, and probably others too. Use this to import logos, photos etc.
[image: images/svg/create-black-24dp.png] Level 1: Adding the University Logo
I’ve provided the University of Leeds logo in the Interactive Inkscape folder - uol-logo.png. Use the instructions below to add this to your layout.
Note that the University has strict requirements for use of the logo. Keep it small, don’t change the colour, and if you use it, place it at the top right of your documents.
Adding images is fairly simple, but do try to make sure they are good quality to start with, and it’s best if you don’t need to resize them too much once they have been imported.
· File > Import navigate to the image and select it, then Open.
· To include it in your document choose to Embed. If you choose to Link you’ll need to keep the image and svg file together in your folders, but the size of the svg file will be smaller.
· Choose Image Rendering Mode as Smooth (optimizeQuality). Then click OK.
You can then move the image to wherever you want it, and resize etc as necessary.
Adding text to your layout and editing existing text
More detailed instructions for adding text are covered in the Interactive Inkscape worksheet number 9.
Adding new text
To add a title, or your name, student ID and the module code just use the text tool (t) and format the text as required.
[image: images/svg/create-black-24dp.png] Level 1: Text to add to Ashes Hollow Layout
I’ve exported the Ashes Hollow layout from QGIS with very little text. Try adding the following:
• A title: “The geology of Ashes Hollow, Shropshire”
• Your name or id, the module number, and the date.
• Label the cross-section as “Cross-section following the line on the map”.
• The data acknowledgements shown below:

Background map: © Crown Copyright and database rights 2023. Ordnance Survey (AC0000851941)
Geological map based on: Wilson, D. (2000) Ashes Hollow - Devil’s Mouth In Precambrian Rocks of England and Wales, Geological Conservation Review Series No. 20, Joint Nature Conservation Committee, Peterborough, pp. 98-103.

Adding formatted text directly in Inkscape
It is possible, though fiddly, to add formatted text directly in Inkscape.
To create paragraphs of formatted text directly in Inkscape use the Text tool (t) to drag a box to fill the space where you want your text. Type your text, then select a couple of words. To format that text, bring up the Text and Font dialog (Shift + Ctrl + T) and choose a different font, or select bold then click Apply. You can also use keyboard shortcuts such as Ctrl - B to make the selected text bold.
This isn’t ideal, but then Inkscape is a graphics program, not a word processor.
Adding formatted text from Word or similar apps
To add formatted text, e.g. an abstract, you may find it easier to import it from a Word document or any other similar word processed document that can be saved as pdf. Try that now by creating a Word document with a title and some bold, italic and coloured text. It doesn’t matter what it says! (Keep it polite…) Set the page size to a size that will just fill the space on your page, e.g. A5 or a custom size in centimetres. You can also set the margins to Wide so there is space around your text once it is imported.
Try not to use any fancy fonts - these probably won’t import and your text will be imported as a generic font.
Save the document as a pdf file, and import it into Inkscape in the usual way -
File > Import... Select the document, then Open.
If Inkscape imports the text as a separate page, you may need to copy and paste it from there, or select and drag it onto your layout.
You can then delete the extra page as follows:
· Click on the last button on the toolbar on the left (usually… It’s the one with all the tools such as the select tool). The tooltip should say Pages Tool.
· Use the tool to click on the new page, the one you want to delete.
· Right-click and Delete page.
· Make sure you go back to a different tool, such as pressing s for the Selector Tool, so you don’t delete the page you’re working on by mistake!
Editing text from the original pdf
If you exported text as paths from QGIS (as recommended) and imported the pdf, you won’t be able to edit the text as text. Instead, try hiding or deleting the bits you don’t need or need to change, and use the Inkscape text tools (Interactive Inkscape worksheet 9) to fill in the changed text.
· Unlock the layer your original map is on.
· Use the Selector Tool (S) to select the text you want to change. The selection should be highlighted in the Layers and Objects panel. Use that to hide the selection by clicking on the eye symbol next to it.
· At this stage it’s a good idea to create a new layer and add your additions on that - it makes it easier to find them later if you need to!
· Now go to the Text tool (t) and use it to add the new text. It can be a little tricky to match the size and font of the text, but it’s worth making the effort.
Replacing text on an imported image
Note that if you imported the image file for your map rather than the pdf, you won’t be able to select existing text or delete it.
One way around this is to cover the text you don’t want with a rectangle or other shape which is the same colour as your background. You can then add new text on top of that.
Additional techniques
Adding outlines or boxes
If you want to outline elements, just add rectangles or squares using the appropriate tool (r or F4) and set the fill and stroke appropriately. Using the Layers and Objects panel, move the shape downwards so it doesn’t cover other elements.
A well placed outline can lift the presentation of a map or poster - but don’t go overboard!
Aligning elements
Don’t forget to use Align and Distribute (Shift+Ctrl+A) to line up elements.
Try using Guides in combination with Snapping to make it easier to line up the elements in your map or poster, or turn on the Page Grid.
Remember to refer back to the Interactive Inkscape worksheets if you need reminders of how to do things.
Printing or exporting your map
Refer back to Interactive Inkscape worksheet 12 which covers printing and exporting.
Creating posters in Inkscape
The techniques shown here for creating a map layout in Inkscape will also work for creating posters.
You may have used Powerpoint in the past, but some people find Inkscape much more flexible and easier for producing a professional-looking poster. It’s up to you!
Remember that your dissertation map is not a poster. One big difference is that a poster will be put on a wall and needs to be read from a distance. This map is intended to be looked at more closely, probably whilst being held in the hand.
So for a map to be held in the hand, you shouldn’t make text and elements too large. Have a look at published geological maps, e.g. by the British Geological Survey (copies available from Clare) and see how small some of their text is.
For a poster, you will need to use larger headings and clearer symbols on diagrams so that they can be read at a distance - have a look at the scientific posters on the walls around the School of Earth and Environment for plenty of examples.
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